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Getting Started
 

The M3 Library Automation System is a native MARC database and search engine designed specifically
for library use. This flexible library management tool con- trols everything from patron search stations
and circulation to cataloging and reports.
 
With M3:
 

• Use true MARC records that do not need to be reinterpreted, resulting in exceptionally  fast data retrieval.
All MARC fields and subfields are indexed and searchable.

 

• Store an unlimited number of records, with all record types conforming to either a standard or
customized  MARC record structure.

 

• Use the system’s templates, context-sensitive menus, and preloaded MARC field conventions  to edit
and create bibliographic records, holding records, patron records, authority records, and other specialty
records.

 

• Assign varying levels of access for Cataloging, Circulation, and the OPAC.

 

• Add or remove fields from windows or change font size, style, and color for windows.

 

• Change the OPAC Visual Catalog displays and searches;  display the logo of choice on the OPAC and
Web Gateway.

 
The M3 Core Package is the basic building block of the M3 Library Automation System. The M3 Core
Package contains the following fully integrated modules: Group Editor, Cataloging, Circulation, OPAC,
ReportTool,  and Inventory. It also includes the following utilities: the Barcode Label Printing Utility,
Configuration Editor, BEDSCAT, History Purge, and Picture Manager. Optional M3 modules include
Authority Control, ZServer (Z39.50 server), and BookWhere™ V4 (Z39.50 client).
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Installing M3

 
This chapter explains how to perform a first time installation of the M3 Library Automation System or an
upgrade installation for an existing M3 site. Specifically, this chapter describes:
 
•     The minimum and recommended  M3 hardware requirements
•     How to install Mandarin M3 from the M3 CD
•     How to start the M3 modules
•     Password considerations
•     System backup information
 
Attention:
Be sure to read the following section, “Before You Install,”
before beginning the installation process.
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Before you Install
 
 
System Requirements to  Operate M3
 

M3 Client/Server System Requirements
   

 Minimum Recommended

Server Windows 2003 Windows 2003 or Later

 Pentium 4 1.3 GHz Xeon or Opteron dual core

 1 GB RAM 2 GB RAM

 400 MB hard disk space (free) 1 GB hard disk space (free)

 TCP/IP Enabled TCP/IP Enabled

 MS Internet Explorer 6 SP1 or later MS Internet Explorer 7 or later

 CD-ROM drive (Installation only) CD-ROM drive

   
Workstation Windows 2000 Windows XP or later

 Pentium III at 1 GHz Modern Intel or AMD proc at 2GHz

 128 MB RAM 128 MB RAM

 800 x 600 Resolution 800 x 600 Resolution

 Ink Jet Printer with postscript support Laser Printer with postscript support

 TCP/IP Installed TCP/IP Installed

 MS Internet Explorer 6 SP1 or later MS Internet Explorer 6 SP1 or later

 
Installation Configuration Options
Before installing the M3 Library Automation System, decide which of the following two installation
configuration options best suits your library situation.
 
•     Option I – Install your databases onto your server and then install the M3 core client modules
(Circulation, OPAC, and so on) onto the hard disks of the individual workstations. For maximum
performance,  this is the pre- ferred option.
 
•     Option II – Install your databases and the M3 core client modules onto your server, then run the
Workstation Setup utility at each M3 workstation to enable access to the core modules installed on the
server. For performance purposes, only consider this option with a high-speed network protocol.
 
NOTE: The Workstation Setup places the necessary
.dll and .ocx files onto the workstations.  It does not
install the client modules onto the individual workstation
hard disks.
 
General Installation Steps
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Installing the M3 system involves multiple steps, whether installing the M3 system for the first time or
installing an M3 update CD. As an overview, the order of the process is described here. Each procedure
is covered in detail in upcoming sections
 

1. Install the M3 Server files. The server files can only be installed onto your server. The folder
containing these files resides on the M3 CD.

2. Install the program files for the M3 core client modules (Circulation, OPAC, and so on). These client
modules can be installed onto individual workstation hard disks (Option I in the previous section)
or onto the server site (Option II in the previous section). The folder containing these program files
resides on the M3 CD.

 
If you selected Option  II in the previous step, run the Workstation Setup procedure at each
workstation that requires access to the M3 core client modules. After installing the client modules, the
Workstation Setup can be found in the M3 folder on the server
(the default path is C:\Program Files\Mandarin M3\Workstation  Setup).
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Installing the M3 Server
 
Installation Preparation
Before you install, verify:
 

• You are logged on your system with full Administrator rights, at the server as well as the individual
workstations.

• Everyone else is logged out of the M3 system during the installation procedure.
• You have quit all applications, including the M3 Server and client modules.

 
Installation Procedure
1. Insert the M3 CD into the CD-ROM drive. The installation menu should appear. If not, navigate to
your CD-ROM drive (D: on most computers) and double-click autorun.exe.
 
2. On the installation menu, click Install M3 Database Server.
 
Note: If you already  have a version  of M3 installed,
you will not be prompted to choose a language; the
program  will use the previously  selected language.
 
3. In the Choose Setup Language dialog box, select the desired language and click OK. This determines
the language of the M3 Server setup only; it does not affect the language of the records in your database.
 
4. In the Welcome dialog box, click Next to begin installation.
 
5. In the License Agreement dialog box, review the agreement and click Yes to accept and continue the
installation. Or, click No to discontinue.
 
6. In the Choose Destination Location dialog box, either:

•     Click Next to install M3 Server into the default folder location on your hard disk (C:\M3
Server).
OR
•     Click Browse and navigate to the desired folder location. When the desired folder has been
selected, click OK, and then click Next.
 

7.      In the Start Copying Files dialog box, review the settings you have chosen. If you want to change
any settings, click Back. If you are satisfied with the settings, click Next.
 
8.      In the Setup Complete dialog box, click Finish. If you are prompted to restart your computer, you
can do so now or later.
 
9.      Proceed to the next section, “Installing the M3 Core Client Modules.”
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Installing the M3 Core Client Modules
 
The M3 core client modules can be installed at the server site or at the individual workstations  that
will use them. The procedure below applies to both situations.
 
Installation Preparation
Before you install, verify:
 

• You are logged on your system with full Administrator rights, at the server as well as the individual
workstations.

• Internet Explorer 5.0 or later is installed at the site you are using. If it is not, first install that
application.  For convenience,  Internet Explorer 6.0 is avail- able on the M3 CD.

• You have quit all applications.

 
Installation Procedure
1.      Insert the M3 CD into the CD-ROM drive. The installation menu should appear. If not, navigate
to your CD-ROM drive (D: on most computers) and double-click autorun.exe.
 
2.      On the installation menu, click Install M3 Client Modules.
 
3.      In the Choose Setup Language dialog box, select the desired language and click OK. This
determines the language of the setup and the language in which the M3 modules display; it does not
affect the language of the records in your database.
 
4.      In the Welcome dialog box, click Next to begin installation.
 
5.      In the License Agreement dialog box, click Yes to accept and continue the installation. Or, click No
to discontinue.
 
6.      In the Library Type dialog box, select your library type.
 

•     If you select School and choose to install ReportTool  in step 8, over
800 preloaded reports generally used by K-12 schools, public libraries, and universities are
installed.
 
•     If you select Public or Academic and choose to install ReportTool  in step
8, over 400 preloaded reports generally used by public libraries and universities are installed.

 
7.      Click Next.
 
8.      In the Setup Type dialog box, select the preferred installation type:
 

•     Custom Install – Allows you to specify which modules are to be installed at this site. Select
this option if you are installing at the server site.
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•     Full Install  – Automatically installs all M3 core client modules (Cata- loging, Circulation,
OPAC, Group Editor, Inventory, and ReportTool). It also installs the Configuration Editor,
Barcode Labels, BEDSCAT, History Purge, and Picture Manager utilities.

 
•     OPAC Only – Installs the OPAC module only.

 
9.      Click Next.
 
10. In the Choose Destination Location dialog box, either:

•     Click Next to install M3 into the default folder location on your hard disk (C:\Program Files
\Mandarin M3).
OR
•     Click Browse. Navigate to the desired folder location, click OK, and then click Next.

 
11. If you selected Custom Install in step 8, the Select Components dialog box displays. Clear any check
box that corresponds to a module you do not want to install at this workstation. Your options are:
 

•     Circulation – Installs the Circulation module.
•     Cataloging – Installs the Cataloging module.
•     OPAC – Installs the OPAC module.
•     Inventory – Installs the Inventory module.
•     ReportTool – Installs the ReportTool module.
•     Utilities – Installs the Configuration Editor, Barcode Labels, BED- SCAT, History Purge, and
Picture Manager utilities.

 
NOTE: To limit the utilities, select Utilities and 
click Change. Clear the check box by any utility
you do not want to install, then click Continue.
 

•     Group Editor – Installs the Group Editor module.
•     Workstation Setup – Installs the Workstation Setup program on the server so client machines
can start the program and use it to install required components.  Select this option only if you
are installing the program modules at the server site. This option is not appropriate if installing
the program modules at individual workstations (as in Option I).

 
12. Click Next.
 
13. In the Select M3 Data Location dialog box, click Browse and select the folder where your M3 Server
data is installed. Click OK, then click Next.
 
14. The Bulletin Board Configuration dialog box displays.

•     If you want to configure your Bulletin Board now, type your library name, a greeting, and
the hours of operation. Then click Next.
OR
•     If you do not want to configure the Bulletin Board now, click Skip.

 
15. In the Start Copying Files dialog box, review the settings you have chosen. If you want to change
any settings, click Back; otherwise, click Next.
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16. In the Setup Complete dialog box, click Finish. If you are prompted to restart your computer, you
can do so now or later.
 
NOTE: If you installed the M3 core client modules
at the server site, you need to run the setup procedure
 at each workstation. Proceed to the following section,
“Setup Procedure  at Workstations.”
 
Setup Procedure at  Workstations
If you installed M3 onto your server, run the following workstation installation pro- cedure at each
workstation planned for M3 use. This procedure does not install M3 onto the workstation; it simply
ensures that the correct .dll and .ocx files are present on the workstation, thereby allowing the
workstation to run the M3 mod- ules installed on the server.
 
Installation Procedure
1.      At the individual workstation,  locate the M3 folder on the server where the M3 applications
reside.
 
2.      In the Workstation Setup folder, double-click Setup.exe.
 
3.      In the Choose Setup Language dialog box, select the desired language and click OK. This
determines the language of the workstation setup only; it does not affect the language of the interface
or your database.
 
4.      In the Welcome dialog box, click Next to begin installation.
 
5.      In the License Agreement dialog box, click Yes to accept and continue the installation. Or, click No
to discontinue.
 
6.      In the Choose Destination Location dialog box, either:

•     Click Next to install M3 into the default folder location on your hard disk (C:\Program Files
\Mandarin M3).
OR
•     Click Browse. Navigate to the desired folder location, click OK, and then click Next.
 

7.      In the Select M3 Data Location dialog box, click Browse and select the folder where your M3 Server
data is installed. Click OK, then click Next.
 
8.      In the Start Copying Files dialog box, review the settings you have chosen.
If you want to change any settings, click Back. If you are satisfied with the settings, click Next.
 
9.      In the Setup Complete dialog box, click Finish. If you are prompted to restart your computer, you
can do so now or later.
 
10. Repeat this process at each workstation that will be used to access M3, and create desktop
shortcuts for the modules the workstation will be using.
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Starting M3
 
To start the individual modules of M3, either:

•     Double-click the Mandarin M3 shortcut on your desktop, then double-click the desired module.
OR
•     On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click the
desired module.

 
For instructions on how to start and log on a specific module, refer to the corresponding chapter in this
Users Guide.
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Passwords
 
Password Setup
The default logon sequence for the Cataloging, Circulation, Group Editor, and
Inventory modules is:
 
•    Login name: admin
•    Password: boca raton
 
For security reasons, it is recommended  that you change this password immedi- ately after initially logging
on.
 
Modifying Patron Barcodes and  Passwords
Patron barcodes, as well as patron passwords, reside in patron records. You can access and modify patron
barcodes and passwords in the M3 Cataloging module.
 
NOTE: Any patron record assigned to a patron
group that has access privileges to the Cataloging,
Circulation, Group Editor, or Inventory modules
MUST have both a login name and a password.



 
M3 System Backup Information

© 2014 Mandarin Library Automation, Inc. All rights reserved.
14 of 361

M3 System Backup Information
 
In order to protect your M3 data, it is important to perform frequent data backups. Daily backups are
recommended to avoid the loss of files on the local hard disk due to disk drive failure, power outage, virus
infection, accidental deletion, and other potential network problems.
 
The M3 Library Automation System does not currently provide continuous backup. A backup device, such
as a tape backup, should be installed to allow backups. In addition, Mandarin recommends that your
server be equipped with an automated backup system that can be used to schedule unattended backups.
 
Backup Recommendations
Mandarin recommends performing a daily backup Monday through Thursday after closing, and a full
backup on Friday or before a holiday. In case of a hardware failure, a restore of a full backup followed by
a restore of the latest partial backup can be completed.  In case of a loss of only M3 data, a restore of the
latest partial backup can be completed.
 
Backups must be performed when no users are logged on the M3 server and the server is not running. To
stop the M3 server:
 
1.      On the taskbar, click the M3 Server icon. This displays the M3 Server menu.
 
2.      Select Stop, then click All. This stops the server.
 
3.      Perform the desired backup method. Two backup methods are explained in the following section,
“Backup Methods.”
 
4.      When finished, repeat step 1. Select Start, then click All. This restarts the server.
 
Backup Methods
Two recommended backup methods are as follows:
 
•     Partial backup – Backs up only the data that is critical to daily operation of M3. This entails selecting
the specific location where M3 data is stored (the default path is C:\M3 Server\Registry) and starting the
backup. This operation completes within a few minutes, and is a reliable solution for restoring M3 data.
This type of backup does not back up the operating system or any other files on the computer. If a server
failure occurred and the data on the hard disk was lost, the operating system and all applica- tions would
have to be reinstalled; M3 would be restored from the latest backup, repairing all data and transactions.
This type of backup is typi- cally performed by a network adminstrator.
 
•     Full backup  – Backs up the entire server, including the operating system, users, security, login scripts,
applications, and all M3 data. This entails selecting the drive(s) and starting the backup. This operation
  may take a half hour to several hours to complete. This type of backup is typically per- formed by a
network adminstrator.
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Using Group Editor
 
You must either set up a hierarchy of patron groups based on the permissions required for patrons in each group, or you must
disable the hierarchy in the Global.ini.REG file.
 
About Group Editor
Group Editor is used to create the groups that M3 Circulation and OPAC require to function. Each
group has a customized set of parameters and permissions.
 
There are three types of groups in M3: Patron, Item, and Special Reserve.
 
•     Patron groups – Each patron record entered into the M3 system must be assigned to a patron
group to establish circulation permission for the patron. A library might work with patron groups such
as General Patron, VIP Patron, Volunteer, Staff Member, and Director. Permission to access patron
groups is set by a user higher in the hierarchy than the patron group, and patrons cannot change which
groups they can access. You can create an unlimited number of patron groups, although a patron can
only be assigned to one group.
 
•     Item groups – Each holding record must be assigned to an item group to establish the item’s
circulation parameters. A library might work with item groups such as general collection, reference
collection, periodicals, equipment, and rare books. Permission to access item groups is set by a user
higher in the hierarchy than the patron group, and patrons cannot change which groups they can
access. You can create an unlimited number of item groups, although a holding record can only be
assigned to one group.
 
•     Special Reserve groups – When a library needs to accommodate unusual circulation restrictions
for a defined patron set, a special reserve group can be created. For instance, you might create a four
week special reserve group to restrict certain science books to inlibrary use by students involved in a
chemistry project. Permission to access special reserve
 
groups is set by a user higher in the hierarchy than the patron group, and patrons cannot change which
groups they can access. You can create an unlimited number of special reserve groups; patrons and
items can be assigned to multiple special reserve groups. Special reserve group permissions override
item group permissions.
 
Creating Group Hierarchy
The group hierarchy indicates which patron, item, and special reserve groups each individual patron
group can modify in Group Editor. The hierarchy is determined by the entry in the Created by Patron
Group box on the patron, item, and special reserve group General tabs. This box determines which
groups display in the Group Access tabs. Permissions to modify patron and item access are then estab-
lished in the Group Access tabs.
 
If you do not want to create the group hierarchy, you must disable this fea- ture in the
Global.ini.REG  file (the default path is C:\M3 Server\Registry
\Common) by changing the Group Hierarchy entry to Override=off. If disabled, the Group Access rules
in Group Editor will  not be enforced.
 



 
Using Group Editor

© 2014 Mandarin Library Automation, Inc. All rights reserved.
16 of 361

M3 includes four default patron groups: Administrators, Librarians, Library Assis- tants, and Patrons.
The hierarchy has been created for these groups. Mandarin rec- ommends that these groups be used;
they cannot be deleted. You can modify these groups or create additional groups, if desired. These four
groups have the fol- lowing permissions:
 
•     Administrator (first level) – has permission to modify access of all groups
 
•     Librarians (second level) – has permission to modify access of Library
Assistants and Patrons
 
•     Library Assistants (third level) – has permission to modify access of
Patrons
 
•     Patrons (fourth level) – has no permission to modify access of other groups
 
If your library requires additional patron groups, use the following procedure to add groups to the
hierarchy and establish permissions. In this example, a user in the “Librarian” group has created a
“Faculty” group, which will have the same permissions as the group “Library Assistants.”
 
For instructions on creating a patron group, see “Creating a New Patron  Group” begin- ning on page 3-4.
 
1.      In the General tab for the “Faculty” group, select Librarians in the Created by Patron Group box.
(No patron groups that were also created by “Librarians” will have access to the “Faculty” group unless
indicated in the Group Access tab.)
 
2.      In the Group Access tab, the groups without access to the “Faculty” group dis- play in the Groups
Without Access box. To grant one or more of these groups access to the “Faculty” group, select the group
in the Groups Without Access box, then click the << button. This moves the patron group to the Groups
With Shared Access  To Current box.
 
3.      When finished, click OK to save the “Faculty” group.
 
Staring Group editor
To start the Group Editor module:
 
1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click Group
Editor. This displays  the Group Editor Login dialog box.
 
2.      Type your user ID in the Login Name box, your password in the Password
box, and then click OK. This displays the Group Editor window.
 
 
Group Editor Window Features
All M3 groups are created, customized, and modified through the Group Editor window (Figure 3.1).
Window features are summarized below.
 
FIGURE 3.1
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•     Display list – Contains the list of display options for this main window. You can display the listings
for all groups or only a particular group type (patron, item, or special reserve group). To change the
displayed group type, select the desired type in the Display list.
 
•     Database Set list – Contains the list of catalog databases available to search from your library’s M3
system.
 
•     Group listings – Each group listing includes the group type icon, group name, and group
description.  A group type icon appears to the left of each group listing. A head signifies a patron group;
a book signifies an item group; eyeglasses signify a special reserve group.
 
•     Function buttons – Buttons that allow you to edit, delete, and duplicate existing groups, and to
create new groups.
 
•     Access lock – Appears next to any group to which you have read-only access.
 
Selecting a Catalog Database
Your M3 system can access multiple catalog databases. If multiple databases are available, select the
catalog database you want to work with in Group Editor. To do so, in the Group Editor window, select
the desired database in the Database Set list.
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Working with Patron Groups
 
With M3, you can create an unlimited number of patron groups with customized permissions for each
group. For more information about patron groups, see page 3-1.
 
Entering Patron Records & Patron Groups
You must create patron groups before you can enter or import patron records through the M3
Cataloging module.
 
Creating a New Patron Group
To create a new patron group:
 
1.      In the Group Editor window, select a catalog database in the Database Set list.
 
2.      Click New. This displays the New Group dialog box (Figure 3.2).
 
FIGURE 3.2

 
3.      Click New Patron Group, then click OK. This places a “New Patron Group”
listing in the Group Editor window (as shown in Figure 3.3).
 
NOTE: If the new listing does not appear,  verify that All Groups or Patron
Groups is selected in the Display list.
 
FIGURE 3.3
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4.      Select the new patron group, then click Edit. This displays the New Patron Group window (Figure
3.4), where you customize the group’s character- istics. Enter the appropriate information in each tab
as described in the following sections.
 
FIGURE 3.4
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Note: When adding a person  to the system,  the person  is assigned to a patron group and a new patron record with a unique
barcode is created. In many libraries, this barcode is placed on the person’s  library card. The library card’s expi- ration date is
calculated from the number of days entered in the Card Expiration  Period box, using  the date the new patron  record was created
as day one.
 
General Tab
In this tab (Figure 3.4), enter identification information for the group. This information displays in the
Group Editor window.
 
1.   In the Name box, type the patron group’s name.
2.   In the Description box, type any information needed to clarify this group.
 
3.      The Created by Patron Group box displays the patron group of the user that created this group.
Only administrators can modify this entry.
 
4.      In the Card Expiration Period box, type or select the number of days a library card issued to a
member of this patron group remains valid before requiring renewal.
 
5.      Click Apply to save your entries in this tab, then click another tab to modify it.
 
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Circ Blocks Tab
In this tab (Figure 3.5), customize the patron group’s rights to add, modify, place, remove, and override
system messages. Typically, selected library staff members require such rights—general patrons do not.
 
FIGURE 3.5
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Depending on your permissions,  some of these options may  be unavailable.
 
1.      Select the functions needed by members of this patron group:
 

•     Add, Edit, and Delete Messages allows group members to add, edit, and delete patron and item
messages.
 
•     Attach and Detach Information Blocks allows group members to attach and detach messages
assigned the information block type.
 
•     Attach and Detach Nudge Blocks allows group members to attach and detach messages
assigned the nudge block type.
 
•     Attach, Detach, and Override Privilege Blocks allows group members to attach, detach, or
override messages assigned the privilege block type.
 
•     Attach, Detach, and Override Blocking Blocks allows group members to attach, detach, or
override messages assigned the blocking block type.
 

2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Circ Limits Tab
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In this tab (Figure 3.6), customize the circulation quantity limits for the patron group. Specify the
maximum number of items for each type of transaction listed.
 
FIGURE 3.6

 
 
1.      Select a circulation limit for each limit type. To do so:
 
A.     Select a limit type. If a limit is not selected, no limit is assigned. B.     In the list next to the limit
type, select a limit amount.
 
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Circ Access Tab
In this tab (Figure 3.7), specify whether this patron group is allowed to access any circulation
functions.
 
FIGURE 3.7
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1.      In the Access Circulation list, select Yes or No.
 

•     If you click Yes, you can enable any available function listed on the tab by selecting the
function. Functions are organized into five groups:
 
•     Operations – lists various types of circulation transactions.
 
•     Bibliographic Records – pertains to bibliographic record mainte- nance.
 
•     Holding Records – pertains to holdings record maintenance.
 
•     Patron Records – pertains to patron record maintenance.
 
•     Templates – pertains to template record maintenance.
 
•     If you click No, all functions listed on this tab are disabled.

 
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
OPAC Access Tab
In this tab (Figure 3.8), specify whether this patron group is allowed to access any
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OPAC functions.
 
FIGURE 3.8

 
Note: The Visual Catalog Configuration check box also controls the permission to modify  the OPAC header.
 
1.      In the Access OPAC list, select Yes or No.
 

•     If you click Yes, you can enable any available function listed on the tab by selecting the
function.
 
•     If you click No, all functions listed on this tab are disabled.

 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Cataloging Access Tab
In this tab (Figure 3.9), specify whether this patron group is allowed to access any cataloging functions.
 
FIGURE 3.9
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The Override Authority option and the Authority Records group are avail- able only  if you are using a version  of M3 that
supports Authority Control.
 
Tip: The Replace check box in this  tab’s Bibliographic, Holding, Patron, and Authority  Records groups gives patrons access to the
Replace function  of the Find/Replace utility. The Find/Replace utility is part of the Cataloging module.
 
1.      In the Access Cataloging list, select Yes or No.
 

•     If you click Yes, you can enable any available function listed on the tab by selecting the
function. Functions are organized into five groups:
 
•     Bibliographic Records – pertains to bibliographic record mainte- nance.
 
•     Holding Records – pertains to holdings record maintenance.
 
•     Patron Records – pertains to patron record maintenance.
 
•     Templates – pertains to template maintenance.
 
•     Authority Records – pertains to authority record maintenance.
 
•     If you click No, all functions listed on this tab are disabled.

 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
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Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Utilities Tab
In this tab (Figure 3.10), specify whether this patron group is allowed to access any of the utilities
listed.
 
FIGURE 3.10

 
1.      To allow access to a utility, select the corresponding check box. The util- ities listed are:
 

•     Inventory – allows members of this patron group to view and conduct catalog inventory
functions through M3 Inventory.
 
•     Configuration  Editor – allows members of this patron group to perform configuration
functions in M3 Configuration Editor.
 
•     Group Editor – allows members of this patron group to view and con- duct functions in M3
Group Editor.
 
•     Report Generator – allows members of this patron group to view and create reports through
M3 ReportTool.
 

2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
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Click Cancel to discard your entries in this tab and return to the Group Editor window.
 
 
Members Tab
In this tab (Figure 3.11), add and remove patron group members. Skip this tab if you have not yet entered
any patron records for this group. You can add members to this group later using the Edit function in
the Group Editor window.
 
To add or remove patron records:
 
1.      In the Display list, select All Patrons. This displays a list of all patrons (as shown in Figure 3.11),
not just patrons currently assigned to this group.
 
FIGURE 3.11

 
 
Tip: You can also scan patrons into the group. To do so, select Scan  Patrons into Current Group in the Display list. Then scan the
patron’s barcode or type the barcode in the Barcode  box (not shown in Figure 3.11).
 
2.      Select each patron you want to add to or remove from the patron group.
To locate specific patrons:
 

•     Use the vertical scroll bar or your up and down arrow keys to move through the list.
OR
 
•     Click a column heading to sort the list by that column.
 
OR
 
•     Search for a patron by any field indexed in the patron records. To do so:
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A.     In the Display list, select Search. This displays the Search dialog box (Figure 3.12).
 
FIGURE 3.12

 
B.     Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or oper- ator.
Then click Search. This displays a list of patrons matching your search query.
 
3.      Select the desired patrons, then click Move. This displays the Select Group dialog box (Figure
3.13).
 
FIGURE 3.13

 
4.      Select the group into which you want to move the patrons, then click OK.
 
5.      To view the new patron group list, select Patrons  in Current Group Only in the Display list. The
patron list refreshes to display only those assigned to this group.
 
6.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group Editor window.
 
 
Item Group Overrides Tab
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In this tab (Figure  3.14), grant this patron group rights to override specific circu- lation limits connected
to item groups. For example, if the item group “CD Collec- tion” limits the number of loan renewals to
one, you can establish a different limit for this particular patron group.
 
To assign item group overrides:
 
FIGURE 3.14

 
 
1.      In the Overrides box, click the item group name. If it is not listed in the Overrides box, select the
item group name in the Item Groups box, and then click the << button. This moves the name to the
Overrides box.
 
2.      While the item group name is selected, click Edit Override. The Circ Periods window appears,
displaying the circulation limits for the selected item group (Figure 3.15).
 
FIGURE 3.15
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3.      In the Maximum Renewals list, select the maximum number of times that an item in this group can
be renewed.
 
4.      In the Default Units list, select Daily or Hourly as the default time unit for
Loan Period, Renewal Period, Grace Period, and Fines.
 
5.      In the Loan Period, Renewal Period, and Grace Period groups, enter the time limit for each period
type.
 
6.      In the Fines group, type the fine amount per time unit and the maximum fine amount.
 
7.      In the Reserve Period Default Units and Hold Period Default  Units groups, select Daily or Hourly in
the list, and then specify the time limit for each.
 
8.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Group Access Tab
In this tab (Figure  3.16), specify which patron groups you want to have access to this group.
 
To specify groups with access:
 
FIGURE 3.16
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1.      The Groups Without Access box displays the patron groups that do not have access to this group.
To change the group access, click the patron group that you want to have access to this patron group,
then click the << button. This moves the patron group to the Groups With Shared Access  To Current box.
Repeat this for all groups that you want to have access to this patron group.
 
2.      In the Default  Patron Group list, select the patron group that you want to appear as the default
group when a member of this patron group creates a patron record in the Cataloging and Circulation
modules. This default group appears in patron records in the Standard Group (991#a)  field.
 
3.      In the Default Item Group list, select the item group that you want to appear as the default group
when a member of this patron group creates a holding record in the Cataloging and Circulation
modules. This default group appears in holding records in the Standard Group (991#a)  field.
 
4.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group Editor window.
 
You cannot delete a patron group if members are assigned  to the group.
 
Modifying Patron Group Permissions
To modify the permissions assigned to a patron group:
 
1.      In the Group Editor window, select a catalog database in the Database Set
list.
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2.      Select a patron group, then click Edit. This displays the settings window for the selected group.
 
3.      Modify the settings in the tabs as needed using the techniques described in “Creating a New Patron
Group” beginning on page 3-4. When finished, click OK to save your changes.
 
Deleting a Patron Group
To delete a patron group from the M3 system:
 
1.      In the Group Editor window, select the group to be deleted.
 
2.      Click Delete.
 
NOTE: If members are assigned to the group, the message “You cannot delete a group that has
members” appears.
 
3.      If the group has no members, a confirmation prompt appears. Click Yes to proceed with the deletion.
 
Warning: You cannot undo this  deletion.
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Working with Item Groups
 
With M3, you can create an unlimited number of item groups with customized per- missions for each
group. For more information about item groups, see page 3-1.
 
Entering Item Records and  Item Groups
You must create item groups before you can enter or import item records through the M3 Cataloging
module.
 
Creating a New Item Group
To create a new item group:
 
1.      In the Group Editor window, select a catalog database in the Database Set
list.
 
2.      Click New. This displays the New Group dialog box (Figure 3.17).
 
FIGURE 3.17

 
3.      Click New Item Group, then click OK. This places a “New Item Group” listing in the Group Editor
window (as shown in Figure 3.18).
 
NOTE: If the new listing does not appear,  verify that All Groups or Item
Groups is selected in the Display list.
 
FIGURE 3.18
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4.      Select the new item group, then click Edit. This displays the New Item Group window (Figure
3.19), where you customize the group’s character- istics. Enter the appropriate information in each tab
as described in the following sections.
 
FIGURE 3.19

 
General Tab
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In this tab (Figure  3.19), enter identification information for the group. This information displays in
the Group Editor window.
 
To enter general information:
 
1.      In the Name box, type the item group’s name.
 
2.      In the Description box, type any information needed to clarify this group.
 
3.      The Created by Patron Group box displays the patron group of the user that created this group.
Only administrators can modify this entry.
 
4.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Circ Periods Tab
In this tab (Figure 3.20), establish circulation time frames and fine amounts for this item group.
 
FIGURE 3.20

 
 
1.      To enter different limits for this item group, see steps 3 through 7 on page 3-15.
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
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OR
 
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Members Tab
In this tab (Figure 3.21), add and remove item group members. Items assigned to this group adhere to
the circulation parameters established in the Circ Periods tab on page 3-19.
 
To add or remove holding records:
 
1.      In the Display list, select All Items. This displays a list of all items (as shown in Figure 3.21), not
just items currently assigned to this group.
 
FIGURE 3.21

 
Tip: You can also scan items into  the group. To do so, select Scan Items into Current Group in the Display list. Then scan the item’s
  barcode or type the barcode in the Barcode  box (not shown in Figure 3.21).
 
2.      Select each item you want to add to or remove from the item group. To locate specific items:
 
•     Use the vertical scroll bar or your up and down arrow keys to move through the list.
OR
 
•     Click a column heading to sort the list by that column (not applicable to Title and Author).
OR
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•     Search for an item by any field indexed in the item records. To do so: A.     In the Display list, select
Search. This displays the Search dialog
box (Figure 3.22).
 
FIGURE 3.22

 
B.     In the Search For list, select Bibliographic or Holdings.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or oper- ator.
Then click Search. This displays a list of items matching your search query (Figure 3.23).
 
FIGURE 3.23

 
3.      Select the desired items, then click Move. This displays the Select Group dialog box (Figure 3.24).
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FIGURE 3.24
 
4.      Select the group into which you want to move the items, then click OK.
 
5.      To view the new item group list, select Items  in Current Group Only in the Display list. The item list
refreshes to display only those assigned to this group.
 
6.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
Group Access Tab
In this tab (Figure  3.16), specify which patron groups you want to have access to this group.
 
To specify groups with access:
 
FIGURE 3.25
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1.      The Groups Without Access box displays the patron groups that do not have access to this group.
To change the group access, click the patron group that you want to have access to this item group,
then click the << button. This moves the patron group to the Groups With Shared Access  To Current box.
Repeat this for all groups that you want to have access to this item group.
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group Editor window.
 
Modifying Item Group Permissions
To modify the permissions assigned to an item group:
 
1.      In the Group Editor window, select a catalog database in the Database Set
list.
 
2.      Select an item group, then click Edit. This displays the settings window for the selected group.
 
3.      Modify the settings in the tabs as needed using the techniques described in “Creating a New Item
Group” beginning on page 3-17. When finished, click OK to save your changes.
 
Deleting an  Item Group
To delete an item group from the M3 system:
 
1.      In the Group Editor window, select the group to be deleted.
 
2.      Click Delete.
 
NOTE: If members are assigned to the group, the message “You cannot delete a group that has
members” appears.
 
3.      If the group has no members, a confirmation prompt appears. Click Yes to proceed with the deletion.
 
Warning; You cannot undo this  deletion.
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Working with Special Reserve Groups
 
With M3, you can create an unlimited number of special reserve groups with customized permissions
for each group.
 
Creating a New Special Reserve Group
To create a new special reserve group:
 
1.   In the Group Editor window, select a catalog database in the Database Set
list.
 
2.   Click New. This displays the New Group dialog box (Figure 3.26).
 
FIGURE 3.26

 
 
3.      Click New Special Reserve Group, then click OK. This places a “New Special
Reserve Group” listing in the Group Editor window (as shown in
Figure 3.27).
 
NOTE: If the new listing does not appear,  verify that All Groups or Special
Reserve Groups is selected in the Display list.
 
FIGURE 3.27
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4.      Select the new special reserve group, then click Edit. This displays the New Special Reserve
Group window (Figure 3.28), where you customize this group’s characteristics. Enter the appropriate
information in each tab as described in the following sections.
 
FIGURE 3.28

 
General Tab
In this tab (shown in Figure 3.28), enter identification information for the group as well as information
that impacts circulation behavior.
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1.      In the Name box, type the special reserve group’s name.
 
2.      In the Description box, type any information needed to clarify this group.
 
3.      In the Reserve  Group Expiration group:
 

•     If the group has no planned expiration date, click No Expiration.
 
OR
 
•     If an expiration date is known, click Expires, and then type or select a date in the adjacent
box. To select a date, click the Calendar arrow to display a calendar (as shown in Figure 3.29).
Click the calendar’s left (<) and right (>) arrows to select a month, then click the desired date.
The date appears in the Expires box.
 

FIGURE 3.29

 
4.      The Created by Patron Group box displays the patron group of the user that created this group.
Only administrators can modify this entry.
 
5.      In the Circulation Access  Available to group:
 

•     Click All Patrons  if you want all patrons to have access to items included in this special
reserve group.
OR
 
•     Click Only patrons that are members of this group if you want to restrict access to items in this
special reserve group.
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6.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Item Members Tab
In this tab (Figure 3.30), add and remove item group members. Items assigned to this group adhere to
the circulation parameters you establish in the next tab, Circ Periods.
 
To add or remove holding records:
 
1.      In the Display list, select All Items. This displays a list of all items (as shown in Figure 3.30), not
just items currently assigned to this group.
 
FIGURE 3.30

 
Tip: You can also scan items into  the group. To do so, select Scan Items into Current Group in the Display list. Then scan the item’s
  barcode or type the barcode in the Barcode  box (not shown in Figure 3.30).
 
2.      Select each item you want to add to the special reserve group. To locate specific items:
 

•     Use the vertical scroll bar or your up and down arrow keys to move through the list.
OR
 
•     Click a column heading to sort the list by that column (not applicable to Title and Author).
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OR
•     Search for an item by any field indexed in the item records. To do so: A.     In the Display list,
select Search. This displays the Search dialog
box (Figure 3.31).
 

FIGURE 3.31

 
B.     In the Search For list, select Bibliographic or Holdings.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or oper- ator.
Then click Search. This displays a list of items matching your search query.
3.      To add items, select the desired items, then click Add.
 
OR
 
To remove items, select the desired items, then click Remove.
 
4.      To view the new item group list, select Items  in Current Group Only in the Display list. The item list
refreshes to display only those assigned to this group.
 
5.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Circ Periods Tab
In this tab (Figure 3.32), establish circulation time frames and fine amounts for this special reserve
group.
 
FIGURE 3.32
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1.      To enter different limits for this special reserve group, see steps 3 through  on page 3-15.
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Circ Limits Tab
In this tab (Figure 3.33), customize the circulation quantity limits for the special reserve group. Specify
the maximum number of items for each type of transaction listed.
 
FIGURE 3.33
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1.      Select a circulation limit for each limit type. To do so:
 

A.     Select a limit type. If a limit is not selected, no limit is assigned.
B.     In the list next to the limit type, select a limit amount.

 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Patron Members Tab
In this tab (Figure 3.34), add and remove patron members. Use this tab only if Only patrons that are
members of this group is selected in the General tab (shown in Figure 3.28).
 
To add or remove patron members:
 
1.      In the Display list, select All Patrons. This displays a list of all patrons (as shown in Figure 3.34),
not just patrons currently assigned to this group.
 
FIGURE 3.34
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Tip: You can also scan patrons into the group. To do so, select Scan  Patrons into Current Group in the Display list. Then scan the
patron’s barcode or type the barcode in the Barcode  box (not shown in Figure 3.34).
 
2.      Select each patron you want to add to the special reserve group. To locate specific patrons:
 

•     Use the vertical scroll bar or your up and down arrow keys to move through the list.
OR
 
•     Click a column heading to sort the list by that column.
 
OR
 
•     Search for a patron by any field indexed in the patron records. To do so:
 

A.     In the Display list, select Search. This displays the Search dialog box (Figure 3.35).
 
FIGURE 3.35
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B.     Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or oper- ator.
Then click Search. This displays a list of patrons matching your search query.
3.      To add patrons, select the desired patrons, then click Add.
 
OR
 
To remove patrons, select the desired patrons, then click Remove.
 
4.      To view the new patron group list, select Patrons  in Current Group Only in the Display list. The
patron list refreshes to display only those assigned to this group.
 
5.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group
Editor window.
 
 
Group Access Tab
In this tab (Figure  3.36), specify which patron groups you want to have access to this group.
 
To specify groups with access:
 
FIGURE 3.36
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1.      The Groups Without Access box displays the patron groups that do not have access to this group.
To change the group access, click the patron group that you want to have access to this special reserve
group, then click the
<< button. This moves the patron group to the Groups With Shared Access To Current box. Repeat this for
all groups that you want to have access to this special reserve group.
 
2.      Click Apply to save your entries in this tab, then click another tab to modify it.
OR
 
Click OK to save your entries in this tab and return to the Group Editor window.
OR
 
Click Cancel to discard your entries in this tab and return to the Group Editor window.
 
Modifying Special Reserve Group Permissions
To modify the permissions assigned to a special reserve group:
 
1.      In the Group Editor window, select a catalog database in the Database Set
list.
 
2.      Select the desired group, then click Edit. This displays the settings window for the selected group.
 
3.      Modify the settings in the tabs as needed using the techniques described in “Creating a New
Special Reserve Group” beginning on page 3-23. When finished, click OK to save your changes.
 
Deleting a Special Reserve Group
To delete a special reserve group from the M3 system:
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1.      In the Group Editor window, select the group to be deleted.
 
2.      Click Delete.
 
NOTE: If members are assigned to the group, the message “You cannot delete a group that has members” appears.
 
3.      If the group has no members, a confirmation prompt appears. Click Yes to proceed with the
deletion.
 
Warning: You cannot undo this  deletion.
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Using Cataloging
 
This chapter explains:
•     How to search for, create, and edit records
•     How to update Authority Control
•     How to use the find and replace utility
•     How to mark records for deletion and purge marked records
•     How to import records, including pictures
•     How to export records
 
 
ABOUT CATALOGING
This chapter assumes the user is trained in MARC cataloging practices.
 
All records are entered into M3 as MARC records. They are divided into five dif- ferent databases:
Bibliographic, Holding, Patron, Authority, and Picture. Your M3 system may not have all five databases.
 
The M3 Cataloging module is a full MARC record editor. Use it to add, modify, and delete MARC records
in any of these databases.
 
 
STARTING M3  CATALOGING
To start the Cataloging module:
 
1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click Cataloging.
This displays the Cataloging Login dialog box.
 
2.      Type your user ID in the Login Name box, your password in the Password
box, and then click OK. This displays the Cataloging window (Figure 4.2).
 
 
SELECTING A  DATABASE
Your M3 system can access multiple catalog databases. If multiple databases are available, select the
catalog database you want to use. To do so:
 
1.      On the File menu, click Change Database. This displays the Change Data- base dialog box (Figure 4.1).
 
FIGURE  4.1

 
2.      In the Current Database  list, select the desired database.
 
3.      When finished, click OK.



 
Working with Bibliographic Records

© 2014 Mandarin Library Automation, Inc. All rights reserved.
52 of 361

Working with Bibliographic Records
 
Cataloging Window Features
The bibliographic version of the Cataloging window (Figure 4.2) has a split window that displays brief
bibliographic and holding records. The bibliographic record version of this window is shown in Figure
4.2.
 
FIGURE  4.2

 
•     Cataloging menu bar – Contains the File, Edit, View, and Help menus.
 
•     From the File menu (Figure  4.3), create new records, import and export records, change
databases, and access printing commands.

 
FIGURE  4.3

 
 

•     From the Edit menu (Figure  4.4), access the commands  Undo Find/ Replace, Search,
Duplicate,  Find, Select/Deselect All Records,  Delete/Unde- lete Selected  Records, Purge Deleted
Records, and Undo Save, as well as several optional features (if they are available in your M3
system).

 
FIGURE  4.4
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Tip: To sort information by any field in the pane, click the field’s column heading. One click sorts in ascending order; a second click
sorts  in descending order.
 

•     From the View menu, enable/disable  the status bar display on the Cat- aloging window.
 
•     From the Help menu, access Cataloging Help topics and connect to the
Mandarin Web page.
 
•     Column headings – Each pane includes a set of column headings. These are names that
identify the MARC record field displayed below each heading.
 
•     Bibliographic records pane – After a bibliographic record search, this pane lists brief
bibliographic records matching the search query. Your library can configure which MARC fields
display in this pane.
 
•     Holding  records pane – After a bibliographic record search, this pane lists brief holding
records matching the search query. The list of holding records corresponds to the bibliographic
record selected in the upper pane. Your library can configure which MARC fields display in this
pane.
 
 
•     Status bar – The status bar displays the current database being used and the number of
bibliographic and holding records found matching the search query.
 

Searching for  a Bibliographic Record
The Search Dialog Box
The default bibliographic version of the Search dialog box is shown in Figure 4.5.
 
FIGURE  4.5
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Search Tips:
• You can apply the trunca- tion asterisk (*) to the begin- ning and/or end of a keyword; the wildcard  question mark (?) character
within  a keyword (wom?n); and quotation marks (“ ”) around a phrase.
• You can use the AND, OR, and NOT Boolean operators to connect keywords within  a keyword box. Be sure to type operators in
capital letters.
 
All M3 Search dialog boxes use the keyword search method. You can search for keywords in as many as
three bib record fields.
 
NOTE: Options in the record field lists are the search attributes defined by Z39.50 protocol. Among other options, they include
MARC record fields and indexes of multiple MARC record fields. For simplicity, this Users Guide refers to them as MARC fields.
 
Your system can be configured to display different default MARC fields and
Boolean operators.
 
How to Search
To search for a bibliographic record:
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.5).
 
2.      In the Search For list, select Bibliographic.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator.
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.6).
 
FIGURE  4.6
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5.      From here, you can:
 

•     Click any bib record in the upper pane to display corresponding holding records in the lower
pane.
 
•     Double-click a brief bib or holding record to view its full MARC record. A full MARC bib
record matching this search is shown in Figure 4.12; a full MARC holding  record is shown in
Figure 4.17.
 
•     Select a check box to tag the corresponding record for deletion or printing. To tag a block
of records, select the first record and press SHIFT while selecting the last record; this tags all
records in between.
 
•     Print tagged records or all records in the list. To do so, select Print on the File menu, then
click Records (to print tagged) or List (to print all).
 
•     Create a new similar record by clicking Duplicate on the Edit menu. (For instructions, see
“Creating a Bibliographic Record” on page 4-6.)
 
•     Move (not copy) a holding record from one bib record to a different bib record. To do so, click
and drag the holding record to the appro- priate bib record.
 
•     Start another search from the Edit menu.

 
 
Creating a Bibliographic Record
There are three ways to create a new bibliographic record: (1) You can use a tem- plate and edit it to
match the new record; (2) You can duplicate an existing biblio- graphic record, then edit it to create
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the new record; (3) You can click New in the After Saving group when creating or editing a different
bib record. The first two methods are explained in the following sections, “From a Template” and “By
Dupli- cating an Existing Bib Record.” The third method is explained in the New bullet in step 5 of
“Editing a Bibliographic Record” on page 4-8.
 
From a Template
1.      On the File menu, select New, and then click Bibliographic Record. This dis- plays the Templates
dialog box (Figure 4.7).
 
FIGURE  4.7

 
 
2.      Click the appropriate template for the record you want to create, then click OK. This displays the
template in the Bibliographic - Cataloging window (Figure 4.8).
 
FIGURE  4.8

 
Note: If you do not want empty fields to be deleted when the record is saved, change the Strip Empty Fields entry in the Active-
MarcEdit.ini file (located in your M3 directory) to OVER- RIDE=on, then restart  the Cataloging module. Authority Control users
should not change this setting.
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FIGURE  4.9

 
Tip: To insert a picture field in this record so a picture displays  alongside the record when it is involved in a trans- action,  see
“Adding  a Picture Field  to a Bibliographic  or Patron Record”  on page 5-38.

3.      Enter field and subfield data for the new record. To move through the record, use your keyboard up
and down arrows. Notice that status bar information changes to identify the selected field and subfield.
 

•     To access a menu with edit commands (Figure 4.9), right-click the field or subfield you want
to edit. From this menu, you can insert, delete, cut, copy, paste, and move fields. You can click
Find to locate text within this record, or click Toggle Prompts to change the MARC field labels
from numbers to text.
 
•     To access a list of fixed field standard choices (including position and legal characters)
pertaining to a particular fixed field, double-click in the field. The dialog box for fixed field 008 is
shown in Figure 4.10. You can define your fixed field by typing in text or, where available, clicking
the arrow button and selecting an option in the list. When fin- ished, click OK.

 
FIGURE  4.10
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•     If you are using a version of M3 that supports Authority Control, and the field you want to edit is
managed under Authority Control, then the field is not editable (unless you use the Override Authority
feature explained on page 4-10). To select an authority record, click subfield a in the white edit area of
the subfield (shown in Figure 4.12). This displays the Authority Records dialog box (Figure 4.11).
 
FIGURE  4.11

 
Select the authority record you want to use, then click OK. This returns you to the Bibliographic -
Cataloging window (Figure 4.8) and enters the new record in the selected field.
 

•     To save a version of this record as a template for future use, click Save As Template on the File
menu.



 
Working with Bibliographic Records

© 2014 Mandarin Library Automation, Inc. All rights reserved.
59 of 361

 
4.      Click Validate to check for errors in the record. If any errors appear in the Validation  Errors box, fix
or ignore them. To view information explaining each error, click the plus (+) sign to the left of the error.
 
5.      When finished editing the record and validating errors (but before saving), click an option in the
After Saving group to indicate what you want to happen after you save the record. The options are:
 

•     Close exits the saved record and returns to the Cataloging window.
 
•     Duplicate creates a new record identical to the one you are saving; you can edit the duplicate
record to create another record.
 
•     New exits the saved record and displays a new template window to modify. (If more than one
bib template is available, the Templates dialog box displays. Select a template, then click OK.)
 
•     Create Holding exits the saved record and displays a corresponding holding record template
where you can add local information such as call number, barcode number, and location. If
more than one template is available, the Templates dialog box displays, allowing you to select a
template.
 

 
6.      To mark this record for deletion, select the Mark for Deletion check box.
For instructions on purging records marked for deletion, see “Step 2: Purging Records Marked for
Deletion” on page 4-47.
 
7.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
By Duplicating an Existing Bib Record
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.5).
 
2.      In the Search For list, select Bibliographic.
 
3.      Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or operator. (For
search tips, see page 4-4.)
 
4.      Click Search. This displays a list of bib and holding records matching your search query.
 
5.      Click the bib record to be duplicated. On the Edit menu, click Duplicate.
This displays the Bibliographic - Cataloging window (Figure 4.8) con- taining the corresponding  full
MARC record. This is a duplicate MARC bib record.
 
6.      Edit this record as needed. For instructions, see steps 3 through 5 begin- ning on page 4-7.
 
7.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
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Editing a Bibliographic Record
To edit a bib record:
 
1.      If the record to be edited is not displayed:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.5).
 
B.     In the Search For list, select Bibliographic.

 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of bib and holding records matching your search query.
 
E.     Double-click the bib record you want to edit. This displays the selected record in full MARC
format (Figure 4.12).

 
FIGURE  4.12

 
Tip: To navigate through the records in the search results list, click the navigation buttons First, Prev, Next, and Last.
 
Note:  To  have access to the Override Authority  feature, the Override Authority check box must  be selected  in Group Editor.
 
2.      Edit this record as needed. For instructions, see steps 3 through 6 begin- ning on page 4-7.
 
3.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
Using the  Override Authority Feature
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If you are using a version of M3 that supports Authority Control, the Override Authority feature
allows you to edit fields in a bibliographic record that are man- aged under Authority Control. It can be
utilized when creating or editing a biblio- graphic record.
 
To use the Override Authority feature:
 
1.      Display the bibliographic record you want to edit in the Bibliographic - Cataloging window (Figure
4.12). (For instructions on locating and dis- playing a record, follow steps 1A through 1E in “Editing a
Bibliographic Record” on page 4-9.)
 
2.      Select the Override Authority check box. This makes all Authority Control- managed fields editable.
 
3.      Click in the white edit area of the field you want to edit and type new entries as desired.
 
4.      When finished, click Save in the Bibliographic - Cataloging window.
 
5.      Verify your bibliographic records for consistency. To do so, see the following section, “Verifying
Bibliographic Records with Authority Control.”
 
Note: After the update, any records  that  cannot  be veri- fied appear in the Cataloging window.
 
Verifying Bibliographic Records with Authority Control
If you are using a version of M3 that supports Authority Control, you will want to verify your
bibliographic records for consistency  after the initial record import and subsequent imports. When you
update, M3 matches the authority fields in all bibliographic records against the local authority table to
ensure that all records are using the correct authority fields.
 
Verifying Records
To verify all records or newly added records:
 
On the Edit menu, select Bibliographic, select Update Authority Control, and then click one of the
following:
 

•     Verify All – Checks all records.
 
•     Verify New – Checks all records added since the last update.

 
 
To verify selected records:
 
1.      In the brief MARC record list, select the check box by each bibliographic record you want to verify.
 
2.      Right-click in the Bibliographic records pane. In the command menu, click
Verify Selected  Records. This checks only the selected records.
 
Unlinking Bibliographic Records from Authority Records If you are using a version of M3 that supports
Authority Control, you can remove the links between ALL bibliographic  and authority records. To do
so:
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On the Edit menu, select Bibliographic, select Update Authority Control, and then click Unlink
Bibliographic.
 
NOTE: To use Authority Control after performing this procedure,  you must click Verify All to reverify your records. For
instructions, see the preceding section, “Verifying Bibliographic Records with Authority Control.”
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Working with Holding Records
 
 
Cataloging Window Features
As with the bib version of the Cataloging window, the holding record version has a split window that
displays brief bibliographic and holding records. However, the panes are reversed; the holding record
appears in the top pane and the corre- sponding bib record appears in the lower pane. The holding
version of the window is shown in Figure 4.13. The other window features are similar to the bib
version; see “Cataloging Window Features” on page 4-2 for descriptions.
 
FIGURE  4.13

 
Searching for  a Holding Record
 
The Search Dialog Box
The default holding version of the Search dialog box is shown in Figure 4.14.
 
FIGURE  4.14
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All M3 Search dialog boxes use the keyword search method. You can search for keywords in as many as
three holding record fields.
 
NOTE: Options in the record field lists are the search attributes defined by Z39.50 protocol. Among other options, they include
MARC record fields and indexes of multiple MARC record fields. For simplicity, this Users Guide refers to them as MARC fields.
 
Your system can be configured to display different default MARC fields and Boolean operators.
 
How to Search
To search for a holding record:
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.14).
 
2.      In the Search For list, select Holdings.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.15).
 
FIGURE  4.15

 
5.      From here, you can:
 

•     Double-click a brief holding or bib record to view its full MARC record. A full MARC holding
record matching this search is shown in Figure 4.17.
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•     Select a check box to tag the corresponding record for deletion or printing. To tag a block
of records, select the first record and press SHIFT while selecting the last record; this tags all
records in between.
 
•     Print tagged records or all records in the list. To do so, select Print on the File menu, then
click Records (to print tagged) or List (to print all).
 
•     Create a new similar record by clicking Duplicate on the Edit menu. (For instructions, see
“Creating a Holding Record” on page 4-14.)
 
•     Start another search from the Edit menu.
 

 
Creating a Holding Record
To create a holding record:
 
1.      Locate the bib record matching the holding record you want to create.
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.14).
 
B.     In the Search For list, select Bibliographic.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of bib and holding records matching your search query
(Figure 4.15).

 
2.      Click the bib record matching the holding record you want to create.
 

•     If a holding record similar to the one you want to create appears in the lower pane, use this
as a template. Click the brief holding record, then click Duplicate on the Edit menu.
OR
 
•     If no similar holding record exists, select New on the File menu, and then click Holding
Record. (If more than one holding template is avail- able, the Templates dialog box displays
(Figure 4.7). Click the desired template, then click OK.) This displays the holding record
template in the Holding - Cataloging window (Figure 4.16). The template displays some entries
from the bib record you selected, including the prefix (852#k).

 
FIGURE  4.16
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3.      Enter field and subfield data for the new record. For instructions, see step 3 beginning on page 4-7.
NOTE: Since Authority Control fields are not available for holding records, skip the Authority Control
option explained on page 4-8.
 
 
Tip: If you want the holding record to display  a status  of “unavailable” in the OPAC (for example, until  you have received the
item), insert field 994#a (Status). In the 994#a field list, select i=IN PROCESS.

4.      When finished editing the record (but before saving), click an option in the After Saving group. This
selection indicates what you want to happen once you save the record. The options are:
 

•     Close exits the saved record and returns to the Cataloging window.
 
•     Duplicate creates a new record identical to the one you are saving; you can edit the duplicate
record to create another record.
 
•     New Bib exits the saved record and displays the Templates dialog box, allowing you to select
a new bib template to edit.
 
•     New Holding exits the saved record and displays a new holding tem- plate to edit in the
holding records pane. If more than one holding template is available, the Templates dialog box
displays, allowing you to select a template.

 
Note: You cannot generate holdings from a holding record that is marked for dele- tion.
 
Note: The prefix  and suffix values are assigned in 852#p.
 
Note:  Do not select the Mark for Deletion check box if you selected the Generate Hold- ings option in step 4.
 

OR
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•     Select the Generate Holdings check box to create multiple holding records, using the holding
record displayed in the lower pane as a template.

 
A.     Type the number of holdings you want to add in the Quantity box.
NOTE: This number is in addition to the holding records that already exist for this
bibliographic  record.
 
B.     If the record’s barcode has a prefix, it appears in the BC Prefix box. Modify if desired. If the
barcode does not have a prefix and you would like to add one, type a value in the BC Prefix box.
 
C.     The barcode suffix appears in the Start box. Modify if desired. The suffix must be a numeric
value and will be the starting value for the barcodes of the new holding records.
 
D.     In the + box, type the number by which you want the suffix to increment. For example, if
the values are 1000 in the Start box and 2 in the + box, the first holding record will be assigned a
barcode of [Prefix]1000 and the next holding record will be assigned [Prefix]1002.

 
5.      To mark this record for deletion, select the Mark for Deletion check box.
For instructions on purging records marked for deletion, see “Step 2: Purging Records Marked for
Deletion” on page 4-47.
 
6.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in step 4.
 
NOTE: If you selected Generate Holdings in step 4 and a barcode created by this procedure already exists, an error message displays
and no holdings are created. Click OK and modify the value in the Start and/or + box, then click Save again.
 
 
Editing a Holding Record
To edit a holding record:
 
1.      If the record to be edited is not displayed:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.14).
 
B.     In the Search For list, select Holdings.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of bib and holding records matching your search query.
 
E.     Double-click the holding record you want to edit. This displays the selected record in full
MARC format (Figure 4.17).
 

FIGURE  4.17
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Tip: To navigate through the records in the search results list, click the navigation buttons Prev, Next, First, and Last.
 
2.      Edit this record as needed. For instructions, see step 3 beginning on page 4-7. NOTE: Since
Authority Control fields are not available for holding records, skip the Authority Control option
explained on page 4-8.
 
3.      When finished editing the record (but before saving), click an option in the After Saving group or
select the Generate Holdings check box. For instructions, see step 4 on page 4-15.
 
4.      To mark this record for deletion, select the Mark for Deletion check box.
For instructions on purging records marked for deletion, see “Step 2: Purging Records Marked for
Deletion” on page 4-47.
 
5.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
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Working with Patron Records
 
Cataloging Window Features
The patron version of the Cataloging window is similar to the bib version (shown in Figure 4.2), except it
only contains patron records. The patron version of the window is shown in Figure 4.18. The other window
features are similar to the bib version; see “Cataloging Window Features” on page 4-2 for descriptions.
 
FIGURE  4.18

 
Searching for  a Patron Record
 
The Search Dialog Box
The default patron version of the Search dialog box is shown in Figure 4.19.
 
FIGURE  4.19
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All M3 Search dialog boxes use the keyword search method. You can search for keywords in as many as
three patron record fields.
 
 
Your system can be configured to display different default patron record fields and Boolean operators.
 
How to Search
To search for a patron record:
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
2.      In the Search For list, select Patrons.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query
 
FIGURE  4.20

 
5.      From here, you can:
 
•     Double-click a brief patron record to view its full MARC record. A full MARC patron record
matching this search is shown in Figure 4.23.
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•     Select a check box to tag the corresponding record for deletion or printing. To tag a block of records,
select the first record and press SHIFT while selecting the last record; this tags all records in between.
 
•     Print tagged records or all records in the list. To do so, select Print on the File menu, then click
Records (to print tagged) or List (to print all).
 
•     Create a new similar record by clicking Duplicate on the Edit menu. (For instructions, see “Creating
a Patron Record” on page 4-19.)
 
 
•     Start another search from the Edit menu.
 
Creating a Patron Record
There are two ways to create a new patron record. (1) You can use a template and edit it to create the
new record. (2) You can duplicate an existing patron record, then edit it to create the new record.
 
From a Template
1.      On the File menu, select New, and then click Patron Record. (If more than one patron template is
available, the Templates dialog box displays (Figure 4.7). Click the desired template, then click OK.)
This displays the patron record template in the Patron - Cataloging window (Figure 4.21).
 
FIGURE  4.21

 
Note: To automatically  delete all fields left empty when the record is saved, change the Strip Empty Fields entry in the
ActiveMarcEdit.ini file (located in your M3 direc- tory)  to OVERRIDE=off, then restart  the Cataloging module.
 
Tip: To insert a picture field in this record so a picture displays  alongside the record- when it is involved in a trans- action,  see
“Adding  a Picture Field  to a Bibliographic  or Patron Record”  on page 5-38.
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2.      Enter field and subfield data for the new record. To move through the record, use your keyboard up
and down arrows. Notice that status bar information changes to identify the selected field and subfield.
 

•     To access a menu with edit commands (Figure 4.9), right-click the field or subfield you want
to edit. From this menu, you can insert, delete, cut, copy, paste, and move fields. You can click
Find to locate text within this record, or click Toggle Prompts to change the MARC field labels
from numbers to text.
 
•     To access a list of Leader field standard choices (including position and legal characters),
double-click in the Leader field. This displays the Fixed Field dialog box (Figure 4.22). In the
Record Status list, select a status, then click OK.

 
FIGURE  4.22

 
 

•     To save a version of this record as a template for future use, click Save As Template on the File
menu.

 
3.      When finished editing the record (but before saving), click an option in the After Saving group to
indicate what you want to happen after you save the record. The options are:
 

•     Close exits the saved record and returns to the Cataloging window.
 
•     Duplicate creates a new record identical to the one you are saving; you can edit the duplicate
record to create another record.
 

4.      To mark this record for deletion, select the Mark for Deletion check box.
For instructions on purging records marked for deletion, see “Step 2: Purging Records Marked for
Deletion” on page 4-47.
 
5.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
By Duplicating an Existing Patron Record
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
2.      In the Search For list, select Patrons.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
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4.      Click Search. This displays a list of records matching your search query (Figure 4.20).
 
5.      Click the patron record to be duplicated.  On the Edit menu, click Duplicate. This displays the
Patron - Cataloging window (Figure 4.21) containing the corresponding  full patron record. This is a
duplicate patron record.
 
6.      Edit the record as needed. For instructions, see steps 2 through 4 begin- ning on page 4-19.
 
7.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
 
Editing a Patron Record
To edit a patron record:
 
1.      If the record to be edited is not displayed:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
B.     In the Search For list, select Patrons.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of brief patron records matching your search query (Figure
4.20).

 
E.     Double-click the patron record you want to edit. This displays the corresponding  full record
(Figure 4.23).

 
FIGURE  4.23
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Tip: To navigate through the records in the search results list, click the navigation buttons Prev, Next, First, and Last.
 
2.      Edit this record as needed. For instructions, see steps 2 through 4 begin- ning on page 4-19.
 
3.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
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Working with Authority Records
 
 
 
Note: You must use a version of M3 that supports Authority Control to work with authority records.
 
Cataloging Window Features
As with the bib and holding versions of the Cataloging window, the authority record version has a
split window that displays brief authority and bibliographic records. The default authority version
of the window is shown in Figure 4.24. The other window features are similar to the bib version; see
“Cataloging Window Fea- tures” on page 4-2 for descriptions.
 
FIGURE  4.24

 
Searching for  an  Authority Record
The Search Dialog Box
The default authority version of the Search dialog box is shown in Figure 4.25.
 
FIGURE  4.25
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All M3 Search dialog boxes use the keyword search method. You can search for keywords in as many as
three authority record fields.
 
Your system can be configured to display different default authority record fields and Boolean
operators.
 
How to Search
To search for an authority record:
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select Authority.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.26).
 
FIGURE  4.26
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5.      From here you can:
 

•     Double-click a brief authority record to view its full MARC record. A full MARC authority
record matching this search is shown in Figure 4.29.
 
•     Select a check box to tag the corresponding record for deletion or printing. To tag a block
of records, select the first record and press SHIFT while selecting the last record; this tags all
records in between.
 
•     Print tagged records or all records in the list. To do so, select Print on the File menu, then
click Records (to print tagged) or List (to print all).
 
 
•     Create a new similar record by clicking Duplicate on the Edit menu. (For instructions, see the
following section, “Creating an Authority Record.”)
 
•     Start another search from the Edit menu.

 
Creating an  Authority Record
There are three ways to create a new authority record. (1) You can use a template and edit it to create
the new record. (2) You can duplicate an existing authority record, then edit it to create the new record.
(3) You can use the Quick Editor method (see “Using the Authority Record Quick Editor” beginning on
page 4-27).
 
From a Template
1.      On the File menu, select New, and then click Authority Record. (If more than one authority template
is available, the Templates dialog box displays (Figure 4.7). Click the desired template, then click OK.)
This displays the authority record template in the Authority - Cataloging window
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(Figure 4.27).
 
FIGURE  4.27

 
Tip: To add an authority record using  the Quick Editor method,  see “Using the Authority Record Quick Editor”  beginning on
page 4-27.
 
Note: To automatically  delete all fields left empty when the record is saved, change the Strip Empty Fields entry in the
ActiveMarcEdit.ini file (located in your M3 direc- tory)  to OVERRIDE=off, then restart  the Cataloging module.
 
2.      Enter field and subfield data for the new record. To move through the record, use your keyboard up
and down arrows. Notice that status bar information changes to identify the selected field and subfield.
 

•     To access a menu with edit commands (Figure 4.9), right-click the field or subfield you want
to edit. From this menu, you can insert, delete, cut, copy, paste, and move fields. You can click
Find to locate text within this record, or click Toggle Prompts to change the MARC field labels
from numbers to text.
 
 
•     To access a list of fixed field standard choices (including position and legal characters)
pertaining to a particular fixed field, double-click in the field. The dialog box for fixed field 000
is shown in Figure 4.28. You can define your fixed field by typing in your text, or, where avail-
able, clicking the arrow button and selecting an option in the list. When finished, click OK.

 
FIGURE  4.28
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•     To save a version of this record as a template for future use, click Save As Template on the File
menu.

 
3.      When finished editing the record (but before saving), click an option in the After Saving group to
indicate what you want to happen after you save the record. The options are:
 

•     Close exits the saved record and returns to the Cataloging window.
 
•     Duplicate creates a new record identical to the one you are saving; you can edit the duplicate
record to create another record.

 
4.      To mark this record for deletion, select the Mark for Deletion check box.
For instructions on purging records marked for deletion, see “Step 2: Purging Records Marked for
Deletion” on page 4-47.
 
5.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the previous step.
 
By Duplicating an Existing Authority Record
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
2.      In the Search For list, select Authority.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.26).
 
5.      Click the authority record to be duplicated. On the Edit menu, click Dupli- cate. This displays the
Authority - Cataloging window (Figure 4.27) containing the corresponding  full authority record. This is
a duplicate authority record.
 
6.      Edit this record as needed. For instructions, see steps 2 through 4 begin- ning on page 4-24.
 
7.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
Editing an  Authority Record
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To edit an existing authority record:
 
1.      If the record to be edited is not displayed:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
B.     In the Search For list, select Authority.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of brief authority records matching your search query.
 
E.     Double-click the authority record you want to edit. This displays the corresponding  full
record (Figure 4.29).

 
FIGURE  4.29

 
 
 
Tip: To navigate through the records in the search results list, click the navigation buttons Prev, Next, First, and Last.
 
2.      Edit this record as needed. For instructions, see steps 2 through 4 on page 4-24.
 
3.      When finished, click Save. This saves the record and displays another record or the Cataloging
window, depending on which option you selected in the After Saving group.
 
 
Using the  Authority Record Quick Editor
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The Quick Editor offers a simplified method for quickly creating and editing authority records. This
method provides several commonly-used authority sub- fields, in a predetermined order, for each
type of authority record. It also allows you to quickly add, edit, and delete “See From” and “See Also
From” references. This method offers only limited access to authority record fields. For full access to
additional fields or to change the order of subfields, use the MARC record editor method explained in
“Creating an Authority Record” and “Editing an Authority Record” beginning on page 4-24.
 
Creating an Authority Record Using the Quick Editor
1.      On the File menu, select New, and then click Authority Record. This displays the Templates dialog
box (Figure 4.30).
 
FIGURE  4.30

 
 
2.      Click the desired type of authority record, then click OK. This displays the authority record
template in MARC format in the Authority - Cataloging window (Figure 4.31).
 
FIGURE  4.31

 
Tip: For information  on the After  Saving  and Mark  for Deletion  options in this window, see steps 3 and 4 on page 4-25.
 
3.      Click Quick. This displays the Authority - Cataloging Quick Editor window.
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The fields available in the Heading group vary depending on the type of authority record selected in
step 2. Shown in Figure 4.32 is the Quick Editor window for a Personal Name authority record.
 
FIGURE  4.32

 
See From references (MARC authority field 4xx) lead a searcher from an unauthorized  heading to an authorized  heading. See
Also From references (MARC authority field 5xx) lead a searcher from an authorized heading to another related authorized
heading.
 
 
NOTE: If you need access to additional fields or otherwise prefer to edit the record in MARC format, click MARC. This returns the
record to MARC format (shown in Figure 4.31).
 
4.      In the Heading group, type entries as desired.
 
5.      In the See From References group, click Add. This displays the See From Ref- erences dialog box
(Figure 4.33).
 
FIGURE  4.33
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Type entries as desired, then click OK. This places the entries in the See From References  box in the
Authority - Cataloging window.
 
6.      In the See Also From References  group, click Add. This displays the See Also From References
dialog box, which contains the same fields as the See From References dialog box (Figure 4.33). Type
entries as desired, then click OK. This places the entries in the See Also From References  box in the
Authority - Cataloging window.
 
 
7.      When finished, click Save in the Authority - Cataloging window.
 
Editing  an Authority Record Using the Quick Editor
1.      Display the record you want to edit in the Authority - Cataloging window (Figure 4.34). (For
instructions on locating and displaying a record, follow steps 1A through 1E in “Editing an Authority
Record” on
page 4-26.)
 
FIGURE  4.34

 
2.      Click Quick. This displays the Authority - Cataloging Quick Editor window.
The fields available in the Heading group vary depending on the type of authority record you are
editing. Shown in Figure 4.35 is the Quick Editor window for a Personal Name authority record.
 
FIGURE  4.35
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See From references (MARC authority field 4xx) lead a searcher from an unauthorized  heading to an authorized  heading. See
Also From references (MARC authority field 5xx) lead a searcher from an authorized heading to another related authorized
heading.
 
 
NOTE: If you need access to additional fields or otherwise prefer to edit the record in MARC format, click MARC. This returns the
record to MARC format (shown in Figure 4.34).
 
3.      In the Heading group, edit entries as desired.
 
4.      In the See From References  group, select a reference, then click Delete or Edit.
 

•     If you click Delete, the reference is deleted and removed from the See From References  box.
 
•     If you click Edit, the See From References dialog box displays (Figure 4.36).

 
FIGURE  4.36
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Edit entries as desired, then click OK. This updates the entries in the
See From References  box in the Authority - Cataloging window.
 
5.      In the See Also From References  group, select a reference, then click Delete
or Edit.
 

•     If you click Delete, the reference is deleted and removed from the See Also From References 
box.
 
•     If you click Edit, the See Also From References dialog box displays, which contains the same
fields as the See From References dialog box (Figure 4.36). Edit entries as desired, then click
OK. This updates the entries in the See Also From References box in the Authority - Cataloging
window.

 
6.      When finished, click Save in the Authority - Cataloging window.
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Working with Picture Records
 
Cataloging Window Features
The picture version of the Cataloging window is similar to the bib version (shown in Figure 4.2), except
it only contains picture records. The picture version of the window is shown in Figure 4.37. The other
window features are similar to the bib version; see “Cataloging Window Features” on page 4-2 for
descriptions.
 
FIGURE  4.37

 
Displaying Item and  Patron Pictures
Pictures can be imported into your M3 database and displayed in the OPAC and Circulation modules.
Item pictures, such as cover images, can be displayed in the OPAC and Circulation; patron photos can
be displayed in Circulation. For instruc- tions on importing images, see “Using M3 Picture Manager” on
page 4-49.
 
In the OPAC
After importing pictures into your M3 database, you must enable them in the M3Opac.ini file. For
instructions, see “Enabling Cover Images” on page 6-31. The images can then be viewed in the OPAC
Search Results, Record Details, Bookbag Record List, and Bookbag Record Details windows.
 
In Circulation
Once pictures are imported into your M3 database, they display automatically alongside patrons and
items in the Circulation Patron and Item panes if M3 v1.6 was your first installation of M3. If you had
a version of M3 installed prior to installing 1.6, you must do the following:
 

•     Add a graphic cell to the Patron pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Mod- ifying the Patron Pane Display” on page 5-59.
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•     Add a graphic cell to the Item pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Mod- ifying the Item Pane Display” on page 5-64.

 
Searching for  a Picture Record
 
The Search Dialog Box
The default picture version of the Search dialog box is shown in Figure 4.38.
 
FIGURE  4.38

 
All M3 Search dialog boxes use the keyword search method. You can search for keywords in as many as
three picture record fields.
 
Your system can be configured to display different default picture record fields and
Boolean operators.
 
How to Search
To search for a picture record:
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
2.      In the Search For list, select Pictures.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.20).
 
FIGURE  4.39
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5.   From here, you can:
 

•     Double-click a brief picture record to view its full MARC record. A full MARC picture record
is shown in Figure 4.42.
 
•     Select a check box to tag the corresponding record for deletion or printing. To tag a block
of records, select the first record and press SHIFT while selecting the last record; this tags all
records in between.
 
•     Print tagged records or all records in the list. To do so, select Print on the File menu, then
click Records (to print tagged) or List (to print all).
 
•     Create a new similar record by clicking Duplicate on the Edit menu. (For instructions, see
“Creating a Patron Record” on page 4-19.)
 
•     Start another search from the Edit menu.
 

Creating a Picture Record
There are two ways to create a new picture record. (1) You can use a template and edit it to create the
new record. (2) You can duplicate an existing picture record, then edit it to create the new record.
 
From a Template
1.      On the File menu, select New, and then click Picture Record. This displays the template in the
Picture Manager dialog box (Figure 4.40)
 
FIGURE  4.40
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2.      In the Image Source group, select the source of the picture. Depending on the source selected, you
must search for or navigate to the picture (for instructions on using the options in this group, see step
6 in “Adding a Pic- ture Field to a Bibliographic or Patron Record” on page 5-39). After the picture is
selected, it appears in the Preview pane (Figure 4.41).
 
FIGURE  4.41

 
 
3.      Enter field and subfield data for the new record. To access a menu with edit commands (Figure
4.9), right-click the field or subfield in the Record pane that you want to edit. From this menu, you can
insert, delete, cut, copy, paste, and move fields. You can click Find to locate text within this record, or
click Toggle Prompts to change the MARC field labels from num- bers to text.
 
4.      When finished, click Save. This displays the Cataloging window with the new picture record listed.
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By Duplicating an Existing Picture Record
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.38).
 
2.      In the Search For list, select Pictures.
 
3.      Type your search query into the appropriate keyword boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field or
operator. (For search tips, see page 4-4.)
 
4.      Click Search. This displays a list of records matching your search query (Figure 4.39).
 
5.      Click the picture record to be duplicated.  On the Edit menu, click Duplicate. This displays the
Picture Manager window (Figure 4.41) containing the corresponding  full picture record. This is a
duplicate picture record.
 
6.      Edit the record as needed.
 
•     To change the source of the picture, select an option in the Image Source group. Depending on the
source selected, you must search for or navigate to the picture (for instructions on using the options
in this group, see step 6 in “Adding a Picture Field to a Bibliographic or Patron Record” on page 5-39.)
After the picture is selected, it appears in the Preview pane (Figure 4.42).
 
•     To access a menu with edit commands (Figure 4.9), right-click the field or subfield in the Record
pane that you want to edit. From this menu, you can insert, delete, cut, copy, paste, and move fields.
You can click Find to locate text within this record, or click Toggle Prompts to change the MARC field
labels from numbers to text.
 
7.      When finished, click Save. This displays the Cataloging window with the new picture record listed.
 
Editing a Picture Record
To edit a picture record:
 
1.      If the record to be edited is not displayed:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.19).
 
B.     In the Search For list, select Pictures.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays a list of brief picture records matching your search query
(Figure 4.39).
 
E.     Double-click the picture record you want to edit. This displays the corresponding  full
record (Figure 4.42).
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FIGURE  4.42

 
2.      Edit the record as needed.
 

•     To change the source of the picture, select an option in the Image Source group. Depending on
the source selected, you must search for or navigate to the picture (for instructions on using the
options in this group, see step 6 in “Adding a Picture Field to a Bibliographic or Patron Record”
on page 5-39). After the picture is selected,  it appears in the Preview pane (Figure 4.42).
 
•     To access a menu with edit commands (Figure 4.9), right-click the field or subfield in the
Record pane that you want to edit. From this menu, you can insert, delete, cut, copy, paste, and
move fields. You can click Find to locate text within this record, or click Toggle Prompts to change
the MARC field labels from numbers to text.

 
3.      When finished, click Save.
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Using Find and Replace to Modify Records
 
The M3 Cataloging module includes a Find and Replace utility that allows you to modify bibliographic,
holding, patron, authority, and picture records. Use this utility to modify all occurrences of a keyword
in all selected records, or to selec- tively modify occurrences in a specific record.
 
To use the Find and Replace utility:
 
1.      Verify that you are working with the correct database. For instructions, see “Selecting a Database”
on page 4-2.
 
2.      Isolate the records you want to modify. To do so:
 

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
B.     In the Search For list, select the type of records you want to modify.

 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
 

C.     Type your search query into the appropriate keyword boxes. To select a different MARC field
or Boolean operator, click the arrow next to the appropriate list, and then select the preferred
field or operator. (For search tips, see page 4-4.)
 
D.     Click Search. This displays the list of brief records matching your search query.

 
3.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select the type of record you want to include, and
then click Select All Records. This places a check mark by all brief records in the list.
 
Tip: You can also display  the Find  dialog box by right- clicking  the search results.
 
FIGURE  4.43

 
4.      On the Edit menu, select the type of records you want to modify, and then click Find. This displays 
the Find dialog box (Figure 4.43).
 
5.      Enter the desired find and replace parameters. To do so:
 

A.     In the Find box, type the existing text you want to find and replace. This text can be any
alphabetic or numeric character string, including punctuation.
 
B.     In the In list, specify the MARC field that contains the text you want to replace.
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•     To indicate a specific field, type or select the desired field.
 
•     To indicate any field (whether in the current record or all records isolated in step 2),
select <global>.  This looks for the text in all fields.

 
C.     In the Replace with box, type the replacement text.
 
D.     In the Search options group, select the appropriate options to fine-tune your search. Your
choices are:

 
•     Match whole word only – Locates  exact  text typed into the Find box, treating your
text as a whole word. For example: If you type cat, only cat occurrences are found, and
other words such as catalog and scatter are ignored. (Match whole word only and Match
whole field only cannot be selected in the same operation.)
 
•     Match whole field only – Locates exact text typed in the Find box, but only when that
text is the entire content of a field.
 
•     Match case – Locates exact text typed in the Find box, but only if the case matches.
 
 
•     Wildcards – Allows a user to apply the truncation asterisk (*) to the beginning and/or
end of text typed in the Find box, and the wild- card question mark (?) within text in the
Find box. Wildcard usage broadens your search.
 
•     Regular expression  – Allows an advanced user to search using regular expression
  notation rather than plain text. Regular expressions allow you to use a character 
string that has special meaning when used in a pattern. For example, the string /eg*/
would find easy, egocentric, egg, and all other words that have zero or more occurrences
of the character preceding the asterisk (in this example, g). This is only one example of a
regular expression search; there are many characters  that can be used.

 
E.     Select the Advanced check box if you plan to use the advanced options. These options are
explained in “Using the Advanced Find and Replace Features” on page 4-39.

 
6.      Click the appropriate option button to proceed with the find and replace operation. The button you
choose depends on whether you want to find and replace in all records isolated in step 2, or in just the
selected record. To do so:
 

•     Click Replace All to replace text in all records isolated in step 2. This locates all occurrences
in all the selected records and replaces them simultaneously. This option does not allow you to
preview each occur- rence prior to replacement. If you click Replace All, this completes  the find
and replace operation.
OR
 
•     Click Find Next to limit the find operation to locating each occurrence of the search item,
one by one. This button searches all records to find the next occurrence of the text. (If you
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indicated a specific field in step 5B, Find Next lim its the find operation to that specific field in
the records.) When an occurrence is found, it is displayed and high- lighted, waiting for you to
preview the occurrence. Click in the Find dialog box and then select one of the following four
option buttons.
 
•     Find Next skips this occurrence without replacing the text, then finds and displays the next
occurrence.
 
•     Replace inserts replacement  text for that one occurrence, then waits for you to indicate the
next action. You must then click Find Next to look for the next occurrence.
 
•     Replace/Find inserts replacement  text for that one occurrence, then automatically finds and
displays the next occurrence.
 
•     Replace All inserts replacement  text for all occurrences simulta- neously.
 

NOTES:
•     To cancel the find and replace operation, click Cancel at any time. How- ever, any changes made prior to clicking Cancel are
saved.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Using the  Advanced Find and  Replace Features
The Find and Replace utility includes an Advanced mode that allows you to make sophisticated
modifications to bibliographic, holding, patron, authority, and pic- ture records. You can use the
Advanced mode to modify one or all occurrences  of a selected field, add a new field, delete a field, and
more by specifying your own find and replace parameters.
 
To use the Advanced Find and Replace mode, select the Advanced check box in the Find dialog box
(Figure 4.43). This displays the Advanced Find/Replace dialog box (Figure 4.44).
 
FIGURE  4.44
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In the Advanced Find group:
 

•     Limit search  to field occurrence – Limits a search to a specific field occur- rence or any, first,
or last field occurrence. (If only one occurrence exists, it qualifies as the first and the last.)
 
•     Limit search  to subfield occurrence – Limits a search to a specific subfield occurrence or any,
first, or last subfield occurrence. (If only one occurrence exists, it qualifies as the first and the
last.)
 
•     Limit search  to character positions – Limits a search to a specific range of character positions
in a field and/or subfield specified in the two prior check boxes. Note that the character position
starts at zero. For example, the third character in a character string is position 2, or the first
character in a character string is position 0 (zero). This is defined in the MARC stan- dard.

 
•     Match each control field, subfield or indicator as specified above (ignore find expression) –
Searches for a specific field or subfield, while ignoring the contents of the field.
 

In the Advanced Replace group:
 

•     Execute actions for each:
 
•     match – Limits the replace action to any match in any record.
 
•     record – Limits the replace action to any record regardless of match.
 
•     field specified above – Limits the replace action to the specified field.
 
•     subfield specified above – Limits the replace action to the specified sub- field.
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•     Actions only (ignore replace expression) – Carries out the actions selected using Action and its
options, and does not use the contents of the Replace with box.
 
•     Actions box – Lists the actions created using Action and its options, and places them in
the order they will be executed. Users can select the order of the actions in the Actions box by
clicking Move Up and Move Down.

 
•     Advanced Replace option buttons:
 
•     Action – Displays a list of options that allows the user to create one or more replace actions.
The replace actions are then listed in the Actions box. The option buttons are:
 
•     Wizard: Leads the user through the creation of an action.
 
•     Copy matching: Copies the contents of a field or subfield that contains text matching the Find
box into a user-specified field or subfield.
 
•     Copy existing: Copies the contents of an existing user-specified field or subfield into a
different user-specified field or subfield.
 
•     Move matching: Moves (changes the position of) a field or subfield containing text that
matches the Find box.
 
•     Move existing: Moves (changes the position of) an existing user- specified field or subfield.
 
•     Rename matching: Renames a matching field or subfield.
 
•     Rename existing: Renames an existing user-specified field or subfield.
 
•     Remove matching: Removes a matching field or subfield.
 
•     Remove existing: Removes an existing user-specified field or subfield.
 
•     Insert new: Inserts a new control field, field, or subfield.
 
•     Insert text: Inserts text into an existing control field, existing subfield, or indicator.
 
•     Move Up – Moves the currently-selected action in the Actions box up one position.
 
•     Move Down – Moves the currently-selected action in the Actions box down one position.

 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
 

•     Delete – Removes the currently selected action in the Actions box.
 
•     Delete All – Removes all actions in the Actions box.
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Example Find and  Replace Operations
NOTE: The following examples assume that the M3 system is installed and prop- erly running. The
examples also assume the user has the Cataloging module running and all rights configured so that the
Find and Replace utility operates properly.
 
Changing the  Contents of  a Field or Subfield
The first two examples explain how to replace the contents of a field or subfield.
 
Example 1: Correcting a spelling problem
This example shows how to correct misspelled words in records.
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select the type of records you want to search.
 
3.      In the first keyword box, type the misspelled word. To select a different MARC field, select the
preferred field in the record field list.
 
4.      Click Search. This limits the find and replace operation to only the records containing the misspelled
word, and reduces the time needed for the find and replace operation.
 
5.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select the type of record you want to include, and
then click Select All Records. This places a check mark by all brief records in the list.
 
6.      On the Edit menu, select the same record type you selected in step 2, and then click Find. This
displays  the Find dialog box (Figure 4.43).
 
7.      In the Find box, type the misspelled word.
 
8.      In the In lists,  specify the MARC field and subfield to which you want to limit the find and replace
operation.
 
9.      In the Replace with box, type the correct spelling of the word.
 
10. Select any of the search options check boxes needed to refine your search (Match case, Wildcards, and
so on).
 
11. Click Find Next. This locates the first occurrence of the Find text.
 
12. If you want the text replaced, click Replace. If you do not want the text replaced, click Find Next to
locate the next occurrence.
 
NOTES:
•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
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Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Example 2: Changing grade levels in a high school
When changing the grade level of a group of patrons, it is very important that you start the find and
replace from the patrons in the highest grade first. If you do not, then all the patrons will end up with
the same grade listed. (This example assumes the patron records contain the grade information. Also,
if your system is using groups to differentiate between the grade levels, there is no need to perform this
operation.)
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select Patron.
 
3.      In the first keyword box, type the highest grade level at your institution (for example, 12th grade).
To select a different MARC field, select the pre- ferred field in the record field list.
 
4.      Click Search. This limits the find and replace operation to only the records containing the grade
level you want to change, and reduces the time needed for the find and replace operation.
 
5.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select Patrons, and then click Select  All Records.
This places a check mark by all brief records in the list.
 
6.      On the Edit menu, select Patrons, and then click Find. This displays the Find dialog box (Figure
4.43).
 
7.      In the Find box, type the number 12.
 
8.      In the In lists,  select 852 and g to limit the find and replace operation to field 852#g.
 
9.      In the Replace with box, type the number 13.
 
10. Select the Match whole word only check box to make sure the find and replace does not find and
possibly change text like 120 or 1213. While this might not be needed in this case, it is a good habit.
 
11. Click Find Next. This locates the first occurrence of the Find text.
 
12. If you want the text replaced, click Replace. If you do not want the text replaced, click Find Next to
locate the next occurrence.
 
13. Repeat this procedure  until all grades have been promoted.  When finished, be sure to search for
and delete all 13th graders.
 
NOTES:
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•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
 
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Deleting and/or Obsoleting Unwanted Fields and/or Subfields
 
Example 3: Deleting all field occurrences of field 261
This example explains how to delete a field. We will search for and delete all field occurrences of 261.
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select Bibliographic.
 
3.      In the record field list, type the field tag number (261)  over the default field name.
 
4.      In the first keyword box, type an asterisk (*).
 
5.      Click Search. This limits the find and replace operation to only the records containing the
unwanted field, and reduces the time needed for the find and replace operation.
 
6.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select Bibliographic, and then click Select All
Records. This places a check mark by all brief records in the list.
 
7.      On the Edit menu, select Bibliographic, and then click Find. This displays the Find dialog box
(Figure 4.43).
 
8.      Select the Advanced check box. This displays the Advanced Find/Replace dialog box (Figure 4.44).
 
9.      Click Action, select Remove existing, and then click field.
 
10. In the first Field/occurrence list, select 261. If there are multiple occur- rences of the field, select which
occurrence should be replaced in the second Field/occurrence list, and then click Next.
 
11. Select the Execute actions for each check box, then click record.
 
12. Click Find Next. This locates the first occurrence of the Find text.
 
13. If you want the field removed, click Replace. If you do not want the field removed, click Find Next to
the locate the next occurrence.
 
NOTES:
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•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Adding a Field or Subfield
 
Example 4: Adding  a new field to a series of records
In this example,  we will add a local notes field to a series of records.
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select Bibliographic.
 
3.      Search for the records in which you want to add the new field. To do so, type your search query
into the appropriate keyword boxes. To select a different MARC field or Boolean operator, click the
arrow next to the appropriate list, and then select the preferred field or operator.
 
4.      Click Search. This limits the find and replace operation to only the records you want to modify, and
reduces the time needed for the find and replace operation.
 
5.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select Bibliographic, and then click Select All
Records. This places a check mark by all brief records in the list.
 
6.      On the Edit menu, select Bibliographic, and then click Find. This displays the Find dialog box
(Figure 4.43).
 
7.      Select the Advanced check box. This displays the Advanced Find/Replace dialog box (Figure 4.44).
 
8.      Click Action, select Insert new, and then click field/subfield.
 
9.      In the Field list, type or select 590. In the Subfield list, type or select the letter a, and then click
Next.
 
10. Select how you want the field positioned,  and then click Next.
 
11. Click Next to skip this dialog box.
 
12. Type your note, and then click Next. This closes the dialog box.
 
13. Select the Execute actions for each check box, then click record.
 
14. Click Find Next. This locates the first occurrence of the Find text.
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15. If you want the field added, click Replace. If you do not want the field added, click Find Next to locate
the next occurrence.
 
NOTES:
•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Example 5: Adding  a field or subfield based on the contents of another field or subfield
In this example, we will add a General Material Designation (245#h) with contents that match the value
of position 6 in the leader (000). We will use “videorecording” as the medium.
 
1.   On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 

A.     In the Search For list, select Bibliographic.
 
B.     In the first record field list, select a MARC field. C.     In the first keyword box, type an
asterisk (*).
D.     In the first Boolean operator list, select NOT.
 
E.     In the next record field list, type 245#h over the default field name. F.     In the keyword box
below, type video*.

2.      Click Search. This limits the find and replace operation to only the records you want to modify, and
reduces the time needed for the find and replace operation.
 
3.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select bibliographic, and then click Select All
Records. This places a check mark by all brief records in the list.
 
4.   On the Edit menu, select Bibliographic, and then click Find. This displays the Find dialog box (Figure
4.43).
 
5.   In the Find box, type the letter g.
 
6.   In the In list, type 000 to limit the find and replace operation to the leader.
 
7.      Select the Advanced check box. This displays the Advanced Find/Replace dialog box (Figure 4.44).
 
8.      Select  the Limit search to character positions check box. Type 6 in both of the boxes that follow.
 
9.      Click Action, select Insert new, select subfield, and then click into existing field.
 
10. In the Subfield list, type or select h, and then click Next.
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11. In the first Field/occurrence list, type or select 245. Leave first as the value of the second Field/
occurrence list, then click Next.
 
12. Click after. In the adjacent boxes, type or select b in the first box, and leave first as the value of the
second box. Then click Next.
 
13. In the text box, type [videorecording], and then click Next.
 
14. Select the Execute actions for each check box, and then click match.
 
15. Click Find Next. This locates the first occurrence of the Find text.
 
Note: During the Find  and Replace operation,  all Authority Control fields contained in a bibliographic record are ignored.
 
16. If you want the field added, click Replace. If you do not want the field added, click Find Next to locate
the next occurrence.
 
NOTES:
•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
 
Renaming a Field or Subfield
 
Example 6: Renaming a field or subfield with  incorrect information
In this example we will rename a field in records that were improperly cataloged. In this case, records
have a field incorrectly named 261 that should be 262.
 
1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.25).
 
2.      In the Search For list, select Bibliographic.
 
3.      In the record field list, type the field tag number (261)  over the default field name.
 
4.      Click Search. This limits the find and replace operation to only the records containing the
unwanted field, and reduces the time needed for the find and replace operation.
 
5.      Select the check box by each brief record you want to include in the Find and Replace operation.
Or, to include all records in the list: on the Edit menu, select Bibliographic, and then click Select All
Records. This places a check mark by all brief records in the list.
 
6.      On the Edit menu, select Bibliographic, and then click Find. This displays the Find dialog box
(Figure 4.43).
 
7.      Select the Advanced check box. This displays the Advanced Find/Replace dialog box (Figure 4.44).
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8.      Click Action, select Rename existing, and then click field.
 
9.      In the first Field/occurrence list, type or select 261. If there are multiple occurrences of the field,
indicate which occurrence should be replaced in the second Field/occurrence list, and then click Next.
 
10. Type or select 262 as the new field tag, and then click Next. This closes the dialog box.
 
11. Select the Execute actions for each check box, then click record.
 
12. Click Find Next. This locates the first occurrence of the Find text.
 
13. If you want the field renamed, click Replace. If you do not want the field renamed, click Find Next to
locate the next occurrence.
 
 
NOTES:
•     If you feel comfortable  with the replace operation, click Replace All. This automatically completes the find and replace operation
without user intervention. Use this only if the find and replace operation will work properly on every match.
•     To cancel the find and replace operation, click Cancel at any time. However, any changes made prior to clicking Cancel are saved.
•     To “undo” the changes, click Undo Find/Replace on the Edit menu. You cannot undo once you have begun another find
operation, saved a record, imported or exported records, begun a standard keyword search, or exited Cataloging.
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Deleting and Undeleting Records
 
For precautionary reasons, deleting records is a two-step process. You must first mark records for
deletion, then purge the marked records. You can undelete records marked for deletion unless they
have been purged.
 
Step 1: Marking Records for  Deletion
You can quickly tell when a bibliographic, holding, patron, or authority record has been marked for
deletion. In a brief record format in the Cataloging window, marked records display in red. In a full
MARC record, the Mark for Deletion  check box is selected and the record status code in the Leader field
is d. (This does not apply to picture records.)
 
From the Brief MARC Record List
Note:  Use this  method to delete picture records.
 
Note: You cannot use this method to delete picture records.
 
To mark records for deletion while viewing the brief record list:
 
1.      Select the check box by each record you want to delete. Or, to delete all records in the list, on the
Edit menu, select the type of record you want to delete, and then click Select All Records. This places a
check mark by all brief records in the list.
 
2.      On the Edit menu, select the type of record you want to delete, and then click Delete Selected
Records. The selected records display in red.
 
From the Full MARC Record
To mark a record for deletion while viewing its full MARC record:
 

•     Select the Mark for Deletion check box.
 
OR
 
•     Double-click the Leader field to display the Fixed Field 000 dialog box.
Click the Record status arrow and click d. Click OK to save your changes. This selects the Mark
for Deletion check box and displays the corre- sponding brief record in red.

 
Step 2: Purging Records Marked for  Deletion
Warning: You cannot undo the Purge Deleted Records command; records are permanently
removed.
 
To purge records marked for deletion:
 
On the Edit menu, select the type of records you want to purge, and then click Purge Deleted Records.
This removes  all records marked for deletion from the system.
 
Undeleting Records
You can undelete records marked for deletion unless they have been purged. To undelete records:
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1.      Select the check box by each deleted record you want to undelete. (Deleted records appear in red.)
 
2.      On the Edit menu, select the type of record you want to undelete, and then click Undelete Selected
Records. This removes the check mark by the records and changes the color of the records to black.
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Additional M3 Searching Capabilities
 
Searching by  Record Status
Tip: The record status code appears in Fixed Field 000 in the full MARC record.
 
The M3 search utility allows you to locate records by record status. This is partic- ularly useful if you
want to review the list of records marked for deletion prior to running the deletion utility. To do so:
 
1.   On the Edit menu, click Search. This displays the Search dialog box (Figure 4.45).
 
2.   In the Search For list, select the type of record you want to search.
 
3.   In the record field list, select Record Status.
 
4.      In the corresponding  keyword box, type the desired record status subfield code, as shown in the
example in Figure 4.45:
 

•     a locates records with an increase in encoding level
 
•     c locates corrected or revised records
 
•     d locates records marked for deletion
 
•     n locates new records
 
•     p locates records with an increase in encoding level from prepublica- tion
 

FIGURE  4.45

 
5.      Click Search. This displays the Cataloging window listing all records with the selected record
status.
 
Searching by  MARC Field Tag  Numbers
The M3 search utility allows you to locate records by MARC field tag numbers and subfield codes. To do
so:
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1.      On the Edit menu, click Search. This displays the Search dialog box (Figure 4.46).
 
2.      In the Search For list, select the type of record you want to search.
 
3.      In the record field list, type the desired field tag number (for example,
260) over the default field name. To narrow to a specific subfield, type the field tag number plus the #
delimiter character and the subfield code (for example, 260#a).
 
4.      In the corresponding keyword box, type the text you want to locate, as shown in the example in
Figure 4.46.
 
FIGURE  4.46

 
5.      Click Search. This displays the Cataloging window listing all records con- taining the text in the
designated field.
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Using M3 Picture Manager
 
The M3 Picture Manager utility allows you to import multiple image files and auto- matically link the
images to the appropriate bibliographic or patron records. Once imported, images can be displayed
alongside the records in the Circulation window and the OPAC Search Results, Record Details, and
Bookbag windows. Item and patron images can be displayed in Circulation, but only item images can
be displayed in the OPAC.
 
This utility also allows you to update your bibliographic and patron records with pictures that have
already been imported. This feature locates the pictures in your picture table and attaches them to the
corresponding bibliographic or patron records. You may want to use this feature if, for example, you
add bibliographic records to your database after batch importing and linking pictures.
 
Note: Image files must be in .jpg or .bmp format to be used in M3.
 
Displaying Imported Pictures
To display images in the OPAC, they must be enabled after import. For instructions, see “Enabling
Cover Images” on page 6-31.
 
Once pictures are imported, they display automatically in Circulation alongside patrons and items in
the Patron and Item panes if M3 v1.6 was your first installa- tion of M3. If you had a version of M3
installed prior to installing 1.6, you must do the following:
 

•     Add a graphic cell to the Patron pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Modifying the Patron Pane Display” on page 5-59.
 
•     Add a graphic cell to the Item pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Modifying the Item Pane Display” on page 5-64.

 
Importing Pictures
1.      On the File menu, select Import, then click Pictures. This displays the M3 Picture Manager window
(Figure 4.47).
 
FIGURE 4.47
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2.      Click Import and link new pictures, then click Next. This displays the Step 1 dialog box (Figure 4.48).
 
FIGURE 4.48

 
 
3.      Locate the image files you want to import.
 

•     In the Select import files from box, type the path of the image files to import. The file names
display in the Unselected box.
OR
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•     Click Browse. This displays the Open dialog box. Navigate to the direc- tory containing the
files, then click OK. The file names display in the Unselected box.
 

NOTE: Images are listed only if they are the type selected in the File Type list; if desired, select a different type. Only .jpg or .bmp
files will be imported.
 
4.      Move each file you want to import from the Unselected box to the Selected box. To do so, select each of the
files you want to import, then click the > button. To move all files, click Select All, then click the > button.
 
5.      Click Next. This displays the Step 2 dialog box (Figure 4.49)
 
FIGURE 4.49

 
 
6.      The first picture to be imported displays.
 

•     If you want to import all pictures you selected in the Step 1 dialog box without viewing
them, click Import.
 
•     If you want to view each picture you selected, click Import or Don’t import for this image,
and then click Next Picture. Repeat for each pic- ture you want to view. To skip to the end of the
picture list, click Import or Don’t import for the remaining images.

 
7.      Click Next. This displays the Step 3 dialog box (Figure 4.50).
 
FIGURE 4.50
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Note: To disable the field option,  change the Allow Match Field Edit entry in the Global.ini.REG file (the default path is C:\M3
Server\Registry\Common) from 1 to 0. The default fields can also  be modified in this file.
 
8.      In the database list, select the database for which you want to import pic- tures.
 
9.      Click bibliographic table or patron table to indicate the table for which you want to import the pictures.
 
10. The field box displays the field that will be used to match the picture to a bibliographic or patron
record. This field is placed in the 991#b field of the picture record.
 
11. Click everything except the dot and file extension or a range of characters to indicate how you want to
extract data from the image file names.
 

•     If your file names are descriptive names or vary in length, select every- thing except the dot
and file extension. The names of all picture files being imported must be the same length to use a
range of characters.
 
•     If you select a range of characters, enter the appropriate numbers in the first character and last
character boxes. These numbers will be used to limit the data that is matched in the picture file
name. For example, if you enter 3 in the first character box and 10 in the last character box, and
the picture file name is 0042789354.jpg, the numbers 42789354 will be matched. The characters
to be matched display in the extracted data for linking box. (NOTE: If you choose this option, the
names of all picture files being imported must be the same length.)

 
12. Click Finish. This imports the pictures.
 
Updating Bibliographic or Patron Records with Pictures Use this feature to update your
bibliographic or patron records with pictures that have already been imported. If you have not yet
imported pictures, see “Importing Pictures” on page 4-50.
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1.      On the File menu, select Import, then click Pictures. This displays the M3 Picture Manager window
(Figure 4.47).
 
2.      Click Update bibliographic or patron tables, then click Next. This displays the Step 1 dialog box
(Figure 4.51).
 
FIGURE 4.51

 
3.      In the database list, select the database for which you want to attach pic- tures.
 
4.      Click bibliographic table or patron table to indicate whether you want to attach pictures to
bibliographic records or patron records.
 
5.      The using data from field box displays the field that will be used to match a picture to a bibliographic
or patron record. This field is placed in the
991#b field of the picture record.
 
6.      Click all records in the table or records with no pictures (records without a 996 field) to indicate which
bibliographic or patron records you want to attach pictures to.
 
7.      Click Finish. This places  the ISN of the picture record in the 996#a field of the bibliographic or
patron record.
 
Adding a Picture Field to a Bibliographic or Patron Record To add a picture field to one
bibliographic or patron record at a time, follow the procedure below. To import multiple image files at
once, follow the procedure in “Importing Pictures” on page 4-50.
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1.      Display the desired bibliographic or patron record in the Bibliographic - Cataloging (Figure 4.8) or
Patron - Cataloging (Figure 4.21) window.
 
2.      Follow the procedure beginning with step 3 in “Adding a Picture Field to a Bibliographic or Patron
Record” on page 5-38.
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Importing Bibliographic, Patron and Authority Records
 
Importing Overview
M3 Cataloging includes a utility to import bibliographic, patron, and authority records formatted in
three different data types:
 

•    MARC – Records in MARC format.
 
•     Delimited – Records in which each field ends with, or is “delimited” by, a particular
character such as a comma or tab.
 
•     Fixed width – Records in which each field has a designated maximum width in number of
characters.

 
During the import procedure, despite which of the three data types applies to the records to be imported,
the records are mapped into a MARC record format. This is necessary as M3 is designed exclusively to
operate with MARC records to pro- vide optimum performance.
 
The import procedure for each data type is explained in this section. In addition, an optional high-speed
import procedure is available that can be used the first time you import records into M3.
 
The same import procedures apply to bibliographic, patron, and authority records; the only difference
occurs when you specify the type of record to import.
 
M3 also includes a Picture Manager utility to import pictures. To use this utility, see “Using M3 Picture
Manager” beginning on page 4-49.
 
Optional High-Speed Import Option
For the first mass import of records into M3, you may want to use the high-speed import option. This
option cannot be run while others are using any part of the M3 system.
 
Warning: Do not use the high-speed import option to load records into an existing catalog
containing records. If your catalog contains records, use one of the three import options explained
in the preceding section, “Importing Overview.”
 
To use the high-speed import option:
 
1.      Press and hold CTRL, then click Import on the File menu. When an asterisk appears by the menu
options on the Import submenu, release CTRL.
 
2.      Proceed with the importing instructions in one of the following sections, depending on the type of
data you are importing (MARC, delimited, or fixed width). (As the procedure progresses, a dialog box
advises you that it is going to index. This is appropriate.)
 
Importing MARC Records
To import records that are in MARC format:
 
1.      Verify that you are working with the correct database.
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2.      On the File menu, select Import, and then click the type of records you are importing. This displays
the Open dialog box.
 
3.      Navigate to the file containing the records you want to import, and then click Open.
 
4.      In the Step 1 dialog box (Figure 4.52), specify the range of records you want to import.
 
FIGURE  4.52

 
 
To do so:

A.     Skip the Original Data Type group. The MARC option should automati- cally be selected.
 
B.     In the Start import at row and Stop import at row boxes, select the range of records you want
to import. By default, the first and last row numbers in the import file are displayed. If you only
want to import a portion of the records in the file, type the row numbers corresponding to the
range you want to import.
 

NOTE: The data in the Preview pane displays differently depending on the record type you are importing.
 
Tip: To  see the field entries in other records of the import file, click the navigation buttons in the lower  left of the Step 2 dialog
box (see Figure 4.53). From left to right, these buttons  access the first record in the import  file range, the previous record, the next
record, and the last record.
 
FIGURE  4.53
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C.     When finished, click Next.

 
5.      In the Step 2 dialog box (Figure 4.53), indicate the field mapping struc- ture that you want the
records to conform to once they are imported. By default, the dialog box is set to import the field
mapping configuration currently used by the records to be imported.
 
NOTE: When the Step 2 dialog box appears, it displays the field entries for the first record in the range of records you plan to
import. In addition, you see the comprehensive  list of fields and subfields used by the entire range of records in your import
file. Because this first record may not have entries in every field used by the range of records, you are likely to see **Field not in
current record** throughout  the Field Data column.
 
Your options in this dialog box are:
 

•     Accept the default field mapping configuration and continue the import process. To do so, click
Next, and then skip to step 7 on page 4-60.
 
•     Accept the default field mapping configuration and save it for future importing sessions
before continuing. To do so:
 

A.     In the Field Mapping Configuration list, select Save As. This displays the Save Field
Mapping As dialog box.
B.     Type a descriptive name for the new configuration, then click OK. C.     After the
Step 2 dialog box refreshes, click Next, and then skip to
step 7 on page 4-60.
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Tip: To map most but not all occurrences  of a repeating field to the same destination field, you can still use the optional Unite 
procedure explained in step A, with  one modification.  After selecting the Unite check box and revising the Map To destination as
explained in step F on page 4-59,  clear  the Unite check box. This separates the repeating field listings  once again but maintains
the Map To modification entered while the fields were united. You can then modify the mapping as explained in step F for those
few listings that do not match the global change you entered while  the fields were united.
 

•     Use a field mapping configuration  that was previously saved. To do so:
 

A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field
Mapping Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the Step 2 dialog box refreshes, click Next, and then skip to step 7 on page
4-60.

 
•     Create a new field mapping configuration by modifying the default configuration. To do so,
follow the modification instructions as explained in step 6.
 
•     Create a new field mapping configuration by modifying a configura- tion that was previously
saved. To do so:

 
A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field
Mapping Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the Step 2 dialog box refreshes, make any desired changes as explained in
step 6.

 
6.      To modify a field mapping configuration:
 

A.     In the Step 2 dialog box, review the Field column  for fields that repeat. If you plan to
change the mapping of a repeating field, and if all occurrences of the repeating field are to
be mapped to the same destination field, then you can save time and keystrokes by using
the optional Unite check box feature. This collapses all the occurrences of the repeating field
into one line, creating a single occurrence, thereby enabling you to simultaneously remap all
occurrences of this field to the same field. (If the field repeats several times, this could save
you considerable time. If you do not use this feature, you must revise the mapping for each
occurrence individually.)
 
To use this time-saving option, select the Unite check box by the first occurrence of the repeating
field. (This action collapses all the repeated field occurrences into a single listing.) Then
continue to step B.
 
B.     In the Include check box column, select the fields and subfields you want to import among
those listed in the Field column. In the default configuration, all fields and subfields are
selected based on the assumption you want to import all data contained in the records you are
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importing. If you do not want to import a particular field or subfield, clear the field’s Include
check box.
 
C.     In the Field column, do nothing. The Field column provides a compre- hensive list of the
fields and subfields used by the records to be imported. Some records may not have entries in
each field and subfield in this list.
 
D.     The Field Data column works with the Action column. By default, the Field Data column
displays the actual field and subfield data for the first record in the range you plan to import.
To view the data contained in other records, click the navigation buttons in the lower left of this
dialog box.
 
 
E.     In the Action column, select Keep or Replace for each field and subfield you plan to import.
In the default mapping configuration,  Keep is selected for each field and subfield.

 
•     Select Keep if you want the data currently stored in that field to be kept during the
import procedure.
 
•     Select Replace if you want to change the current data in a field to a constant value
(such as a library name, regional code, or field label) during the import procedure. This
constant value over- writes all data contained in the field prior to importing. If you select
Replace, then in the Field Data column, type the information you want to appear in this
field.

 
F.     In the Map To column, select the destination MARC field or subfield for each field you plan
to import. The default mapping configuration assumes you want to import to the same field
locations; therefore, the Map To column displays the same field tag number and subfield code
listed in the Field column.
 
To change the default mapping to a different destination field or subfield, click the Map To
arrow and select the preferred destination field or subfield from the tree. (You can expand and
collapse the field tree by clicking the field’s corresponding  plus (+) and minus (–) signs.)
 
G.     In the Occurrence  Number (Occ.#)  column, select the order in which you want any
repeating fields to appear in the new records. (This is not applicable if the repeating field’s Unite
check box is selected.) In the default mapping configuration, any repeating fields are numbered
in sequential order in the Occ.#  column. (To review the type of infor- mation in each occurrence
of the field, look at the entries in the Field Data column.) For example, if subfield 020#a occurs
twice, the first listing is assumed to be occurrence 1 and the second is occurrence 2. You can
override this occurrence order by typing the preferred order numbers into this column.
 
If you revise the Map To column, the utility assumes that the field or subfield you are
remapping becomes the first occurrence of that field in the new records. You are prompted to
either accept this first occur- rence order or change to a preferred occurrence order. (If the new
occurrence order leaves gaps between occurrence numbers, a GAP error message advises and
allows you to revise the order.)
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H.     When finished:
 

•     If you want to save the mapping configuration to use during another import session,
select Save As in the Field Mapping Config- uration list. This displays the Save Field
Mapping As dialog box. Type a descriptive name for the new mapping configuration,
then click OK.
OR
 
•     If you do not want to save the mapping configuration, proceed to the next step.
 

I.     In the Step 2 dialog box (Figure 4.53), click Next.
 
 
7.      In the Step 3 dialog box (Figure 4.54), specify the import options.
 
FIGURE  4.54

 
 
To do so:
 

A.     If you are importing bibliographic or authority records, the Duplicates group is available.
Choose one of the following:
 

•     To prevent the import of records that may duplicate existing records, click Don’t allow
duplicates. (All fields in two records need not match to consider the records as duplicates;
matching is based upon specific vital field criteria. For example, two biblio- graphic
records may be considered duplicates if just the ISBN field matches.)



 
Importing Bibliographic, Patron and Authority Records

© 2014 Mandarin Library Automation, Inc. All rights reserved.
120 of 361

 
•     To import records that may duplicate existing records, click Allow duplicates.
 
•     To be prompted when duplicate records are found during the import process, accept
the default Prompt if duplicates are found option. This lets you compare the record you are
importing to the record already in the M3 system, and then decide whether to import the
duplicate record.

 
If a duplicate record is found, the Bibliographic Compare or Authority Compare dialog box displays
(depending on the type of record you are importing), showing the two records side by side. Figure 4.55
shows the Bibliographic Compare dialog box.
 
FIGURE  4.55

 
Tip: Select the Don’t show this window again check box before clicking  a button to apply the action to the displayed record and all
records being imported in this session.
 
Note: If you are importing authority  records, only the Duplicates  group is available.
 
Using the option buttons, you have the following four choices:
 

Save Existing – Saves the existing record and does not import the duplicate record. If it
is a bibliographic record, all corresponding holding records are imported. Result: One
bibliographic record with all corresponding holding records.
 
Replace Existing – Imports the duplicate record and replaces the existing record. If it is
a bibliographic record, all corresponding holding records are also imported. Result: One
bibliographic record with all corresponding holding records.
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Import – Imports the duplicate record and keeps the existing record. If it is a
bibliographic record, all corresponding holding records are also imported and linked to
the duplicate biblio- graphic record, not the existing bibliographic record. Result: Two
bibliographic records and two sets of holdings —the existing bibliographic record and its
original holdings, and the duplicate bibliographic record and its corresponding holdings.
 
Do not Import – Does not import the duplicate record. Result: The existing authority record,
or bibliographic record and its holding records, remain the same.

 
B.     If you are importing bibliographic records, the Holding Records group is available. If you do not
want to generate holding records, clear the Generate holding records check box. Otherwise, accept
the default.

 
Tip: You must  have 852 entries in the records you are importing  or other fields mapped to 852 in order for Update barcode values
in 852 field  with  to work. If no 852 field is found in a record, then no barcode is generated for that record.
 
The Import Summary is a log containing the start  and end time  of the import session, the number  of records in the import  file,
the number  of records imported success- fully, any duplicate barcodes, and the barcode creation summary.  Duplicate barcodes
are changed to a barcode of “SIRS” followed by the ISN number.
 

C.     In the Barcode group, specify how you want barcodes handled during the import procedure.
Your options are:

 
•     To transfer any barcode numbers in the 852#p field of the orig- inal records to M3,
select the Automatically generate barcode records check box in the Barcode group. (This
should be the only option selected in the Barcode group.) This allows you to continue
using this barcode with the same record and places the barcodes you are importing into
the M3 system (in the barcode table).
 
•     To create new barcodes for the records being imported, whether barcodes exist in the
original records or not, select the Update barcode values in 852 field with check box. You
must then accept or change the values in the four boxes below it:

 
Prefix – To assign a constant prefix to the barcode imported into the 852 field,
type it here. For example, type b for bibliographic records or p for patron records.
You must assign different prefixes to bibliographic records and patron records.
 
Suffix Starting Value – To assign an incrementing suffix to the barcodes in the
order they import into the system, type the numeric starting value for these
records (for example, type 1).
 
Suffix Increment Type – If you assign a suffix, you must select a format in this list.
 
Suffix Increment  By – If you assign a suffix, type the number of increments you
want the records to increase by (for example, 1 increment).
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•     If you do not want to transfer or assign any barcodes to the records being imported,
clear both check boxes (Automatically generate barcode records and Update barcode values in
852 field with).

 
NOTE: If the first check box is unavailable, clear the second check box to make the first check box available.)
 

D.     In the Assign to group list, select the group to which you want the imported data assigned.
 
E.     When finished, click Finish. While the import procedure takes place, the Import Progress
bar displays on screen.

 
8.      When the import procedure is complete, a confirmation prompt displays and asks if you want to view
the Import Summary. Click Yes to view it now or No to view it later. It is best to view it now to evaluate
the results of the import procedure.
 
 
Importing Delimited Records
Delimited data appears in columns, with each field separated by a character such as a comma, tab,
semicolon, or space. To import records that are in delimited format:
 
1.      Verify that you are working with the correct database. For instructions, see “Selecting a Database”
on page 4-2.
 
2.      On the File menu, select Import, and then click the type of records you are importing. This displays
the Open dialog box.
 
3.      Navigate to the file containing the records you want to import, then click Open.
 
4.      In the Step 1 dialog box (Figure 4.56), specify the range of records you want to import.
 
FIGURE  4.56
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To do so:
 

A.     Skip the Original Data Type group. The Delimited option should auto- matically be selected.
 
B.     In the Start import at row and Stop import at row boxes, select the range of records you want
to import. By default, the first and last row numbers in the import file are displayed. If you only
want to import a portion of the records in the file, type the row numbers corresponding to the
range you want to import.

 
NOTE: The data in the Preview pane displays differently depending on the record type you are importing.
 

C.     When finished, click Next.
 
5.      In the Step 2 dialog box (Figure 4.57):
 
FIGURE  4.57
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A.     In the Field Delimiter list, specify the field delimiter character used by the data to be
imported to separate fields in the file. The import utility makes an educated guess based on the
contents of the file you are importing; however, verify the delimiter by reviewing the columns of
data in the Preview pane. If data does not appear in correct column order, select the appropriate
field delimiter. Each time you select a different field delimiter, the Preview pane refreshes.
 
B.     In the Text Qualifier list, specify the character (if any) used by the file to be imported to
mark the beginning and end of the data in a field. For instance, if a field contains lastname,
firstname, the data might be enclosed within quotes to mark the beginning and end of the data,
as in “lastname, firstname”.
 
C.     Click Next.

 
6.      In the Step 3 dialog box (Figure 4.58), indicate the MARC field mapping structure that you want
the records to conform to once they are imported. (M3 is designed to work with MARC records; therefore,
all data fields must map to a MARC field.)
 
FIGURE  4.58
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By default, the dialog box does not have a mapping structure selected. You must select or modify an
existing mapping structure (if you’ve imported delimited records before), or create a new configuration.
 

•     To select a field mapping configuration  that was previously saved:
 

A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the Step 3 dialog box refreshes, click Next, and then skip to step 7 beginning on page
4-67.

 
•     To create a new field mapping configuration by modifying a configu- ration that was
previously saved:

 
A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the Step 3 dialog box refreshes, make any desired changes as explained in the next
bullet.

 
•     To create a new field mapping configuration:
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A.     In the check box column, select each field you want to import in the Column Data column.
By default, no fields are selected.
 
B.     The Column Data column provides a list of the fields used by the records to be imported. By
default, the actual field data for the first record in the file is displayed. (To display the data for
other records, click the navigation buttons in the lower left of this dialog box.) The Column Data
column works with the Action column.
 
C.     In the Action column, select Keep or Replace for each field you plan to import. By default,
Keep is selected for each field.
 
Select Keep if you want to import all data currently stored in that field.
 
Select Replace if you want to change the current data in a field to a constant value (such as a
library name, a regional code, or a field label). This constant value then appears in this field in
all imported records. If you select Replace, then in the Column Data column, type the information
you want to appear in this field.
 
D.     In the Map To column, select the destination MARC field or subfield for each field listed in
the Column Data column. To map to a destination field or subfield, click the Map To arrow and
select the destination field. Patron record fields are shown in the example in Figure 4.59. (You
can expand and collapse the field tree by clicking the field’s corresponding plus (+) and minus
(–) signs.)

 
FIGURE  4.59

 
 

E.     In the Occurrence # (Occ.#)  column, select the order in which you want any repeating fields
to occur in the destination records. By default, any repeating fields are numbered in sequential
order in the Occ.#  column. For example, if a field containing the patron’s last name occurs
twice, the first listing is assumed to be occurrence 1 and the second is occurrence 2. You can
override this occurrence order by typing the preferred order numbers into this column.

 
NOTE: The import utility assumes that the field or subfield you are mapping to in the Map To column becomes the first occurrence
of that field in the new records. You are prompted to either accept this first occurrence order or change to a preferred occurrence
order. (If the new occurrence order leaves gaps between occur- rence numbers, a GAP error message advises and allows you to
revise the order.)
 
 

F.     When finished:
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If you want to save the configuration to use during another import session, select Save As in the
Field Mapping Configuration  list. This displays the Save Field Mapping As dialog box. Type a
descriptive name for the new mapping configuration,  and then click OK.
OR
 
If you do not want to save the mapping configuration, proceed to the next step.
 
G.     In the Step 3 dialog box, click Next.

 
7.      In the Step 4 dialog box (Figure 4.60), specify the import options.
 
FIGURE  4.60

 
 
To do so:
 

A.     If you are importing bibliographic records, the Duplicates group is available. If so, do one of
the following:
 

•     To prevent the import of records that may duplicate existing records, click Don’t allow
duplicates. (All fields in two records need not match to consider the records as duplicates;
matching is based upon specific vital field criteria. For example, two records may be
considered duplicates if just the ISBN field matches.)
 
•     To import records that may duplicate existing records, click Allow duplicates.
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Tip: Select the Don’t show this window again check box before clicking  a button to apply the action to the displayed record and all
records being imported in
this session.
 
Tip: You must  have 852 entries in the records you are importing  or other fields mapped to 852 in order for Update barcode values
in 852 field  with  to work. If no 852 field is found in a record, then no barcode is generated for that record.

•     To be prompted when duplicate records are found during the import process, accept
the default Prompt if duplicates are found option. This lets you compare the record you are
importing to the record already in the M3 system, and then decide whether to import the
duplicate record.

 
If a duplicate record is found, the Bibliographic Compare dialog box displays (Figure 4.55),
showing the two records side by side. Using the option buttons, you have the following
four choices:
 
Save Existing – Saves the existing bibliographic record and does not import the duplicate
bibliographic record. It imports  any corresponding holding records. Result: One
bibliographic record with all corresponding holding records.
 
Replace Existing – Imports the duplicate bibliographic record and replaces the existing
bibliographic record. It also imports all corresponding holding records. Result: One
bibliographic record with all corresponding holding records.
 
Import – Imports the duplicate bibliographic record and keeps the existing bibliographic
record. It also imports the corresponding holding records and links them to the duplicate
bibliographic record, not the existing bibliographic record. Result: Two biblio- graphic
records and two sets of holdings —the existing biblio- graphic record and its original
holdings, and the duplicate bibliographic record and its corresponding holdings.
 
Don’t Import – Does not import the duplicate record. Result: The existing bibliographic
record and its holding records remain the same.

 
B.     If you are importing bibliographic records, the Holding Records group is available. If you do not
want to generate holding records, clear the Generate holding records check box. Otherwise, accept
the default.
 
C.     In the Barcode group, specify how you want barcodes handled during the import procedure.
Your options are:
 

•     To transfer any barcode numbers in the 852#p field of the orig- inal records to M3, select
the Automatically generate barcode records check box in the Barcode group. (This should be
the only option that is selected in the Barcode group.) This allows you to continue using
this barcode with the same record and places the barcodes you are importing into the M3
system (in the barcode table).
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•     To create new barcodes for the records being imported, whether barcodes exist in the
original records or not, select the Update barcode values in 852 field with check box. You
must then accept or change the values in the four boxes below it:
 

Prefix – To assign a constant prefix to the barcodes imported into the 852 field,
type it here. For example, type b for bibliographic records or p for patron records.
You must assign different prefixes to bibliographic records and patron records.
 
Suffix Starting Value – To assign an incrementing suffix to the barcodes in the
order they import into the system, type the numeric starting value for these
records (for example, type 1).

 
The Import Summary is a log containing the start  and end time  of the import session, the number  of records in the import  file,
the number  of records imported success- fully, any duplicate barcodes, and the barcode creation summary.  Duplicate barcodes
are changed to a barcode of “SIRS” followed by the ISN number.
 

Suffix Increment Type – If you assign a suffix, you must select a format in this list.
 
Suffix Increment  By – If you assign a suffix, type the number of increments you
want the records to increase by (for example, 1 increment).

 
•     If you do not want to transfer or assign any barcodes to the records being imported,
clear both check boxes (Automatically generate barcode records and Update barcode values in
852 field with).
 

NOTE: If the first check box is unavailable, clear the second check box to make the first check box available.
 

D.     In the Assign to group list, select the group to which you want the imported data assigned.
 
E.     When finished, click Finish. While the import procedure takes place, the Import Progress
bar displays on screen.
 

8.      When the import procedure is complete, a confirmation prompt displays and asks if you want to view
the Import Summary. Click Yes to view it now or No to view it later. It is best to view it now to evaluate
the results of the import procedure.
 
Importing Fixed Width Records
Fixed width data appears in columns, with each field in the original record sepa- rated into columns of
a specified width. Typically, fixed width records are patron records. To import records that are in fixed
width format:
 
1.      Verify that you are working with the correct database. For instructions, see “Selecting a Database”
on page 4-2.
 
2.      On the File menu, select Import, and then click the type of records you are importing. This displays
the Open dialog box.
 
3.   Navigate to the file you want to import, then click Open.



 
Importing Bibliographic, Patron and Authority Records

© 2014 Mandarin Library Automation, Inc. All rights reserved.
130 of 361

 
4.      In the Step 1 dialog box (Figure 4.61), specify the range of records you want to import.
 
FIGURE  4.61

 
 
To do so:
 

A.     Skip the Original Data Type group. The Fixed width option should auto- matically be selected.
 
B.     In the Start import at row and Stop import at row boxes, select the range of records you want
to import. By default, the first and last row numbers in the import file are displayed. If you only
want to import a portion of the records in the file, type the row numbers corresponding to the
range you want to import.

 
NOTE: The data in the Preview pane looks different depending upon the record type you are importing.
 

C.     When finished, click Next.
 
5.      In the Step 2 dialog box (Figure 4.62), indicate where the column break is for each column in the
data. No column breaks are designated by default.
 
FIGURE  4.62
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To indicate a column break:
 

A.     Click in the diamond row where a column break should occur, which is always to the left of
the field data. This creates a vertical line at the column break point.
 

•     To move a column break, click and drag the diamond in the diamond row.
 
•     To remove a column break, double-click the diamond in the diamond row.

 
B.     Repeat this for each desired column break. When finished, click Next.

 
6.      In the Step 3 dialog box (Figure 4.63), indicate the MARC field mapping structure that you want
the records to conform to once they are imported. (M3 is designed to work with MARC records; therefore,
all data fields must map to a MARC field.)
 
FIGURE  4.63
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By default, the Step 3 dialog box does not have a mapping structure selected. You must select or
modify an existing mapping structure (if you’ve imported fixed width records before), or create a new
configura- tion.
 

•     To select a field mapping configuration  that was previously saved:
 
A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the Step 3 dialog box refreshes, click Next, and then skip to step 7 on page 4-74.
 

•     To create a new field mapping configuration by modifying a configu- ration that was
previously saved:

 
A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.
 
B.     Select the desired configuration,  and then click OK.
 
C.     After the Step 3 dialog box refreshes, make any desired changes as explained in the next
bullet.
 

•     To create a new field mapping configuration:
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A.     Select the check box by each field you want to import. By default, no fields are selected.
 
 
B.     The Column Data column provides a list of the fields used by the records to be imported. By
default, the actual field data for the first record in the file is displayed. (To display the data for
other records, click the navigation buttons in the lower left of this dialog box.) The Column Data
column works with the Action column.
 
C.     In the Action column, select Keep or Replace for each field you plan to import. By default,
Keep is selected for each field.
 
Select Keep if you want to import all data currently stored in that field.
 
Select Replace if you want to change the current data in a field to a constant value (such as a
library name, a regional code, or a field label). This constant value then appears in this field in
all imported records. If you select Replace, then in the Column Data column, type the information
you want to appear in this field.
 
D.     In the Map To column, select the destination MARC field or subfield for each field listed in
the Column Data column. To map to a destination field or subfield, click the Map To arrow and
select the destination field (Figure 4.64). (You can expand and collapse the field tree by clicking
the field’s corresponding  plus (+) and minus (–) signs.)
 

FIGURE  4.64

 
E.     In the Occurrence # (Occ.#)  column, select the order in which you want any repeating fields
to occur in the destination records. By default, any repeating fields are numbered in sequential
order in the Occ.#  column. For example, if a field containing the patron’s last name occurs
twice, the first listing is assumed to be occurrence 1 and the second is occurrence 2. You can
override this occurrence order by typing the preferred order numbers into this column.

 
NOTE: The import utility assumes that the field or subfield you are mapping to in the Map To column becomes the first occur-
rence of that field in the new records. You are prompted to either accept this first occurrence order or change to a preferred occur-
rence order. (If the new occurrence order leaves gaps between occurrence numbers, a GAP error message advises and allows you
to revise the order.)
 

F.     When finished:
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If you want to save the configuration to use during another import session, select Save As in the
Field Mapping Configuration  list. This displays the Save Field Mapping As dialog box. Type a
descriptive name for the new mapping configuration,  and then click OK.
OR
 
If you do not want to save the mapping configuration, proceed to the next step.
 
G.     In the Step 3 dialog box, click Next.

 
7.      In the Step 4 dialog box (Figure 4.65), specify the import options.
 
FIGURE  4.65

 
 
To do so:
 

A.     If you are importing bibliographic records, the Duplicates group is available. If so, do one of
the following:
 

•     To prevent the import of records that may duplicate existing records, click Don’t allow
duplicates. (All fields in two records need not match to consider the records as duplicates;
matching is based upon specific vital field criteria. For example, two records may be
considered duplicates if just the ISBN field matches.)
 
•     To import records that may duplicate existing records, click Allow duplicates.
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•     To be prompted when duplicate records are found during the import process, click
Prompt if duplicates are found. This lets you compare the record you are importing to the
record already in the

 
Tip: Select the Don’t show this window again check box before clicking  a button to apply the action to the displayed record and all
records being imported in this session.
 
Tip: You must  have 852 entries in the records you are importing  or other fields mapped to 852 in order for Update barcode values
in 852 field  with  to work. If no 852 field is found in a record, then no barcode is generated for that record.

M3 system, and then decide whether to import the duplicate record.
 
If a duplicate record is found, the Bibliographic Compare dialog box displays (Figure 4.55),
showing the two records side by side. Using the option buttons, you have the following
four choices:
 

Save Existing – Saves the existing bibliographic record and does not import the
duplicate bibliographic record. It imports  any corresponding holding records.
Result: One bibliographic record with all corresponding holding records.
 
Replace Existing – Imports the duplicate bibliographic record and replaces the
existing bibliographic record. It imports  all corre- sponding holding records.
Result: One bibliographic record with all corresponding holding records.
 
Import – Imports the duplicate bibliographic record and keeps the existing
bibliographic record. It also imports the corresponding holding records and links
them to the duplicate bibliographic record, not the existing bibliographic record.
Result: Two biblio- graphic records and two sets of holdings —the existing biblio-
graphic record and its original holdings, and the duplicate bibliographic record
and its corresponding holdings.
 
Don’t Import – Does not import the duplicate record. Result: The existing
bibliographic record and its holding records remain the same.

 
B.     If you are importing bibliographic records, the Holding Records group is available. If you do not
want to generate holding records, clear the Generate holding records check box. Otherwise, accept
the default.
 
C.     In the Barcode group, specify how you want barcodes handled during the import procedure.
Your options are:
 

•     To transfer any barcode numbers in the 852#p field of the orig- inal records to M3,
select the Automatically generate barcode records check box in the Barcode group. (This
should be the only option selected in the Barcode group.) This allows you to continue
using this barcode with the same record and places the barcodes you are importing into
the M3 system (in the barcode table).
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•     To create new barcodes for the records being imported, whether barcodes exist in the
original records or not, select the Update barcode values in 852 field with check box. You
must then accept or change the values in the four boxes below it:

 
Prefix – To assign a constant prefix to the barcode imported into the 852 field,
type it here. For example, type b for bibliographic records or p for patron records.
You must assign different prefixes to bibliographic records and patron records.
 
Suffix Starting Value – To assign an incrementing suffix to the barcodes in the
order they import into the system, type the numeric starting value for these
records (for example, type 1).
 
Suffix Increment Type – If you assign a suffix, you must select a format in this list.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Import Summary is a log containing the start  and end time  of the import session, the number  of records in the
import  file, the number  of records imported success- fully, any duplicate barcodes, and the barcode creation summary.
  Duplicate
barcodes are changed to a barcode of “SIRS” followed by the ISN number.
Suffix Increment  By – If you assign a suffix, type the number of increments you want the records to
increase by (for example, 1 increment).
 
•     If you do not want to transfer or assign any barcodes to the records being imported, clear both check
boxes (Automatically generate barcode records and Update barcode values in 852 field with).
 
NOTE: If the first check box is unavailable, clear the second check box to make the first check box
available.
 
D.     In the Assign to group list, select the group to which you want the imported data assigned.
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E.     When finished, click Finish. While the import procedure takes place, the Import Progress bar
displays on screen.
 
F.     When the import procedure is complete, a confirmation prompt displays and asks if you want to
view the Import Summary. Click Yes to view it now or No to view it later. It is best to view it now to
evaluate the results of the import procedure.
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Exporting Bibliographic, Patron and Authority Records
 
This section explains how to export records from the M3 system. All M3 records are in MARC format;
they can be mapped to export in their current format or you can specify a different format by mapping
the information into different fields prior to performing the export.
 
To export MARC records:
 
1.      Verify that you are working with the correct database. For instructions, see “Selecting a Database”
on page 4-2.
2.      Perform a search to isolate the records you want to export. To do so:

A.     On the Edit menu, click Search. This displays the Search dialog box (Figure 4.46).
 
B.     In the Search For list, select the type of records you are exporting.
 
C.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator.
 
D.     Click Search. This displays a list of records matching your search query (Figure 4.6).
 

3.      Select the check box by each record you want to export. Or, to export all records in the list, on the
Edit menu, select the type of record you want to export, and then click Select All Records.
 
4.      On the File menu, click Export. This displays the Select Method of Export dialog box (Figure 4.66).
 
FIGURE  4.66

 
Tip: To see the field entries in other records selected for export, click the navigation buttons in the lower  left of the M3 Data Export
  dialog box. From left to right,  these buttons  access the first record selected for  export, the previous record, the next record, and
the last record.
 
5.      Select a method of export, then click OK.
 

•     Standard Export – This method exports the records “as is,” maintaining the current MARC
field structure.
 
•     Enhanced Export – This method allows you to revise the MARC field structure during the
export process. Fields can be remapped or excluded during the export procedure. This method of
export takes longer as all records are scanned prior to allowing any changes.
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6.      If you selected Standard Export in step 5, continue with step 7. If you selected Enhanced Export,
skip to the next section, “Completing the Enhanced Export,” for instructions.
 
7.      In the Export Records dialog box, select the path and type the file name for the records you are
exporting,  and then click Save. This exports the records.
 
8.      When the export is finished, a confirmation prompt appears. Click OK.
 
Completing the Enhanced Export
The Enhanced Export method allows you to revise the MARC field structure during the export process.
To do so:
 
1.      Complete steps 1 through 5 in “Exporting Bibliographic, Holding, Patron, and Authority Records”
beginning on page 4-76, selecting  Enhanced Export in step 5.
 
2.      In the M3 Data Export dialog box (Figure 4.67), select the field mapping structure you want the
records to conform to once they are exported. By default, the dialog box is set to export the field mapping
configuration cur- rently used by the records being exported.
 
NOTE: When the M3 Data Export dialog box displays, you see the field entries for the first record in the range of records you
plan to export. In addition, you see the comprehensive  list of fields and subfields used by the entire range of records selected for
export. Because this first record may not have entries in every field used by the range of records, you are likely to see **Field not in
current record** throughout  the Field Data column.
 
FIGURE  4.67

 
Your options in this dialog box are:
 

•     Accept the default field mapping configuration and continue the export process. To do
so, click Finish, then skip to step 5 on page 4-80. (This is equivalent to selecting  Standard
Export.)
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•     Accept the default field mapping configuration and save it for future exporting
sessions before continuing. To do so:
 

A.     In the Field Mapping Configuration list, select Save As. This displays the Save Field Mapping
As dialog box.
B.     Type a descriptive name for the new configuration, then click OK. C.     After the M3 Data
Export dialog box refreshes, click Finish, and then skip to step 5 on page 4-80.

•     Use a field mapping configuration  that was previously saved. To do so: A.     In the
Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.

 
B.     Select the desired configuration, then click OK.
 
C.     After the M3 Data Export dialog box refreshes, click Finish, and then skip to step 5 on page
4-80.
 

•     Create a new field mapping configuration by modifying the default configuration. To
do so, skip to step 3.
 
•     Create a new field mapping configuration by modifying a configura- tion that was
previously saved. To do so:

 
A.     In the Field Mapping Configuration list, select  Load. This displays the Load Field Mapping
Configuration dialog box.
 
B.     Select the desired configuration, then click OK.
 
C.     After the M3 Data Export dialog box refreshes, make any desired changes as explained in
the next step.
 

Tip: To map most but not all occurrences  of a repeating field to the same destination field, you can still use the optional Unite 
procedure explained in step A, with  one modification.  After selecting the Unite check box and revising the Map To destina- tion
as explained in step F on page 4-79, then clear the Unite check box. This sepa- rates the repeating field list- ings  once again but
maintains the Map To modification  entered while  the fields were united. You can then modify the mapping as explained in step F
for those few listings that do not match the global change you entered while the fields were united.
 
3.      To modify a field mapping configuration:
 

A.     In the M3 Data Export dialog box, review the Field column for fields that repeat. If you plan
to change the mapping of a repeating field, and if all occurrences of the repeating field are to be
mapped to the same destination field, then you can save time and keystrokes by using the optional
Unite check box feature. This collapses all the occurrences  of the repeating field into one line,
creating a single occurrence, thereby enabling you to simultaneously remap all occurrences of this
field to the same field. (If the field repeats several times, this could save you considerable time. If
you do not use this feature, you must revise the mapping for each occurrence individually.)
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To use this time-saving option, select the Unite check box by the first occurrence of the repeating
field. (This action collapses all the repeated field occurrences into a single listing.) Then
continue to step B.
 
B.     In the Include check box column, select the fields and subfields you want to export among
those listed in the Field column. In the default configuration, all fields and subfields are selected
based on the assumption you want to export all data contained in the records you are exporting.
If you do not want to export a particular field or subfield, clear the field’s Include check box.
 
C.     In the Field column,  do nothing. The Field column provides  a list of the fields and subfields
used by the records to be exported. Some records may not have entries in each field and subfield
in this list.
 
D.     The Field Data column works with the Action column. By default, the Field Data column
displays the actual field and subfield data for the first record in the range you plan to export.
To view the data contained in other records, click the navigation buttons in the lower left of this
dialog box.
 
E.     In the Action column, select Keep or Replace for each field and subfield you plan to export.
In the default mapping configuration,  Keep is selected for each field and subfield.
 

•     Select Keep if you want the data currently stored in that field to be kept during the
export procedure.
 
•     Select Replace if you want to change the current data in a field to a constant value
(such as a library name, regional code, or field label) during the export procedure. This
constant value over- writes all data contained  in the field during the export process.
If you select Replace, then in the Field Data column, type the infor- mation you want to
appear in this field.

 
F.     In the Map To column, select the destination MARC field or subfield for each field you plan
to export. The default mapping configuration assumes you want to export to the same field
locations; therefore, the Map To column displays the same field tag number and subfield code
listed in the Field column.
 
 
To change the default mapping to a different destination field or subfield, click the Map To
arrow and select the preferred destination field or subfield from the tree. (You can expand and
collapse the field tree by clicking the field’s corresponding  plus (+) and minus (–) signs.)
 
G.     In the Occurrence  Number (Occ.#)  column, select the order in which you want any
repeating fields to appear in the new records. (This is not applicable if the repeating field’s Unite
check box is selected.) In the default mapping configuration, any repeating fields are numbered
in sequential order in the Occ.#  column. (To review the type of infor- mation in each occurrence
of the field, look at the entries in the Field Data column.) For example, if subfield 020#a occurs
twice, the first listing is assumed to be occurrence 1 and the second is occurrence 2. You can
override this occurrence order by typing the preferred order numbers into this column.
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If you revise the Map To column, the export utility assumes that the field or subfield you are
remapping becomes the first occurrence of that field in the new records. You are prompted to either
accept this first occurrence order or change to a preferred occurrence order. (If the new occurrence
order leaves gaps between occurrence numbers, a GAP error message advises and allows you to
revise the order.)
 
H.     When finished:
 

•     If you want to save the mapping configuration to use during another export session,
select Save As in the Field Mapping Config- uration list. In the Save Field Mapping As
dialog box, type a descriptive name for the new mapping configuration, and then click
OK.
OR
 
•     If you do not want to save the mapping configuration, proceed to the next step.

 
4.      In the M3 Data Export dialog box, click Finish.
 
5.      In the Export Records dialog box, select the path and type the file name for the records you are
exporting,  and then click Save. This exports the records.
 
6.      When the export is finished, a confirmation prompt appears. Click OK. The export procedure is
complete.
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Using Circulation
 
This chapter describes:
 
•     How to modify Circulation options
•     How to conduct circulation transactions (loans, returns, renewals, reserves and holds, bookings, fine
processing)
•     How to print transaction information and receipts
•     How to search for, create, and edit records
•     How to display pictures in Circulation
•     How to add messages to and delete messages from your Circulation system
•     How to attach messages to and detach messages from records
•     How to set up one or more circulation schedules for your library, including closed dates and hours of
operation
•     How to temporarily change the system date
•     How to work with transaction reports and upload transactions
•     How to modify the Circulation window display
 
CIRCULATION SETUP STEPS
 
Before you begin to use Circulation, be sure to perform the following procedures:
 

•     Create item groups. See “Creating a New Item Group” on page 3-17.
 
•     Create patron groups. See “Creating a New Patron Group” on page 3-4.
 
•     Import item barcodes, assigning items to item groups as part of this pro- cess. See
“Importing Bibliographic,  Patron, and Authority Records” on page 4-55.

 
Tip: Patron barcodes can be alphanumeric, maximum 255 characters, and are case- insensitive.
 

•     Enter patron records, assigning patrons to patron groups as part of this process. See
“Importing Bibliographic, Patron, and Authority Records” on page 4-55.
 
•     Set up your library schedules. See “System Schedule Setup” on page 5-50.
 
•     Set up your receipt printer, assuming you plan to print transaction receipts. See “Setting Up
Your Receipt Printer” on page 5-21.
 
•     Add standard patron and item messages to your system. See “Adding Mes- sages to the
Circulation System” on page 5-42.

 
 
STARTING CIRCULATION
 
To start the Circulation module:
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1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click
Circulation. This displays the Circulation Login dialog box.
 
2.      Type your user ID in the Login Name box, your password in the Password
box, and then click OK. This displays the Circulation window (Figure 5.1).
 
 
CIRCULATION  WINDOW FEATURES
 
Circulation transactions are processed at the main M3 Circulation window (Figure 5.1). This window
consists of three panes: a patron pane, an item pane, and a transactions pane. Window features are
summarized in this section.
 
FIGURE 5.1

 
•     Circulation  menu bar – Contains the File, Mode, Patron, Item, Tools, Set- tings, and Help
menus.
 
•     File menu (Figure 5.2): Change to a different database, print a receipt, or log out of the
Circulation module.

 
FIGURE 5.2
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•     Mode menu (Figure 5.3): Select the transaction mode you want to use. Because of their
frequent use, five of the transaction modes are also available from toolbar buttons.

 
 
 
FIGURE 5.3

 
 

•     Patron menu (Figure 5.4): Add or edit a patron record, process fine payment information,
attach a message to a patron record, check a patron’s transaction history, or search for a patron.
(Many of these functions are also available by right-clicking the Patron pane in the Circulation
window.)

 
FIGURE 5.4

 
Note: The History option is available only if Enable Patron History is selected in Circulation  Options. For details, see “Modifying
Circu- lation Options” beginning on page 5-6.
 

•     Item menu (Figure 5.5): Add or edit a bibliographic record, add or edit a holding record,
attach a message to an item record, review an item’s history, or search for an item record.
(Many of these functions are also available by rightclicking on the Item pane in the Circulation
window.)

 
FIGURE 5.5
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Note: The History option is available only if Enable Item History is selected in Circulation  Options. For details, see “Modifying Circu-
lation Options” beginning on page 5-6.
 

•     Tools menu (Figure 5.6): Create and edit the messages available for attachment to patron
and item records, modify and backdate the cir- culation calendar, configure the overall library
schedule, change to a different interface language, or import offline TriCoder transactions (such
as TriCoder transactions conducted from a bookmobile or while your main system is unavailable).

 
FIGURE 5.6

 
•     Settings menu (Figure 5.7): Turn the Transactions pane display off/ on, enable/disable
transaction identification sounds, and access circu- lation options for timeout periods, item and
patron history displays, due date overrides, and more (see “Modifying Circulation Options” on
page 5-6).

 
FIGURE 5.7

 
•     Help menu (Figure 5.8): Access Circulation Help topics, connect to the Mandarin Web page,
and view the circulation system log and upload log.

 
FIGURE 5.8

 
Note:  To enable the shortcut toolbar,  change the Shortcut Toolbar entry in the Mcircsys.ini file (located in the Circulation  folder
in your M3 directory) from OFF to ON, then restart  the Circula- tion module.
 

•     Circulation toolbar – Contains buttons for frequently-used transactions: Loan, Return,
Renew, Reserve, and Status. These functions are also avail- able through the Mode menu.
 
•     Shortcut toolbar – Contains buttons for commonly-used functions, such as adding an item or
patron, accessing circulation options and the schedule, and changing the interface language. To
view the function of each button, rest your mouse pointer on the button for a moment to display
a ToolTip. To turn the shortcut toolbar on or off for the current session, press CTRL+T.
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•     Barcode box – Allows you to type an item or patron barcode to access the matching record.
 
 
•     Patron  pane – Displays vital statistics for the selected patron. The informa- tion displayed
in this pane is customizable, but typically contains data such as the patron name, ID number,
address, phone number, and patron transaction statistics. Any MARC record field tag and
set of statistics can be configured to appear in this pane. The font size, style, and color in
this pane can also be customized. (See “Modifying the Patron Pane Display” on page 5-59 for
customization information.) A convenient right-click transaction menu (Figure 5.9) can be
accessed when information appears in this pane.

 
FIGURE 5.9

 
•     Item pane – Displays brief information about the selected item. As with the Patron pane,
the type of information displayed here can be configured. The font size, style, and color in
this pane can also be customized. (See “Modifying the Item Pane Display” on page 5-64 for
customization infor- mation.) A convenient right-click transaction menu can be accessed when
information appears in this pane (shown in Figure 5.9).
 
•     Transactions pane – Lists the transactions related to the active patron or item in the upper
panes. The type of information displayed here can be configured. The font size, style, and color
in this pane can also be custom- ized. (See “Modifying the Transactions Pane Display” on page
5-65 for customization information.) A convenient righ click transaction menu (Figure 5.10) can
be accessed when information appears in this pane.

 
FIGURE 5.10

 
•     Display button – Switches the Transactions pane display between all trans- actions, patron
transactions, and item transactions. A “head” icon on the Display button represents patron
transactions; a “book spine” icon repre- sents item transactions; and no icon represents all
transactions.
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•     Check box column  – When information appears in the Transactions pane, a check box
corresponding to each transaction appears in this column.
 
 
•     Status bar – Provides details about the information displayed in the Circu- lation window.
In addition to the status message on the left of the status bar, there are five boxes on the right
(shown in Figure 5.11).

 
 
 
FIGURE 5.11

 
•     Mode box – identifies the active transaction mode.
 
•     Database  box – identifies the active database.
 
•     User name box – identifies who is logged onto the circulation system.
 
•     Date box – identifies today’s date based on the circulation system cal- endar.
 
•     Time  box – identifies the current system time based on the circulation clock.
 

You can right-click several of these boxes to access shortcut options. A right-click on the mode box
opens a transaction menu (Figure 5.12); a right-click on the database box displays the Change
Database dialog box (Figure 5.18); and a right-click on the date or time boxes displays the cir- culation
calendar and clock, allowing for temporary date and time changes.
 
FIGURE 5.12

 
MODIFYING CIRCULATION OPTIONS
 
Several circulation setup options are available from within the Circulation module, including timeout
settings, patron and item history display toggles, and more. Each setting is covered in this section.
 
1.      To access these options, click Circulation Options on the Settings menu. This displays the Circulation
Options dialog box (Figure 5.13), which has five tabs.
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FIGURE 5.13

 
Note:  To  access the Circula- tion, History, and Self Mode tabs, the Circulation Options check box must be selected in Group
Editor.  See Figure 3.7 on page 3-8.
 
2.      Click the appropriate tab, and modify as desired.
 

•     Circulation tab (Figure  5.13):
 
•     Global Timeout – Select the Enable Timeout check box to enable the timeout feature. In the
Timeout list, select the desired number of seconds before the Circulation window automatically
clears after a transaction.
 
•     Fine Calculation – Select  the Exclude Closed Days From Fine check box if your institution does
not want to include closed days in fine accruals.
 
•     Barcode – Select the Pre-Process check box to have the system pre- process barcodes as
they are scanned into the system. Some barcode scanners automatically add leading zeros or
following characters to barcodes as they are scanned into the system. You can select the number
of leading or trailing characters to be removed from scanned barcodes in the Leading Zeros and
Trailing Chars lists.
 
•     Sound tab (Figure  5.14):
 

FIGURE 5.14

 
 

•     Enable Sound – Select to enable the sound cues that accompany each circulation transaction.
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•     Sound Device – Select the type of sound device installed on your computer.
 
•     History tab (Figure 5.15):

 
FIGURE 5.15

 
Note: To disable this tab, change the History Option entry in the Global.ini.REG file (the default path is C:\M3 Server\Registry
\Common) to Disable=on.
 

•     Enable Patron History – Select if you want the option to view patron transaction histories during
standard circulation transactions. If enabled, a History option appears on the Patron menu
(Figure 5.4). When History is selected, the Transactions pane can be switched to display Patron
History.
 
•     Enable Item History – Select if you want the option to view item transaction histories during
standard circulation transactions. If enabled, a History option appears on the Item menu (Figure
5.5). When History is selected, the Transactions pane can be switched to display Item History.
•     Self Mode tab (Figure 5.16):

 
FIGURE 5.16

 
 

•     Enable Patron Display – Select to display active patron transaction information in the
Transactions pane during self-checkout and self-return modes.
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•     Timeout Period (secs) – Select the number of seconds that a self- checkout or self-return
transaction displays after a transaction is completed.  After the timeout period elapses without
any worksta- tion activity, data in the Circulation window clears.

 
•     Due Date tab (Figure  5.17):

 
FIGURE 5.17
 

 
•     Normal Calculation – Click this option to use the default loan period due date (set by item
group in the Group Editor).
 
•     Use Provided Date For This Session  – Click this option to override the default due date
calculation based on the item group loan period. This displays a calendar. Use the calendar’s
left (<) and right (>) arrows to select a month, then click the desired date. The selected date
appears in the box. This date stays in effect until you click Normal Calculation or log out of
Circulation.
 

3.      When finished, click OK.
 
 
SELECTING AN  INTERFACE LANGUAGE
 
With M3 Circulation, you can specify the interface language. This affects screen elements such as
names of windows, buttons, and text boxes; it does not affect the language of the records in your
database. (The default language and the lan- guages displayed in the list can be reconfigured by the
system administrator.)
 
To select an interface language:
 
Tip: You can also  change the language by clicking  the corresponding  flag on the shortcut toolbar.
 
1.      On the Tools menu, click Change Language. This displays a sub-menu with the languages available
for selection.
 
2.      Click the language you want to use. This refreshes your circulation inter- face to display the
selected language.
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SELECTING A  CIRCULATION DATABASE
 
M3 Circulation may operate the circulation of items in several databases. If so, it is easy to change to a
different database while using the system. To do so:
 
1.      On the File menu, click Change Database. This displays the Change Data- base dialog box (Figure
5.18).
 
FIGURE 5.18

 
2.      In the Current Database  list, select the desired database.
 
3.      Click OK. The selected database displays on the status bar.
 
 
CONDUCTING TRANSACTIONS
 
Note: If a scanned barcode is invalid,  three distinct beeps will sound.
 
All circulation transactions are accessed from the Circulation window. You can view patron and item
status, loan items, return items, renew items, reserve and hold items, book equipment and rooms,
attach patron and item messages, process fine payments, forgive fines, and record patron claims of lost,
previously paid, never had, and previously returned. Procedures are explained in the following sec-
tions.
 
Viewing Patron and  Item Status
To view the status of a patron or item:
 
1.      On the toolbar, click Status.
 
2.      In the Barcode box, type the item or patron barcode, and then press ENTER (or scan the code).
This displays a record in the Patron or Item pane, depending upon the type of code you entered. If there
are any open trans- actions for this patron or item, they display in list form in the Transactions pane
(Figure 5.19).
 
FIGURE 5.19
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Tip: To retrieve a recently used barcode (patron or item),  click the desired barcode in the Barcode  list.
 
3.      To view the status of another patron or item, enter a different barcode in the Barcode box.
OR
 
To continue with a transaction, right-click the mode box on the status bar. This opens a transaction
menu (Figure 5.12). These transactions are explained in the following sections.
 
Loaning Items
To loan one or more items to a patron:
 
1.      On the toolbar, click Loan.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
NOTES:
•     If your library has not yet established a circulation schedule, an error message displays. For information on establishing a
circulation schedule, see “System Schedule Setup” on page 5-50.
•     If any patron has a fine associated with it, a fine message displays. You can:
•     Click Override to ignore the message and continue with the trans- action.
•     Click Payment to display the Payment dialog box.
•     Click Cancel to stop the transaction.
 
3.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). The loan
transaction appears in the Transactions pane as shown in Figure 5.20.
 



 
Using Circulation

© 2014 Mandarin Library Automation, Inc. All rights reserved.
154 of 361

FIGURE 5.20

 
Tip: Click the Display button  to switch  between a list of patron transactions, item transactions, and all transactions.
 
4.      To loan more items to this patron, type the next item barcode in the Bar- code box, and then press
ENTER (or scan the code). Repeat this process for each item loaned to this patron.
 
Note: If an item is returned that belongs to a special reserve group, a warning message displays. For more information  on special
reserve groups, see “Working with Special Reserve Groups” beginning on page 3-23.
 
Returning Items
M3 Circulation provides five methods to return items. Four methods are described here, and Self-
Return is described on page 5-23.
 

•     Single Return method – Used when a patron is returning a single item.
 
•     Multiple Return method – Used when one patron is returning multiple items.
 
•     Quick Return method – Used when scanning bookdrop returns without patrons present.
 
•     In-House Circulation method – “Returns” items left on tables and desks after in-library use.

 
Returning  One Item
To return an item:
 
1.      On the toolbar, click Return.
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2.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). This returns
the item.
 
Returning  Multiple  Items for the Same Patron
To return multiple items for one patron:
 
1.      On the toolbar, click Loan, Reserve, or Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      In the Transactions pane, select the check box by each item the patron is returning.
 
4.      Right-click on the Transactions pane to open a transaction menu (Figure 5.10).
 
5.      Click Return. This returns all selected items.
 
Quick Return
This rapid entry method is designed for situations such as bookdrop returns. Quick Return does not
alert you to patron messages since it is assumed that patrons are not present. (This information
is included in the patron record and dis- plays the next time the patron conducts a circulation
transaction.) Quick Return does alert you when a Hold is attached to an item.
 
To return items using the Quick Return method:
 
1.      On the Mode menu, click Quick Return.
 
2.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). Repeat this
for each item being returned.
 
3.      When finished, select another transaction mode to exit Quick Return.
 
NOTE: The Patron, Item, and Transactions panes do not update during the Quick Return procedure.
 
 
In-House Circulation Returns
This method is designed to “return” items that were removed from shelf positions and left on library
tables or desks, presumably used at the library though not checked out. This feature takes the
guesswork out of tracking in-library usage of your collection. As with Quick Returns, the In-House
Circulation return mode does not alert you to any messages except when a Hold is attached to an item.
 
To perform In-House Circulation returns:
 
1.      On the Mode menu, click In-House Circulation.
 
2.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). Repeat this
for each item being returned. When finished, select another transaction mode on the toolbar to exit In-
House Circulation.
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Recording an  Item as  Lost or Damaged
When an item is returned and recorded as damaged, a fine is attached to the patron’s record. The fine
amount is the maximum amount established for mem- bers of the item group (see step 6 on page 3-15).
 
When an item is recorded as lost, the fine amount is the item price indicated in field 852#9. If no price
exists, the fine is the maximum fine as set in Group Editor.
 
NOTE: If you want to be prompted to add an additional transaction fee to a lost or damaged item,
change the Transaction Fee entry in the Global.ini.REG file (the default path is C:\M3 Server\Registry
\Common) to Prompt for fee=on. In the amount entry, the default is $5.00; change if desired.
 
1.      On the toolbar, click Loan, Reserve, or Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      In the Transactions pane, select the check box by the item to record as lost or damaged, and then
right-click. This opens a transaction menu (Figure 5.10).
 
4.      Click Lost or Damaged.  At the confirmation prompt, click Yes.
 
NOTE: If an additional transaction fee has been configured, the Transac- tion Fee dialog box displays the default fee amount.
Change if desired, then click OK. This amount is added to the lost or damaged fine.
 
The item is removed from the listing in the Transactions pane.
 
Claiming an  Item as  Returned or Never Had
1.      On the toolbar, click Loan, Reserve, or Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      In the Transactions pane, select the check box by the item claimed as returned or never had, and
then right-click. This opens a transaction menu (Figure 5.10).
 
4.      Click Claimed Returned or Claimed Never Had. The item is removed from the listing in the
Transactions pane.
 
 
Renewing a Loan on  an  Item
M3 Circulation provides two methods to renew items on loan, which are described in the following two
sections. The second method saves time if the patron is renewing more than one item.
 
Renewing One Item
To renew an item:
 
1.      On the toolbar, click Renew.
 
2.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code).
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NOTE: If the item is overdue, an overdue message displays. You can:
•     Click Override to ignore the message and continue with the transaction.
•     Click Payment to accept payment of the fine (see “Processing Patron Fines” on page 5-19 for instructions).
•     Click Cancel to stop the transaction.
 
The renewal transaction appears in the Transactions pane as shown in Figure 5.21.
 
FIGURE 5.21

 
Notes:
• You cannot reserve or hold a deleted item.
• If you  want  to be notified when an item is being placed on hold instead of reserve, change the Display Placed on Hold Messages
entry in the Mcircsys.ini  file (located in the Circulation folder in your M3 directory) from OFF to ON, then restart  the Circulation
module.
 
Renewing Multiple  Items for the Same Patron
To renew multiple items for one patron:
 
1.      On the toolbar, click Loan, Reserve, or Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
NOTE: If the patron has overdue items, an overdue message displays. You can:
•     Click Override to ignore the message and continue with the transaction.
•     Click Payment to accept payment of the fine (see “Processing Patron Fines” on page 5-19 for instructions).
•     Click Cancel to stop the transaction.
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3.      To renew one or more items listed in the Transactions pane, select the check box by each item the
patron is renewing, and then right-click. This opens a transaction menu (Figure 5.10). Click Renew. Or,
to renew all items listed in the Transactions pane, click Renew All.
 
NOTE: If any of the selected items are overdue, an overdue message dis- plays. You can:
•     Click Override to ignore the message and continue with the transac- tion.
•     Click Payment to accept payment of the fine (see “Processing Patron Fines” on page 5-19 for instructions).
•     Click Cancel to stop the transaction.
 
The renewal transaction appears in the Transactions pane as shown in Figure 5.21.
 
Reserving or Holding an  Item
Reserve and hold transactions are conducted from the Reserve mode. A hold is applied when the
requested item is currently checked into the library and is there- fore available; a reserve is applied
when the item is currently checked out.
 
To reserve or hold an item:
 
1.      On the toolbar, click Reserve.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). The reserve
or hold transaction appears in the Transactions pane as shown in Figure 5.22.
 
FIGURE 5.22
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Note: There must be an e-mail address entered in the patron record to use this feature.
 
Sending E-Mail Notifications for  Items on  Hold
You can configure M3 to send automatic e-mail notifications to patrons when items they reserved are
returned and placed on hold.
 
1.      In the Global.ini.REG file (the default path is C:\M3 Server\Registry\Common), do the following:
 

A.     The default fields for patron notification are as follows. Change if desired. [PATRON INFO
FIELD] email=110#m phone=110#k
 
B.     Type the name of your e-mail server.
 
[SMTP SERVER]
name=
 
C.     Type the e-mail address that will appear in the “From” field in the e-mail notifications.
 
[NOTIFICATION EMAIL]
sender=
 

2.      When a reserved item is placed on hold, the e-mail confirmation is sent, and a copy of the e-mail is
sent to the address indicated in step C.
 
Note:  You cannot book a deleted item.
 
Booking an  Item
Use the Booking feature to reserve an item such as a conference room or piece of equipment for a future
day and/or time. You can book an item for a single day, a range of days, or for specific hours.
 
To book an item:
 
1.      On the Mode menu, click Booking.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code). This
displays the patron’s record in the Patron pane.
 
3.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). This displays
the Booking dialog box (Figure 5.23).
 
FIGURE 5.23
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4.      Select the date and, if applicable, the time to book the item. To do so:
 

•     To book an item for one day, click the day you want the item, and then click Add. This displays
the Booking Range dialog box (Figure 5.24) with the date selected. Click OK to return to the
Booking dialog box and place a marker on the selected day. When finished, click OK.

 
FIGURE 5.24

 
•     To book an item for more than one day, click the first day you want the item and drag the
mouse to the last day you want the item. Then click Add. This places a marker within the
selected range of days. When finished, click OK.
 
•     To book an item for a few hours, click the Calendar/Hourly button. This displays the Agenda
window (shown in Figure 5.25). Click the start time you want for the item and drag the mouse
to the ending time you want for the item. Then click Add. This places a color-coded marker
along the selected time. When finished, click OK.

 
FIGURE 5.25
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•     To manually book an item:
 

A.     In the Booking dialog box, click Add. This displays the Booking Range dialog box (Figure
5.24).
 
B.     Click in the From box. This displays a calendar with today’s date highlighted (Figure 5.26).

 
FIGURE 5.26

 
 

C.     In the calendar, click the first date in the range you want to book.
In the Time box, select the start time. When finished, click OK. This returns you to the Booking
Range dialog box.
 
D.     Click in the To box, then repeat step C to enter the date and time you want to return the booked
item. When finished, click OK. The selected time frame now displays in the Booking dialog box.

 
5.      When finished booking the item, click OK. The booking transaction appears in the Transactions
pane.
 
 
Sending E-mail Notifications for  Fines and  Overdue Items
You can send e-mail notifications to patrons who owe fines or have overdue items.
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1.      Indicate the e-mail address that will appear in the “From” field in the e-mail notifications. To do
so, see step 1C on page 5-16.
 
2.      To send notifications, click Library Transactions on the Mode menu. This dis- plays a listing of all
transactions in the Transactions pane.
 
3.      Right-click in the Transactions pane, then click Select Transactions on the command menu. This
displays the Select Transactions dialog box (Figure 5.27).
 
FIGURE 5.27

 
Note: To send e-mail notifications to patrons who owe fines, see the preceding section, “Sending E-mail Notifications for Fines and
Overdue Items.”
 
4.      In the Transaction Type group, click Fines or Overdue Loans, and then select the Send notification
check box. Then do one of the following:
 

•     If you clicked Fines, select an option in the Time Period group.
 
OR
 
•     If you clicked Overdue Loans, select an option in the Overdue Loans
group.

 
5.      Click OK. All patrons with transactions  that meet the fine or overdue cri- teria are sent a
notification, and these transactions display in the Transac- tions pane.
 
Processing Patron Fines
Before you can receive payment or forgive a fine, the overdue item must be returned or claimed as lost
or damaged. The item status changes from Overdue Loan to Fine when the item is returned.
 
Recording a Payment
1.      On the toolbar, click Loan, Reserve, or Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code). This
displays a message stating the patron has unpaid fines.
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3.      Click Payment. This displays the Payment window (Figure 5.28), which lists the patron’s overdue
items and related fine information. A Totals box appears in the lower left; the current fine total appears
in the Total box in the Payment column.
 
FIGURE 5.28

 
Tip: To view refunds, click History.
 
4.      Review the current fine total in the Totals box. If the patron intends to pay the full fine amount
now, skip to step 5.
 

•     If the patron wants to exclude an item from payment at this time, clear the Pay check box.
This changes the color of the amount in the Balance column from green to red.
 
•     If the patron wants to make a partial payment on a specific item’s fine, click the item’s
listing in the Payment column and type the amount being paid now.
 
•     If you want to forgive all or part of a fine on an overdue item, click the item’s listing in the
Forgiven column and type the amount to be for- given.
 
•     If the patron claims that he or she previously paid a particular fine, click History to review
the payment history. If you want to record that this item was previously  paid, select the
Claimed Paid check box by that item. This eliminates the item’s fine amount in the Payment
column, and reduces the payment amount in the Total box.

 
•     If you want to increase an item’s fine amount, click the item’s listing in the Fine column and type
the new amount. (This is useful if you want to charge for not rewinding a tape, damage, and so on.)
 
•     To add a new fine, click New Fine. Type the amount of the fine and a note, if desired (the note
will display in the Title column of the Pay- ment window). Click OK.
 
•     To apply a refund, click Refund. Type the amount of the refund and a note, if desired (the
note will display in the Title column of the Pay- ment window). Click OK.

 
5.      Type the amount of currency received in the Tendered line, then click OK.
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If change is due back, a dialog box displays the amount to be returned to the patron. To close the dialog
box, click Close.
 
6.      This displays a dialog box asking if you want to print a receipt. Click Yes or No.
 
NOTE: If the amount typed in the Tendered box is less than the Total pay- ment amount, an error message displays. Click Close to
close the dialog box, then adjust the appropriate entry in the Payment window.
 
Reviewing the Patron’s Fine History
1.      On the toolbar, click Status.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      On the Patron menu, click Payments. This displays the Payment window (Figure 5.28).
 
4.      Click History. This displays the patron’s list of previously paid fines, if any are on record.
 
Printing Transaction Receipts
You can print several transaction receipts through Circulation, including:
 

•     Status – Lists all transactions for the selected patron.
 
•     Today’s All – Lists all transactions for the current day for the selected patron.
 
•     Today’s Loans – Lists all loans for the current day for the selected patron.
 
•     Today’s Returns – Lists all returns for the current day for the selected patron.
 

Setting Up Your Receipt Printer
Before you can print transaction receipts, you must set up your receipt printer. To do so:
 
1.      On the File menu, select Print Receipt, and then click Printer Setup. This dis- plays the Receipt
Printer Setup dialog box (Figure 5.29).
 
FIGURE 5.29
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2.      To print receipts, select the Enable Receipt  Printing check box. This acti- vates several functions on
this dialog box.
 
3.      If you want the patron’s name to appear on the receipt, select the Print Patron Name check box.
 
4.      In the Current Printer group, click Change. This displays the Print Setup dialog box.
 
 
NOTE: Verify that your receipt printer is connected to your computer and that the printer device drivers are installed.
 

A.     In the Name list, select the appropriate printer.
B.     Change settings as desired, then click OK.
 

5.      If you want the system to print receipts automatically for specific transac- tion types, select the Print
Each Transaction  check box, and then select the check box next to each appropriate transaction type.
 
6.      To place header and/or footer text on each receipt, type the desired text in the Header and/or Footer
boxes.
 
7.      When finished, click OK to save your entries and return to the Circulation window.
 
Printing Receipts
To print a transaction receipt:
 

•     On the File menu, click Print Receipt, and then select the appropriate  receipt type.
OR
 
•     If you are in Loan mode, press F12 on your keyboard while the transaction is displayed.
 

Printing Transaction Information
You can print patron information from the Patron pane, item information from the Item pane,
transaction information from the Transactions pane, and historical library circulation reports from the
Transactions pane while in the Library Trans- actions mode. To print circulation reports, see “Viewing,
Sorting, and Printing Circ Reports” on page 5-55.
 
To print patron, item, or transaction information:
 
1.      On the Circulation window, right-click the pane you want to print. This dis- plays a transaction
menu (Figure 5.9).
 
2.      Click Print. If a Print dialog box appears, change settings if desired, and then click OK.
OR
 
3.      If you want to see a preview before printing, click Print Preview. When the preview appears, click
the desired option on the preview toolbar.
(NOTE: Print Preview is not available when in the Library Transactions display mode.)
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Using Self-Checkout and  Self-Return
These features allow patrons to check out or return items without staff assistance. NOTES:

•     For system security, once the Self-Check transaction mode is selected, the patron cannot
perform any other type of circulation transaction. The patron’s only options are to self-checkout
or log out of the Circulation module. Similarly, if the Self-Return transaction mode is selected,
then the patron is limited to self-return or log out. Libraries using the Self mode can set up
a network workstation restricted to self-checkout transactions, and a separate workstation
restricted to self-return transactions.
 
•     For privacy, the Self mode can be configured so patron and item transac- tions do not
display. See “Modifying Circulation Options” on page 5-6.
 
•     To enable override messages in Self-Check mode, change the Self Mode entry in the
Global.ini.REG file (the default path is C:\M3 Server\Registry\Common) to Skip Override=off.
Otherwise, the only override  that will dis- play is if the item is non-circulating.
 

Using Self-Checkout
To conduct self-checkout transactions:
 
1.      On the Mode menu, click Self-Check. The workstation remains in this mode until you log out of
circulation.
 
2.      Type the patron barcode in the Barcode box, then press ENTER (or just scan the code).
 
3.      Type the item barcode in the Barcode box, then press ENTER (or just scan the code). The loan
transaction appears in the Transactions pane.
 
NOTE: If a Self mode timeout period has been set, the transaction infor- mation clears automatically. (See “Modifying Circulation
Options” on page 5-6.)
 
Using Self-Return
To conduct self-return transactions:
 
1.      On the Mode menu, click Self-Return. The workstation  remains in this mode until you log out of
circulation.
 
2.      Type the item barcode in the Barcode box, then press ENTER (or just scan the code). This returns
the item.
 
NOTE: If a Self mode timeout period has been set, the transaction infor- mation clears automatically. (See “Modifying Circulation
Options” on page 5-6.)
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Working with Item Records
 
You can search for, edit, and create new bibliographic and holding records from both the M3 Circulation
module and the M3 Cataloging module. Because the M3
Cataloging module includes templates and record duplicating functions, it is a better choice when
creating a number of records. To delete records, you must use the M3 Cataloging module.
 
In this section, items are sometimes divided into bibliographic records and holding records.
 
Searching for  an  Item Record
You may want to search for an item record if you do not know the item’s barcode. There are two
methods of searching in Circulation: from the main window and with the Search dialog box.
 
Searching from the Main Window
This procedure is a quick and simple method of searching for an item by title.
 
NOTE: If you are in Loan, Reserve, or Booking mode, there should be an active patron in the Patron pane before searching by this
method.
 
1.      Type a keyword in the Barcode box.
 
2.      If a match is found, the record displays in the Item pane of the Circulation window, ready for a
transaction. NOTE: If no match is found for an item but a match is found for a patron, the patron results
display.
OR
 
If more than one match is found, the Select Barcode dialog box displays (Figure 5.30). Click the desired
record, then click OK. The record displays in the Item pane of the Circulation window, ready for a
transaction.
 
FIGURE 5.30

 
Searching with  the Search Dialog Box
This procedure offers more search options. It also locates both the bib and any corresponding holding
records.
 
1.      On the Item menu, click Search. This displays the Holding Search dialog box (Figure 5.31).
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FIGURE 5.31

 
Boolean operator list Note: Your system can be configured to display different bib record fields and Boolean operators,
as well as different options within  the record field lists.
 
 
Search Tips:
• You can apply the trunca- tion asterisk (*) to the begin- ning and/or end of a keyword; the wildcard  question mark (?) character
within  a keyword (wom?n); and quotation marks (“ ”) around a phrase.
• You can use the AND, OR, and NOT Boolean operators to connect keywords within  a keyword box. Be sure to type operators in
capital letters.
 
FIGURE 5.32

 
2.      Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or operator.
 
3.      Click Search. This displays the Holding Search Results window (Figure 5.32) with your search
results listed.
 
Tip: You can also double-click a bib or holding record to transfer the information  to the Circulation window.
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4.   From here, you can:
 

•     Select a bibliographic or holding record, then click OK. This transfers the item information
to the Item pane in the Circulation window.
OR
 
•     Click Search to display the Holding Search dialog box (Figure 5.31)
and begin a new search.
 
OR
 
•     Click Cancel to return to the Circulation window.

 
Creating an  Item Record
The procedure to create a bibliographic record varies from the procedure to create a holding record.
Both procedures are covered in this section.
 
Creating a Bibliographic Record
At times, it may be convenient to create a bibliographic record while using the M3
Circulation module. You can also create records from the M3 Cataloging module. If you have several
records to add, you may find it more efficient to import them using the M3 Cataloging module. To do so,
see “Importing Bibliographic, Patron, and Authority Records” on page 4-55.
 
To create a bibliographic record:
 
1.      On the Item menu, click Add Bibliographic. This displays  the Templates dialog box (Figure 5.33)
containing a list of available bibliographic record templates.
 
FIGURE 5.33

 
 
2.      Select a template, then click OK. This displays the Create New Biblio- graphic Record window
(Figure 5.34 shows the template “Book-Long”).
 
FIGURE 5.34
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Note: To automatically  delete all fields left empty when the record is saved, change the Strip Empty Fields entry in the
ActiveMarcEdit.ini file (located in your M3 direc- tory)  to OVERRIDE=off, then restart  the Circulation module.
 
3.      Enter field and subfield data for the new record. To move through the record, use your keyboard up
and down arrows. Notice that status bar information changes to identify the selected field and subfield.
 

•     To access a menu with edit commands (Figure 5.35), select the field you want to edit and
right-click. You can insert, copy, paste, cut, delete, and move fields from this menu. You can click
Find to display a dialog box that allows you to locate text within this record. In addi- tion, you
can click Toggle Prompts to change the MARC field labels from text to tag numbers.

 
FIGURE 5.35
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Tip: To insert a picture  field in this record so a picture displays in the Item pane when the item is selected, see “Adding  a Picture
Field to a Bibliographic or Patron Record”  on page 5-38.
 
 

•     To access a list of fixed field standard choices (including position and legal characters)
pertaining to a particular fixed field, double-click in the field. The dialog box for fixed field 000 is
shown in Figure 5.36. You can define your fixed field by typing in text or, where available, clicking
an arrow button and selecting an option in the list. When fin- ished, click OK.

 
FIGURE 5.36

 
•     If you are using a version of M3 that supports Authority Control, and the field you want to
enter is managed under Authority Control, then you must select a predefined authority record. To
do so, click in the white edit area of the field (as shown in Figure 5.34). This displays the Authority
Records dialog box (Figure 5.37).

 
FIGURE 5.37
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Select the authority record you want to use, then click OK. This returns you to the Create New
Bibliographic  Record window (Figure 5.34) and enters the new record in the selected field.
 
4.      When finished adding information to this bibliographic   record, click OK in the Create New
Bibliographic Record window. This places the new record in your library’s bibliographic record database,
now available for circula- tion purposes and searching.
 
5.      At the prompt “Create Holding Record?” click Yes or No.
 
 
Creating a Holding Record
At times, it may be convenient to create a holding record while using the M3 Cir- culation module. You
can also create a holding record from the M3 Cataloging module.
 
To create a holding record:
 
1.      Locate the bib record matching the holding record you want to create.
 

A.     On the Item menu, click Add Holding. This displays the Bibliographic Search dialog box
(Figure 5.38).

 
FIGURE 5.38
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B.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or operator.

 
2.      Click Search. This displays the Bibliographic Search Results window with your search results
listed (Figure 5.39).
 
FIGURE 5.39

 
3.      Click the bib record in the upper pane that corresponds to the holding record you want to create,
then click OK. This displays the Create New Holding Record window (Figure 5.40).
 
FIGURE 5.40
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Notes:
• If you want temporary items to remain in the catalog after being returned,  change the Temporary Holding option in the
Mcircsys.ini file.
Contact your  sustem  administrator for assistance.
• Temporary items cannot  be placed on reserve.
 
4.      Enter field and subfield data for the new record. For instructions, see step 3 beginning on page
5-27. NOTE: Since Authority Control fields are not available for holding records, skip the Authority
Control option explained on page 5-28.
 
5.      Select the Temp check box if this record is temporary. When the item is returned, the record is
marked for deletion, and the barcode record is labeled “detached” so it can be used again.
 
6.      When finished:
 

•     Click OK to save your entries and return to the Circulation window. If M3 Circulation is in
Loan mode and a patron is currently active, the new item is now on loan; if Circulation is in the
Reserve mode, the new item is now placed on reserve.
OR
 
•     Click Cancel to erase your new entries and return to the Circulation window.
OR
 
•     Click Get Biblio to display the Bibliographic Search dialog box (Figure 5.38) and begin a new
search.

 
 
Editing an  Item Record
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The procedure to edit a bibliographic record differs from the procedure to edit a holding record. Both
procedures are covered in this section.
 
Editing  a Bibliographic Record
To edit a bib record:
 
1.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). This displays
item information in the Item pane of the Circula- tion window.
 
2.      On the Item menu, click Edit Bibliographic. This displays  the Edit Biblio- graphic Record window
(Figure 5.41).
 
FIGURE 5.41

 
3.      Edit this record as needed. For instructions, see step 3 beginning on page 5-27.
 
4.      When finished, click OK to save your changes.
 
Editing  a Holding Record
To edit a holding record:
 
1.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). This displays
item information in the Item pane of the Circula- tion window.
 
2.      On the Item menu, click Edit Holding. This displays the Edit Holding Record window (Figure 5.42).
 
FIGURE 5.42
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3.      Edit this record as needed. For instructions, see step 3 beginning on page 5-27. NOTE: Since
Authority Control fields are not available for holding records, skip the Authority Control option
explained on page 5-28.
 
4.      When finished, click OK to save your changes.
 
Deleting an  Item Record
You cannot delete a bibliographic or holding record from the M3 Circulation module. For security
reasons, you can only delete item records from the M3 Cata- loging module. For instructions, see
“Deleting and Undeleting Records” on page 4-47.
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Working with Patron Records
 
You can search for, edit, and create patron records from both the M3 Circulation module and the M3
Cataloging module. When adding several records, M3 Cata- loging is the best module to use. To delete
records, you must use the M3 Cataloging module.
 
Patron records are treated as a separate MARC database within M3 Circulation.
 
Searching for  a Patron Record
You may want to search for a patron record if you do not know the patron’s bar- code. There are two
methods of searching in Circulation—from  the main window and with the Search dialog box.
 
Searching from the Main Window
This procedure is a quick and simple method of searching for a patron by name.
 
NOTE: If you are in Loan, Reserve, or Booking mode and another patron already appears in the Patron pane, press ESC to clear
the pane before searching by this method.
1.   Type the patron’s last name in the Barcode box.
2.      If a match is found, the record displays in the Patron pane of the Circula- tion window, ready for a transaction. NOTE: If no
match is found for a patron but a match is found for an item, the item results display.
OR
If more than one match is found, the Select Barcode dialog box displays (Figure 5.30). Click the desired record, then click OK. The
record displays in the Patron pane of the Circulation window, ready for a transaction.
 
FIGURE 5.43

 
Searching with  the Search Dialog Box
This procedure offers more search options.
 
1.      On the Patron menu, click Search. This displays the Patron Search dialog box (Figure 5.44).
 
FIGURE 5.44
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Note: Your system can be configured to display different patron record fields and Boolean operators, as well as different options
within the record field lists.
 
 
2.    Type your search query into the appropriate boxes. To select a different MARC field or Boolean
operator, click the arrow next to the appropriate list, and then select the preferred field or operator.
 
3.      Click Search. This displays the Patron Search Results window (Figure 5.45) with your search
results listed.
 
FIGURE 5.45

 
 
 
Tip: You can also double-click a patron  record to transfer the information to the Circulation window.
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Tip: If you think  the name may  be misspelled in the system, use truncation  to broaden your keyword search. For  example, type
whitn* to locate whitney, whitnee, whitnie,  and so on.
 
4.      From here, you can:
 

•     Select a patron, then click OK. This transfers the patron information into the Patron pane in
the Circulation window.
OR
 
•     Click Search to display the Patron Search dialog box (Figure 5.44) and begin a new search.
OR
 
•     Click Cancel to return to the Circulation window.

 
Creating a Patron Record
At times, it may be convenient to create a patron record while using the M3 Cir- culation module.
You can also create records from the M3 Cataloging module. If you have several records to add, you
may find it more efficient to import them using the M3 Cataloging module. To do so, see “Importing
Bibliographic, Patron, and Authority Records” on page 4-55.
 
When adding a patron record, you must first conduct a search to confirm that the patron is not already
entered in the system.
 
To create a patron record:
 
1.      On the Patron menu, click Add Patron.
 

•     If more than one patron template exists, the Templates dialog box dis- plays. Select the template
you want to use, then click OK. This displays the Patron Search dialog box (Figure 5.44).
OR
 
•     If only one patron template exists, the Patron Search dialog box (Figure 5.44) displays.

 
2.      To make sure the patron is not already in the system, type the patron’s information in the
appropriate keyword boxes, then click Search.
 

•     If there is no patron in the system with this information,  the Create
New Patron Record window displays (Figure 5.46).
 
OR
 
•     If there is a patron in the system with this information,  the Patron Search Results window
displays the search results (Figure 5.45). Review the list to confirm that the patron you are
entering is not included, then click Cancel. This displays the Create New Patron Record window
(Figure 5.46).

 
FIGURE 5.46
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Tip: To insert a picture field in this record so a picture displays in the Patron  pane when the patron is selected, see “Adding  a
Picture Field to a Bibliographic or Patron Record”  on page 5-38.
 
3.      Edit this record as needed. For instructions, see step 3 beginning on page 5-27. NOTE: Since
Authority Control fields are not available for patron records, skip the Authority Control option
explained on page 5-28.
 
4.      When finished, click OK to save your changes.
 
Editing a Patron Record
To edit a patron record:
 
1.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code). This
displays patron information in the Patron pane of the Circulation window.
 
2.      On the Patron menu, click Edit Patron. This displays the Edit Patron Record window (Figure 5.47).
 
FIGURE 5.47
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3.      Edit this record as needed.
 
NOTE: Since Authority Control fields are not available for patron records, skip the Authority Control option.
 
4.      When finished, click OK to save your changes.
 
Deleting a Patron Record
You cannot delete a patron record from the M3 Circulation module. For security reasons, you must
delete patron records from the M3 Cataloging module. For instructions, see “Deleting and Undeleting
Records”
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Displaying Item and Patron Picture
 
Pictures, such as cover images and patron photos, can be displayed alongside items and patrons in the
Circulation window.
 
To import and link multiple image files at once, use the M3 Picture Manager utility, which can be
accessed through the M3 Cataloging module. To add a picture to one item or patron record at a time,
see the following section, “Adding a Picture Field to a Bibliographic or Patron Record.”
 
Once pictures are imported into your M3 database, they display automatically alongside patrons and
items in the Circulation Patron and Item panes if M3 v1.6 was your first installation of M3. If you had
a version of M3 installed prior to installing 1.6, you must do the following:
 

•     Add a graphic cell to the Patron pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Mod- ifying the Patron Pane Display” on page 5-59.
 
•     Add a graphic cell to the Item pane for each Circulation mode (Loan, Return, and so on)
in which you want an image to display; changes made to one mode will not apply to the other
modes. For instructions, see “Mod- ifying the Item Pane Display” on page 5-64.

 
Adding a Picture Field to a Bibliographic or Patron Record
To add a picture field to a bibliographic or patron record:
 
1.      In the Barcode box, type the barcode of the item or patron to which you want to assign the picture,
and then press ENTER (or scan the code). This displays the item or patron information in the Item or
Patron pane of the Circulation window.
 
2.      If you are working with an item record, click Edit Bibliographic  on the Item menu. This displays the
Edit Bibliographic  Record window (Figure 5.41).
 
OR
 
If you are working with a patron record, click Edit Patron  on the Patron menu. This displays the Edit
Patron Record window (Figure 5.47).
 
3.      Right-click in the window to open a command menu (Figure 5.35), then click Insert Field. This
displays the Insert Field dialog box (Figure 5.48 shows the Insert Field dialog box for patron records).
 
FIGURE 5.48
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4.      Select field 996 Picture, then click OK. This displays the Insert Subfield dialog box (Figure 5.49).
 
 
 
FIGURE 5.49

 
 
5.      Click subfield a, then click OK. This displays the Picture Manager dialog box (Figure 5.50).
 
FIGURE 5.50
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Tip: You can also double-click the 996 field in the record window  to display the Picture Manager dialog box.
 
Note: The video capture device driver must be Microsoft DirectX® compatible.
 
6.      In the Image Source group, select the source of the picture. After you click an option, the name of
and the options available in the Image Selection pane (shown in Figure 5.50) change.
 

•     Video Capture Device – Use a video capture device (preferably a USB camera) hooked to your
computer to capture a picture. To do so, point the camera at the subject for the picture. The
image appears in the Preview pane (shown in Figure 5.52). Click Capture. If satisfied with the
image, click Save; if not, click Preview to view the image and capture it again.
 
•     Local Picture Table – Search a local table for picture records. To do so, click Search. This
displays the Picture Search dialog box (Figure 5.51).

 
FIGURE 5.51

 
 
Tip: To copy a picture  to the Clipboard:
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• While viewing  the picture, press ALT+PRINT SCREEN.
• Open the picture  in a word processing or drawing program, then click Copy (usually on the Edit menu).
 

A.     Type your search query into the appropriate boxes. To select a different MARC field or
Boolean operator, click the arrow next to the appropriate list, and then select the preferred field
or oper- ator.
 
B.     Click All, Restrict to patron, or Restrict to bibliographics to search for all pictures, pictures
assigned a p (patron) in the 991#a field, or pictures assigned a b (bibliographic) in the 991#a field.
 
C.     Click OK. This displays the picture of the first search result in the Preview pane, and the
record’s fields and subfields in the Record pane (shown in Figure 5.52).
 

•     Remote Picture Table – Search a remote table for picture records. This option is
intended for bibliographic records. The procedure is iden- tical to the procedure for the
Local Picture Table option.
 
•     File – Use a previously-saved picture file (in .jpg or .bmp format). To do so, click
Browse. In the Open Image File dialog box, navigate to the desired file, and then
click Open. This displays the picture in the Pre- view pane and the record’s fields and
subfields in the Record pane (shown in Figure 5.52).

 
•     Windows Clipboard – Use a picture copied to the Windows Clipboard.
To do so, copy the picture to the Clipboard, then click Paste. This dis- plays the picture in the
Preview pane and the record’s fields and sub- fields in the Record pane (shown in Figure 5.52).

 
FIGURE 5.52

 
7.      To add fields to this picture record (such as file name or title), right-click in the Record pane and
repeat steps 3 through 5, selecting the field and subfield you want to add.
 
8.      When finished, click Save. This returns you to the Edit Patron Record window or the Edit
Bibliographic  Record window, and inserts a picture subfield in field 996.
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Using the Message Utility
 
About Messages and  Block Types
You can attach one or more messages to a patron record so the messages appear whenever the patron
barcode is entered. Similarly, you can attach messages to an item record that appear each time the item’s
barcode is entered.
 
When attaching a message to a record, the attacher must also assign a block type to the attachment.
The four block types are:
 

•     Information Blocks – When an information block message appears, the user can bypass the
message by clicking anywhere on the Circulation window. This is the least intrusive block type.
 
•     Blocking Blocks – When a blocking block message appears, the user must select an option in
the message dialog box in order to proceed.
 
•     Nudge Blocks – When a nudge block message appears for the first time, the user must select
an option in the dialog box in order to proceed, as with a blocking block message. Any time this
message appears again with this record, it acts as an information block (no decision required to
bypass).
 
•     Privilege Blocks – When a privilege block message appears, a password is required to bypass
the message dialog box. This is the most intrusive block type.

 
 
Adding Messages to  the  Circulation System
As part of the initial circulation setup, a bank of patron and item messages appro- priate for your library
should have been defined. You can add, edit, and delete mes- sages within the bank at any time.
 
Generally, when you want to modify your message bank, you use the Messages utility on the Tools
menu. However, if you need to create or edit a message while conducting a circulation transaction, you
can also access and modify the message bank “on the fly.”
 
Both options are described in the following sections.
 
Creating a Bank of Patron and Item Messages
To add messages to the bank when not conducting a transaction:
 
1.      On the Tools menu, click Messages. This displays the Add/Edit Messages window (Figure 5.53). If
no messages have been added at your library, this window is empty.
 
FIGURE 5.53
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2.      Click Patron or Item, depending on the type of messages you want to add.
 
3.      Click New. This displays the Add New Message dialog box (Figure 5.54).
 
FIGURE 5.54

 
Tip: General messages provide greater flexibility.
 
4.      Type the message, then click OK. Your new message appears in the Add/ Edit Messages window.
 
 
5.      Repeat steps 3 and 4 for each message you want to include. After adding several messages, the
Add/Edit Messages window looks similar to the example in Figure 5.55.
 
FIGURE 5.55



 
Using the Message Utility

© 2014 Mandarin Library Automation, Inc. All rights reserved.
189 of 361

 
Note:  Only messages not in use  can be deleted.
 
6.      When finished, click Cancel.
 
Deleting a Message  from the System
To delete a message from the circulation message bank:
 
1.      On the Tools menu, click Messages. This displays the Add/Edit Messages window (Figure 5.55).
 
2.      Click the message type you want to delete, Patron or Item.
 
3.      Select the message you want to delete, then click Delete. Repeat this step for each message you
want to delete.
 
NOTE: If Delete is not active, the selected message is attached to a record and cannot be deleted.
 
4.      When finished, click Cancel.
 
Attaching a Message to  a Patron Record
While conducting a circulation transaction, you can attach, create, and edit a patron message.
 
Attaching an Existing Message to a Record
1.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
2.      On the Patron menu, click Messages. This displays the Attach Message(s) to Patron window (Figure
5.56), listing all available patron messages.
 
FIGURE 5.56
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3.      From here, do one of the following:
 

•     If the list includes any appropriate messages:
 
A.     Select all desired messages, then click Accept. This displays the Patron Messages window
(Figure 5.57).

 
FIGURE 5.57

 
If this patron already has messages attached, the Patron Messages window (Figure 5.57) lists all attached messages. Click Attach 
to attach a different message, or Detach  to detach this message.
 

B.     Select a block type in the Block Type list. Do this for each selected message. (Block types are
defined on page 5-41.)
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C.     When finished, click Accept. The attached messages (as shown in Figure 5.58) appear
whenever this patron record is accessed from M3 Circulation.
 

FIGURE 5.58

 
This procedure assumes you are working with a patron message; however, the procedure also works for item messages.
 

•     If the message you need does not appear in the list, follow the proce- dure in the next
section, “Creating a Message “On the Fly”.”
 
•     If a similar message exists that you want to edit before attaching, follow the
procedure in “Editing a Message “On the Fly”” on
page 5-46.
 

NOTE: If you edit a message that is attached to other records, the edited version displays for all records.
 
Creating a Message  “On the Fly”
If you are conducting  a circulation transaction and the message you want to attach does not exist in
the message bank, you can create the new message during the transaction, or “on the fly.” To do so:
 
1.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
2.      On the Patron menu, click Messages. This displays the Attach Message(s) to Patron window (Figure
5.56).
 
3.      Click New. This displays the Add New Message dialog box (Figure 5.59).
 
FIGURE 5.59

 



 
Using the Message Utility

© 2014 Mandarin Library Automation, Inc. All rights reserved.
192 of 361

4.      Type the message, then click OK. The new message appears in the Attach Message(s) to Patron
window (Figure 5.60).
 
FIGURE 5.60

 
5.      If you are satisfied with the message, click Accept. This displays the Patron Messages window
(Figure 5.57).
 
6.      Select the new message, then click a block type in the Block Type list.
 
7.      When finished, click Accept. The attached message (as shown in Figure 5.58) appears whenever
this patron record is accessed from M3 Circulation.
 
Editing  a Message  “On the Fly”
If you are conducting a library transaction and the message you want to attach requires editing, you
can do so during the transaction, or “on the fly.” To do so:
 
1.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
2.      On the Patron menu, click Messages. This displays the Attach Message(s) to Patron window (Figure
5.60).
 
3.      Select the message you want to edit, then click Edit. This displays the Edit Message dialog box
(Figure 5.61) with the selected message displayed.
 
FIGURE 5.61
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4.      Edit the message as desired, then click OK.
 
5.      Your edited message appears in the Attach Message(s) to Patron window (Figure 5.62).
 
FIGURE 5.62

 
 
6.      If satisfied with the message, click Accept. This displays the Patron Mes- sages window (Figure
5.57).
 
7.      Select the new message, then click a block type in the Block Type list.
 
8.      When finished, click Accept. The attached message (as shown in Figure 5.58) appears whenever
this patron record is accessed from M3 Circulation.
 
Attaching a Message to  an  Item Record
While conducting a circulation transaction, you can attach, create, and edit an item message. The
procedure to attach a message to an item record is similar to the procedure for patron records; only the
access path and window names are dif- ferent.
 
To attach a message to an item record:
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1.      In the Barcode box, type the item barcode, and then press ENTER (or scan the item’s barcode).
 
2.      On the Item menu, click Messages. This displays the Attach Message(s)  to Item window (Figure
5.63), listing all available item messages.
 
FIGURE 5.63

 
 
3.      From here, do one of the following:
 

•     If the list includes any appropriate messages:
 
A.     Select the desired messages, then click Accept. This displays the Item Messages window
(Figure 5.64).

 
FIGURE 5.64
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If this item already has messages attached, the Item Messages window (Figure 5.64) lists all attached messages. Click Attach  to
attach a different message, or Detach  to detach this message.
 

B.     Select a block type in the Block Type list. Do this for each selected message. (Block types are
defined on page 5-41.)
 
C.     When finished, click Accept. The attached messages (as shown in Figure 5.58) appear
whenever this item record is accessed from M3 Circulation.
 

•     If the message you need does not appear in the list, follow the proce- dure in
“Creating a Message “On the Fly”” on page 5-45.
 
 
•     If a similar message exists that you want to edit before attaching, follow the
procedure in “Editing a Message “On the Fly”.

 
NOTE: If you edit a message that is attached to other records, the edited version displays for all records.
 
Detaching a Message
If a message displays after you enter a patron or item barcode, you can detach the message during the
transaction. To do so:
 
1.      Close the message. On the Patron or Item menu (depending  on which type of record the message is
attached to), click Messages. This displays the Item Messages or Patron Messages window (Figure 5.65),
 
FIGURE 5.65
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2.      Select the message you want to detach, and then click Detach.
 
3.      Click Accept. This detaches the message.
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Modifying Library Dates and Circulation Periods
 
After your library’s circulation calendar is set up, you can modify it for special cir- cumstances. For
example, you can backdate the circulation date, which is helpful if you have an evening bookdrop. You
can also change the loan expiration date for circumstances when you want to temporarily override the
typical loan period. The following sections explain how to establish your library schedules, then tempo-
rarily revise the setup to accommodate  backdating and date changes.
 
System Schedule Setup
When you install M3 Circulation, you should set up your library’s system schedule. You can set up multiple
schedules to accommodate different times of the year. For example, your summer schedule may differ
from the rest of the year.
 
To set up your library circulation schedule:
 
On the Tools menu, click Schedule. This displays the Circulation Schedule window (Figure 5.66). Enter
the appropriate information in each tab as described in the following sections.
 
FIGURE 5.66

 
 
General Tab
In this tab (shown in Figure 5.66), establish general loan period rules.
 
1.      In the upper group, click the Due Time option appropriate for your library.
 
2.      In the lower group, click the option appropriate for your library.
 
3.      When finished, click OK.
 
 
Schedule Tab
In this tab (Figure 5.67), establish your library’s opening and closing day for each day of the week. You
can create multiple schedules to apply to different times of the year.
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FIGURE 5.67

 
 
1.      In the Period group, specify this schedule’s starting date in the From box. To do so:
 

•     Select the date, then type the new date in MM/DD/YY format.
 
OR
 
•     Click the Calendar arrow to display a calendar (Figure 5.68). Click the calendar’s left (<) and
right (>) arrows to select a month, then click the desired date. The date appears in the From box.

 
FIGURE 5.68

 
2.      Repeat step 1 for the To box.
 
3.      In the Day group, click the Mon arrow, and then click Open or Closed. Repeat for all days of the
week.
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4.      In the Circulation Hours group, select the Start Time and End Time for each day of the week. To do
so, click a time box, then click the adjoining arrows to select a time. Repeat this for each box until the
correct times display for each day of the week.
 
NOTE: If you want to create an additional schedule,  wait until you have completed the Holidays &  Exceptions tab and the Global
Recalls tab for this schedule.
 
5.      When finished, click OK.
 
Holidays & Exceptions Tab
In this tab (Figure 5.69), eliminate or add irregular dates within the schedule you created in the
Schedule tab.
 
FIGURE 5.69

 
1.      In the Holidays & Exceptions tab, click Add. This activates a line.
 
2.      In this line, enter information for the exception date as follows:
 

A.     Select  the R check box if this exception date should repeat every year. This would be
appropriate for holidays that always occur on the same date each year, such as New Year’s Day.
 
B.     In the date box in the Date & Status group, enter the exception date. To do so, select the
date, then type the new date using MM/DD/YY format. Or, click the Calendar arrow (shown in
Figure 5.69) to display a calendar. Click the calendar’s left (<) and right (>) arrows to select a
month, then click the desired date. The date appears in the box.
 
C.     In the box beside the date box, click Open or Closed to indicate whether the library is open
or closed on the date entered in step B.
 
D.     If you clicked Open in step C, enter the Start Time and End Time for this exception day.
Follow the procedure in step 4 page 5-52. If you clicked Closed in step C, no times can be
entered.
 
E.     In the Description box, type any information necessary to clarify this exception date.
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3.      To enter more dates, click Add and repeat step 2.
 
4.      When finished, click OK.
 
 
Global Recalls Tab
In this tab (Figure 5.70), specify the date all items have to be back in the library, such as the end of a
school term or an inventory date.
 
FIGURE 5.70

 
1.      In the Global Recalls tab, click Add. This activates a line.
 
2.      In this line, enter information for the closing date as follows:

A.     Select the R check box if this closing date should repeat every year.
 
B.     In the Recall Dates group, enter the closing date. To do so, select the date, then type the new
date using MM/DD/YY format. Or, click the Calendar arrow (shown in Figure 5.70) to display
a calendar. Click the calendar’s left (<) and right (>) arrows to select a month, then click the
desired date. The date appears in the box.
 
C.     In the Description box, type any text necessary to clarify this closing date.

 
3.      To enter more dates, click Add and repeat step 2.
 
4.      When finished, click OK.
 
5.      If you want to add another circulation period (such as a “summer hours” schedule), repeat the
procedures for the Schedule, Holidays & Exceptions, and Global Recalls tabs beginning  with “Schedule  Tab”
on page 5-51.
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Temporarily Backdating the  Library System Calendar Occasionally, the circulation desk needs to
backdate the system calendar to pro- cess a return. This is standard practice for libraries with evening
bookdrops.
 
There are two ways to backdate the system calendar; one is through the menu bar, and the other is
through a right-click procedure.
 
To backdate the system calendar:
 
1.      On the toolbar, click Return.
 
2.      On the Tools menu, click Backdate. This displays the Calendar dialog box with today’s system date
highlighted (Figure 5.71).
OR
 
In the Circulation window, right-click today’s system date on the status bar. This displays the Calendar
dialog box with today’s system date high- lighted (Figure 5.71).
 
FIGURE 5.71

 
After this change date transaction is completed, the date automatically returns  to the default loan expiration  date.
 
3.      Click the desired earlier day. If you need to select a day in the previous month, click the left (<) arrow
to select a month, then click the desired day.
 
4.      Click Backdate. The system date on the Circulation window status bar changes to the earlier date
you selected.
 
5.      Enter all the item barcodes that you want to return based on this revised system date.
 
6.      To return the system to today’s date:
 

•     On the Tools menu, click Backdate. When the calendar displays, click System Date.
 
OR
 
•     In the Circulation window, right-click the system date on the status bar. In the Calendar
dialog box, click System Date.
OR
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•     Click a different transaction mode on the toolbar.
 

Temporarily Changing the  Loan Expiration Date
Occasionally, the circulation desk needs to make the default loan period shorter or longer. For example,
the default loan period may be too short for someone travel- ling out of town, or too long when you
know the item will soon be needed for a special project.
 
To change the loan expiration date:
 
1.      On the toolbar, click Loan.
 
2.      In the Barcode box, type the patron barcode, and then press ENTER (or scan the code).
 
3.      In the Barcode box, type the item barcode, and then press ENTER (or scan the code). If multiple items
are involved, enter the barcode for each item. This processes the loan transactions based on the default
loan period. The items on loan appear in the Transactions pane. You now need to revise the expiration
date.
 
4.      In the Transactions pane, select the check box or boxes corresponding to the items you just loaned.
Right-click an item to display a transaction menu.
 
5.      Click Change Date. This displays a calendar.
 
6.      Click the desired expiration date. If you need to select a day in the next month, click the right (>)
arrow to select a month, and then click the expi- ration date.
 
7.      Click OK. The revised expiration date appears in the Transactions pane.
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Using the Transactions Report Utility
 
M3 Circulation provides transaction reports to monitor your library status and activity. These reports
are discussed in the following section, “Viewing, Sorting, and Printing Circ Reports.” (More system
reports are available through the report generator; see page 7-1.)
 
Viewing, Sorting, and  Printing Circ  Reports
1.      On the Mode menu, click Library Transactions. This displays a listing of all transactions in the
Transactions pane except returns for the current circu- lation period (as defined in your system’s
Schedule tab; see “Schedule Tab” on page 5-51).
 
FIGURE 5.72

 
2.      From here, your options are:
 

•     To view the patron and/or item information related to one of the listed transactions, double-
click the transaction in the Transactions pane. This displays any relevant patron or item
information in the two upper panes.

To return to the full transaction list, click List All on the command menu.
 
 
FIGURE 5.73
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To return to the full transac- tion list, click List All on the command menu.

•     To switch the view in the Transactions pane between all transactions, patron transactions,
and item transactions, double-click a transaction in the Transactions pane. Then click the
Display button (shown in Figure 5.72) until the desired transaction type displays. A “head”
icon on the Display button represents patron transactions; a “book spine” icon represents item
transactions; and no icon represents  all transac- tions.
 
•     To limit the displayed transactions to today’s data, right-click in the Transactions pane. This
opens a command menu (Figure 5.73) with sorting and other commands. Click the sort option
that suits your needs: Today’s All, Today’s Fines, Today’s Loans, Today’s Holds, Today’s Bookings, or
Today’s Reserves.
 
•     To sort transactions by transaction type or a time period, click Select Transactions on the
command menu (Figure 5.73). In the Select Trans- actions dialog box (Figure 5.74), click a
transaction type and a time period, and then click OK.

 
FIGURE 5.74

 
To send e-mail notifications to patrons with fines or overdue items, see “Sending E-mail Notifications for Fines  and Overdue
Items” on page 5-19.
 

•     To print the transactions listed in the Transactions pane, click Print on the command menu
(Figure 5.73). If a Print dialog box displays, change the settings if desired, and then click OK.
 
•     To configure which information displays and how it displays in the Transactions pane while
in the Library Transactions mode, click Design Mode on the command menu (Figure 5.73). This
procedure is explained in “Modifying the Transactions Pane for Library Transactions”
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Using the Tricoder to Conduct Transactions
 
Note: The following instructions  describe the scanning procedure using  a Worthington TriCoderTM.  If you are using  a different
  type of scanner, your  procedure may differ.
 
Note: You can also type the patron and/or item barcodes into the TriCoder; be sure to press ENTER on the TriCoder between each
barcode.
 
You may want to conduct transactions using a portable scanning device such as a TriCoder. This
is useful when your main M3 Circulation system is not available, such as while working from a
bookmobile.
 
This procedure includes scanning the patron and/or item barcodes using the Tri- Coder, then uploading
them into Circulation. You can scan and upload barcodes for only one transaction mode at a time
(unless you use the Transaction Barcodes sheet; see “Using the Transaction Barcodes Sheet” on page
5-58).
 
Scanning Barcodes
1.      On the TriCoder, press ON, then press any key.
 
2.      At the data collection prompt, press YES.
 
3.      At the program number prompt, press 0.
 
4.      Scan the patron and/or item barcodes.
 

•     If you are conducting a loan or reserve transaction, scan the patron barcode and then scan
the item barcodes. Repeat for each transaction you are conducting.
 
•     If you are conducting a return or renew transaction, scan the item bar- codes only.

 
5.      Press END. You are now ready to upload the data into Circulation.
 
Uploading Data
1.      Connect the TriCoder to your Circulation workstation.
 
2.      In Circulation, click the toolbar button corresponding to the type of trans- action you are
conducting (Loan, Return, Renew, or Reserve).
 
3.      On the Tools menu, click Upload Transactions. This displays the Upload Transactions dialog box
(Figure 5.75).
 
FIGURE 5.75
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4.      Click in the text box.
 
5.      On the TriCoder, press NO at the data collection prompt, then press YES at the data upload
prompt.
 
6.      The barcodes display in the Upload Transactions dialog box. Click OK to upload the transactions
to the database.
 
7.      When the upload process is complete, a message displays confirming a successful upload or
alerting you to errors that occurred  during the upload procedure.
 
 
NOTE: If an error message displays, click View Upload Log on the Help menu. This displays a log identifying the errors (as shown
in the example in Figure 5.76).
 
FIGURE 5.76

 
 
Using the  Transaction Barcodes Sheet
Included with your M3 documentation is a laminated sheet titled Transaction Barcodes. You can use
this barcode sheet to conduct transactions using a TriCoder.
 
1.   Follow steps 1 through 3 in “Scanning Barcodes” on page 5-57.
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2.      Scan the desired transaction mode barcode on the Transaction Barcodes sheet (Loan Mode, Return
Mode, and so on).
 
3.   Scan the patron and/or item barcodes.
 

•     If you are conducting a loan or reserve transaction, scan the patron barcode and then scan
the item barcodes. Repeat for each transaction you are conducting in the current mode.
 
•     If you are conducting a return or renew transaction, scan the item bar- codes only.

 
4.   Repeat steps 2 and 3 as desired.
 
5.   Press END.
 
6.   Connect the TriCoder to your Circulation workstation.
 
7.   In Circulation, click any toolbar button.
 
8.   Upload the data into Circulation. To do so, follow steps 3 through 7 in “Uploading Data”
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Modifying Circulation Window Displays
 
FIGURE 5.77

 
Tip: If a grid  does not display in the Patron  pane, right-click in the pane, then click Show Grid.
 
You can modify the MARC fields and font characteristics that display in the Circu- lation window. You can
also configure different displays for each transaction mode (Loan, Return, Renew, Reserve, and Status)
in each pane (Patron, Item, Transac- tions). M3 Circulation includes default settings for all of these
situations, but you can reconfigure as appropriate for your library.
 
Modifying the  Patron Pane Display
1.      Click the toolbar button corresponding to the transaction mode to be mod- ified (Loan, Return,
Renew, Reserve, or Status). Changes made to one mode will not apply to the other modes; you must
modify each mode individu- ally.
 
2.   Right-click in the Patron pane. This opens a command menu (Figure 5.9).
 
3.      Click Design Mode. This changes the Patron pane to the Design mode, with information displaying
in data cells (Figure 5.77).
 
4.      To create a new cell, click where you want the cell in the Patron pane, then drag to the desired
size. This displays the New Cell dialog box (Figure 5.78).
 
FIGURE 5.78
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FIGURE 5.79

 
Tips:
• When selected, a cell appears with a yellow back- ground.
• To resize a cell, drag the box in the lower right  corner of the cell to the desired  size.
• To move a cell, drag it to the desired location. If it is part of a group  of cells (displaying in blue), this  moves the entire group.
 
Tip: You can also double-click a cell to display the Properties dialog box.
 
Tip: You can create a group of cells by pressing CTRL  and dragging  the mouse to select the desired cells. Cells in a group appear
outlined in blue. Groups allow you to cut, copy, paste, delete, and align multiple  cells. You can ungroup  a group of cells by
clicking  outside of the group.
 
5.      Click the type of cell you want to create, then click OK.
 
6.      To modify cells, right-click a cell or group of cells. This opens a command menu (Figure 5.79).
 
Several of the options in this menu are explained here:
 

•     Properties – Depending on the type of cell you select (label cell, data- base field cell, or
graphic cell), a Properties dialog box appears. See the following three sections, “Modifying a
Label (Text) Cell,” “Modi- fying a Database Field Cell,” and “Modifying a Graphic Cell” for
instructions on modifying each cell type.
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•     Send To Front and Send To Back – If cells are overlapping, select a cell and click one of these
options to send the cell to the front or back of the overlapping cells.
 
•     Select All – Creates a group of all cells, including any cells that are out of view. Use the
scroll bar to view all cells.
 
•     Cut Cell and Cut Group – Deletes the cells from the display and stores it on the clipboard.
 
•     Copy Group – If you use this option to copy a group, then click Paste, the new group is
pasted on top of the original group. You can then drag the new cells to a new location.
 
•     Paste – Pastes the last cut or copy operation. To paste multiple cells, create a group, click
Copy Group, and then click Paste.
 
•     Move Left to Grid – Aligns the selected cell with the grid line to the left of the cell.
 
•     Move Up to Grid  – Aligns the selected cell with the grid line directly above the cell.
 
•     Align Group Vertically  – Vertically aligns the group with the selected cell.
 
•     Align Group Horizontally – Horizontally aligns the group with the selected cell.
 

7.      When finished modifying the display, right-click in the Patron pane. In the command menu, click
Save.
 
8.      Right-click again in the Patron pane. In the command menu, click Exit Design Mode. This exits the
Design mode.
 
Modifying a Label (Text) Cell
To make changes in the Label Properties dialog box (Figure 5.80):
 
FIGURE 5.80

 
 
1.      In the Label box, type any new text you want to display in the cell.
 
2.      To change the background color of the cell, click Change Background Color. This displays the Color
dialog box. Choose a color, then click OK.
 
3.      To make the cell and its contents invisible in Display mode, clear the Visible check box.



 
Modifying Circulation Window Displays

© 2014 Mandarin Library Automation, Inc. All rights reserved.
212 of 361

 
4.      In the Alignment group, select the desired text alignment.
 
5.      If you want the text to wrap to the next line if it is too long to display in the cell, select the Line
Wrap check box. NOTE: You may need to increase the height of the cell to make the wrapped text
visible.
 
6.      To change the font, click Change Font. This displays the Font dialog box. Change settings as
desired, then click OK.
 
7.      When finished, click OK.
 
Modifying a Database  Field Cell
To make changes in the Field Properties dialog box (Figure 5.81):
 
FIGURE 5.81

 
The Contents  box displays items in the order they appear in the cell. To change the order,  select an item and click Move Up or
Move Down.
 
1.      To add a field to a cell, click Add Field. This displays  the Select Database Field dialog box (Figure
5.82).
 
FIGURE 5.82
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2.      To make changes in this dialog box:
 

A.     In the Table list, select the table containing the data you want to display. B.     In the Field
list, select the record field you want to display.
C.     In the Display As group, select the format in which you want the field to display.
D.     If the field is repeatable, select an option in the Repeatable  Field group. E.     When finished,
click OK. This returns you to the Field Properties dialog box (Figure 5.81).

 
3.      To add text to the cell, click Add Text. This displays the Add Text dialog box. Type the text you
want to display, then click OK.
 
4.      To make the cell and its contents invisible in Display mode, clear the Visible check box.
 
Tip: You can also double-click the item to display  the Select Database Field dialog box.

5.      To edit an item, select the item in the Contents box, then click Edit Item. This displays the Select
Database Field dialog box (Figure 5.82). To make changes, follow the procedure explained in step 2.
 
6.      To format an item, select the item in the Contents box, then click Format Item. This displays a Format
dialog box corresponding to the format you selected in step 2C. Make changes as desired, then click OK.
 
7.      To remove an item from the cell:
 

•     To remove one item, select the item in the Contents box, then click Remove Item. This
removes the item.
 
•     To remove all items, click Remove All. This removes all items and places an “Undefined
Field” entry in the cell.

 
8.      In the Alignment group, select the desired text alignment.
 
9.      To make the text wrap to the next line if it is too long to display in the cell, select the Line Wrap
check box.
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10. To change the font, click Change Font. This displays the Font dialog box. Change settings as desired,
then click OK.
 
11. In the Multiple Items group, indicate how you want to separate multiple items in this cell.
 
12. To change the background color of the cell, click Change Background Color. This displays the Color
dialog box. Select a color, then click OK.
 
13. When finished, click OK.
 
Modifying a Graphic  Cell
To make changes in the Picture Properties dialog box (Figure 5.83):
 
FIGURE 5.83

 
1.      In the Picture Location group, click Database or External File.
 

•     If you choose Database, select the table containing the data you want to display in the Table
list, then select the field you want to display in the Field list.
 
•     If you choose External File, click Select File. This displays the Open dialog box. Navigate to
the location of the file you want to open, then click Open. This displays the path and file name in
the Picture Proper- ties dialog box, as shown in Figure 5.84.

 
FIGURE 5.84
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FIGURE 5.85

 
Tip: If a grid  does not display in the Item pane, right-click in the pane, then click Show Grid.
 
 
2.      To make the image invisible in Display mode, clear the Visible check box.
 
3.      If you want the image to fit the dimensions of the cell, select the Shrink/ Stretch the image to fit the
cell check box. NOTE: If the image is larger than the cell and you do not select this check box, only a
portion of the image will appear in the cell.
 
4.      When finished, click OK.
 
Modifying the  Item Pane Display
1.      Click the toolbar button corresponding to the transaction mode to be mod- ified (Loan, Return,
Renew, Reserve, or Status). Changes made to one mode will not apply to the other modes; you must
modify each mode individually.
 
2.      Right-click in the Item pane. This opens a command menu (Figure 5.9).
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3.      Click Design Mode. This changes the Item pane to the Design mode, with data displaying in cells
(Figure 5.85).
 
 
4.      Follow steps 4 through 8 beginning on page 5-60 to modify the data dis- played in the Item pane,
substituting the word “item” for “patron” in the procedure.
 
Modifying the  Transactions Pane Display
There are three Transactions pane displays: Patron, Item, and Library Transac- tions. Each has a
different display configuration. This section explains how to modify the Patron and Item displays for
the Transactions pane. To modify the Library Transactions display, see “Modifying the Transactions
Pane for Library Transactions” on page 5-67.
 
To modify the Patron or Item displays for the Transactions pane:
 
1.      Click the toolbar button corresponding to the transaction mode to be mod- ified (Loan, Return, Renew,
Reserve, or Status).
 
2.      In the Barcode box, type the patron (or item) barcode, and then press ENTER (or scan the code).
 
3.      Right-click in the Transactions pane. This opens a command menu (Figure 5.10).
 
4.      Click Design Mode. This changes the Transactions pane to the Design mode and clears the pane.
 
5.      In the Transactions pane, right-click the column heading of the column you want to edit. This
opens a command menu (Figure 5.86).
 
FIGURE 5.86

 
Tip: You can also double-click the column  heading to open the Column Properties dialog box.
 
 
FIGURE 5.87
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6.      If you want to delete the column or insert a new column, click the appropriate command.
OR
 
If you want to revert to the default settings for the Transactions pane, click Load Default.
 
OR
 
If you want to edit the properties of the selected column, click Column Prop- erties. This displays the
Column Properties dialog box (Figure 5.87).
 
Edit the column properties as desired:
 

•     Display options – Each column has different display properties for bib- liographic items
and equipment items. Bibliographic display settings apply when the transaction involves a
bibliographic  item, and equip- ment display settings apply when the transaction involves an
equip- ment item. Therefore, you may want to click Bibliographic Display and select the settings
used for bibliographic  items, then click Equipment Display and select the settings used for
equipment items.
 
•     Header group – To establish display properties for the column header:
 
A.     In the Column Header box, type the column heading text.
 
B.     To change the font properties for the column data, click Font. This displays the Font dialog
box. Modify the font properties as desired, then click OK.
 
C.     Click a Text Alignment option to establish the text justification for the column header.
 

•     Join group – If the information in this cell should be joined with the information
displayed in the cell to the right (the information is com- bined and displays in the left
cell):

 
A.     Select the Join Cells check box.
 
B.     In the Separator box, type a space, comma, or any other text to separate the content of the
two cells.

•     Data group – To set up the data that displays in this column:
 
A.     In the Table list, select the table containing the data you want to display.
 
B.     In the Field list, select the record field you want to display.
 
C.     To change the font properties for the column data (as shown in the sample text in the Preview
box), click Font. This displays the Font dialog box. Modify the font properties as desired, then
click OK.
 
D.     Click a Text Alignment option to establish the text justification for data in the column.
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•     Format group – If the column data requires a consistent format, click an option (Date,
Numeric, Boolean), and then click the desired format in the corresponding list.

 
7.      When finished editing entries for this column, click OK.
 
8.      Repeat steps 5 through 7 for each column you want to modify in the Trans- actions pane.
 
9.      When finished, right-click in the Transactions pane. In the command menu (Figure 5.86), click Save
Configuration. (Or, to revert to the default settings for the Transactions pane, click Load Default.)
 
10. Repeat steps 1 through 9 for each transaction mode you want to modify in the Transactions pane.
 
11. When finished, right-click in the Transactions pane. In the command menu (Figure 5.86), click Exit
Design Mode. This exits the Design mode.
 
 
Modifying the  Transactions Pane for  Library Transactions
To modify the Library Transactions display for the Transactions pane:
 
1.      On the Mode menu, click Library Transactions.
 
2.      Right-click in the Transactions pane. This opens a command menu (Figure 5.73).
 
3.      Click Design Mode. This changes the Transactions pane to the Design mode and clears the pane.
 
4.      Follow the procedure in steps 5 through 11 beginning on page 5-65.
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Using the OPAC
 
This chapter provides instructions for searching your library’s databases and working with the search
results. It describes:
 
•     How to select an interface language
 
•     How to select databases and database types to search
 
•     How to conduct a Standard, Enhanced, and Visual Catalog search of your library’s holdings
 
•     How to determine item availability and location
 
•     How to work with search results in brief and expanded record formats
 
•     How to add records to the Bookbag
 
•     How to print and save records
 
•     How to use Shelf Browse
 
•     How to review your search session history and return to prior searches
 
•     How to use the My Account tab
 
•     How to use the Reset feature to reset defaults and clear the search history
 
•     How to use the Bulletin Board
 
•     How to modify the OPAC header
 
•     How to display cover images
 
•     How to customize the Visual Catalog interface using Configuration Mode
 
 
ABOUT THE  M3  OPAC
 
The M3 Online Public Access Catalog (OPAC) is a flexible, multilingual search interface that enables
the patron to search for records using three different search methods. The patron can then work with
the search results in a variety of brief and expanded record formats.
 
The three available search methods are:
 

•     Standard Search – A basic keyword search method that recognizes Boolean logic, truncation,
and phrase searches, and allows index browsing.
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•     Enhanced Search – A more advanced search method that offers search flexibility and
options. Patrons can enter simple or complex keyword search queries, and use index browsing.
 
 
•    Visual Catalog Search – An easy point-and-click graphical search method.
Patrons click colorful buttons to narrow their searches from broad topics to more defined sub-
topics, ultimately reaching search results.

 
The following five features enhance the patron’s search session.
 

•     The Bookbag allows a patron to set aside selected records throughout the course of the
search session for additional review or batch printing.
 
•     The Shelf Browse function quickly locates records with a call number sim- ilar to that of a
selected record. This is equivalent to looking at items to the left or right of a specific item on a
library shelf.
 
•    The History function keeps a cumulative list of Enhanced Search queries.
A time-saving AutoSearch feature lets you select a search in the list and return to that search
by clicking a button. To ensure privacy, a patron can clear this cumulative  list at any time.
 
•     The Reset feature deletes all information stored in the History, and returns all OPAC
settings to their default positions.
 
•     The Bulletin Board links to either a local HTML file or a World Wide Web address that your
library wants patrons to view.

 
Displaying the  M3  OPAC
To display the M3 OPAC correctly, set the resolution on your monitor to 800x600 or higher. If necessary,
refer to your Windows documentation for detailed instruc- tions.
 
 
STARTING THE  M3  OPAC
 
To start the M3 OPAC module:
 
Note: If you installed M3 v1.1 prior to installing v1.6, select SIRS Mandarin and then M3 (instead  of Mandarin M3).
 
On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click OPAC. This
displays the main M3 OPAC window (Figure 6.1).
 
 
OPAC WINDOW FEATURES
 
The default M3 OPAC window is shown in Figure 6.1. The main window consists of four distinct areas.
 
 
 
FIGURE  6.1
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•     Header bar – This area contains the Reset, Bulletin Board, and Help but- tons. The header can be
configured to display your library’s logo. For instructions, see “Modifying the OPAC Header” on page
6-30.
 
•     Function tabs – Five tabs allow you to move between different OPAC func- tions: Search, Results,
Bookbag, Databases, and My Account. Each tab is subdivided into two sections: a data pane on the left
and an option pane on the right.
 
•     Search tab (shown in Figure 6.1) – Select a search method and per- form a search.
 
•     Results tab – View and work with search results in brief and expanded record formats.
 
•     Bookbag tab – View and work with records added to the Bookbag.
 
•     Databases tab – Select the database type and databases to be searched.
 
•     My Account tab (optional) – View personal information and transac- tion history.
 
•     Data pane – Within each tab, this area displays information related to the selected tab.
 
 
•     Option pane – Within each tab, this area contains the option buttons appro- priate for the
information displayed in the data pane. Each tab includes a different set of option buttons.
 
 



 
Using the OPAC

© 2014 Mandarin Library Automation, Inc. All rights reserved.
222 of 361

SELECTING AN  INTERFACE LANGUAGE
 
The M3 OPAC allows patrons to select a language for the interface. Changing the interface language
affects screen elements such as names of windows, buttons, and text boxes; it does not change the
language of the information in the database.
 
To select a different interface language:
 
1.      On the Search tab, click Languages. This displays the Languages dialog box
(Figure 6.2).
 
FIGURE  6.2
 

 
 
2.      Select the interface language, then click OK. This changes  the interface language.
 
 
SELECTING A  DATABASE TO  SEARCH
 
Overview
Before beginning a search, you should always verify you are connected to the appropriate database type
and databases.
 
Two database types are predefined in the M3 OPAC. Your system administrator can add, modify, and
delete database types to suit your institution’s needs. The two predefined database types are:
 
•     Standard – Intended for standard catalog databases. The field labels and tag structure conform to
USMARC standards, as defined by the Library of Congress.
 
•     Equipment – Applicable for databases that contain equipment. Field labels and structure have been
modified to correspond to the needs of equipment databases.
 
NOTE: The M3 system is specifically designed to manage MARC records. All record types
(bibliographic, holdings, patrons, equipment, transaction, specialty databases) conform to a standard or
customized MARC record structure.
 
 
Databases Tab  Features
A sample Databases tab is shown in Figure 6.3.
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FIGURE  6.3

 
 

•     Database Type list – Lists the types of databases available to search. Each type has a
different MARC field structure. By default, standard (appro- priate for catalog databases) is
selected.
•     Available Databases  box – Lists the databases available to search.
 
•     Option buttons – The Apply/Cancel Changes buttons allow the patron to apply or cancel any
changes just made in the Databases tab. The other two buttons access menus with the following
options listed:

 
Reset Defaults options:
 

•     Revert To Application Defaults – Changes all M3 OPAC settings back to their default
positions,  including default search fields, formats, database selections in all database types,
and so on.
 
•     Revert To [selected database type] Defaults – Changes all settings for the selected database
type back to default positions.
 
•     Revert To Default Databases – For the selected database type, reverts back to the default
selection of databases.
 
•     Revert To Default Database Restrictions – Not applicable unless searching a centralized
(union) database.
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Tag options:
 
•     Tag/Untag All – Tags or untags all databases within the selected data- base type.
 
•     Tag/Untag Database Restrictions – Not applicable unless searching a centralized (union) database.
 
Selecting a Database
Before sending a search query, verify that you are connected to the appropriate database type and
databases. To do so:
 
1.      Click the Databases tab. A sample Databases tab is shown in Figure 6.4.
 
FIGURE  6.4

 
Tip: When several databases are available, click Tag  to access a shortcut menu.
 
2.      If you are already connected to the correct database type and databases, click the Search tab and
conduct your search as described in “Conducting a Standard Search” on page 6-7, “Conducting an
Enhanced Search” on page 6-10, or “Conducting a Visual Catalog Search” on page 6-15.
OR
If you are not connected to the appropriate database type and databases:

A.     In the Database  Type list, select the desired database type. Standard is appropriate
for catalog databases; equipment is appropriate for equipment databases. (Your system
administrator may have modified this list.)
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B.     In the Available Databases  box, select the check box by each database you want to search,
and clear the check box by each database you do not want to search. (Many institutions only
have one available data- base per database type.)
 
 
C.     Click Apply. This sends a connection query to each selected database.
 

NOTE: If you receive a warning message stating you deselected a data- base that still contains  search results in the Results tab:
 

•     Click No to go back and add any search results to the Bookbag.
 
OR
 
•     Click Yes to connect to the selected databases. This sends connecting queries to
the selected databases and deletes any search information in the Results tab. Any
information stored in the Bookbag or History are not deleted.

 
D.     Click the Search tab and conduct your search query as explained in “Conducting a Standard
Search” in the following section, “Conducting an Enhanced Search” on page 6-10, or “Conducting a
Visual Catalog Search” on page 6-15.
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Standard Search
 
Tip: The three default MARC record fields are indexes of multiple fields rather than single fields. For simplicity, this Users  Guide
refers to all of them as fields. Entries conform to Z39.50  use attribute standards.
 

FIGURE  6.5
 
The Standard Search method suits basic search needs; patrons are limited to key- word searches within
three specific MARC record fields. Boolean logic, truncation, and phrase searching are available to the
patron, as well as index browsing.
 
Standard Search Window Features
The default Search tab with Standard Search selected is shown in Figure 6.5. A
sample search has been entered; your window will be empty.
 
Search Tips:
• You can apply the trunca- tion asterisk (*) to the begin- ning and/or end of a keyword; the wildcard  question mark (?) character
within  a keyword (wom?n); and quotation marks (“ ”) around a phrase.
• You can use the AND, OR, and NOT Boolean operators to connect keywords within  a keyword box. Be sure to type operators in
capital letters.
 

•     MARC record fields  – Indicate the MARC record fields available for searching. (The default
fields and the fields included in the lists can be reconfigured by your system administrator.)
•     Keyword boxes – Allow the patron to enter keywords to search the selected
MARC record fields.
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•     Browse buttons – Display a list of all data currently contained in the selected MARC record
field. This allows patrons to select a search term from existing data, particularly useful to those
unsure of the search they want to enter. This search selection technique is known as Index
Browse.
 
•     Option buttons – The Languages button displays a list of available interface languages. The
Standard, Enhanced, and Visual buttons select the search method to be used.
 
•     Total box – Displays the number of records found matching the search query.
 
•     Function buttons – The Clear and Search buttons perform the following functions:

 
Clear – Erases any keywords entered in the keyword boxes and any results listed in the
Results tab.
 
Search – Submits the search query typed into the keyword boxes and, if matches are
found, automatically proceeds to the Results tab.

 
How  to  Search
This procedure assumes the appropriate interface language (see “Selecting an Interface Language”
on page 6-4) and the databases to be searched (see “Selecting a Database to Search” on page 6-4) are
already selected. To conduct a Standard Search of the selected databases:
 
1.      On the Search tab, click Standard. This displays the Standard Search window (Figure 6.5).
 
2.      Type your search query into one or more of the three keyword boxes, as shown in Figure 6.5. Each
box is labeled to indicate the MARC record field it searches. The two lower labels also indicate the
Boolean operator applied to the box below. (The default MARC record fields and Boolean operators can
be reconfigured by your system administrator.)
 
NOTE: You can also use the Index Browse technique to enter a search term. See “Using Index Browse in a Search Query” on page
6-12.
 
3.      Click Search. The Search Results window displays a list of search results
(Figure 6.6).
 
NOTE: If no matches are found, a Browse window (Figure 6.9) displays the indexed entries for the selected MARC field and takes
you to the closest alphabetical match for your keywords. Double-click a listing to enter it into the keyword box in the search
window, then click Search again.
 
FIGURE  6.6
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Note: The Cross-Reference box displays only if you are using  a version  of M3 that supports Authority Control and the search
term you entered is managed under Authority Control.
 
4.      See “Working with Search Results” on page 6-18 for more information on options within the
Results tab.
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Enhanced Search
 
The Enhanced Search method provides search flexibility. Patrons can enter simple or complex keyword
search queries, select the fields and Boolean operators for the search, and use index browsing.
 
Enhanced Search Window Features
The Search tab with the default fields of the Enhanced Search window displayed is shown in Figure 6.7.
 
FIGURE  6.7

 
Tip: Many entries in the MARC record field lists are indexes  of multiple fields rather than single fields. For simplicity, this Users
Guide refers to all of them as fields. Entries conform  to Z39.50 use attribute standards.
 

•     MARC record field lists – List the MARC record fields available for searching. (The default
fields and the fields listed here can be reconfigured by your system administrator.)
•     Keyword boxes – Allow the patron to enter keywords to search the selected
MARC record fields.
 
•     Boolean operator lists – List all Boolean operators available for patron use.
Each Boolean operator list applies to the keywords in the keyword box below it. (The
default operators and the operators included in the lists can be reconfigured by your system
administrator.)
 
•     Browse buttons – Display a list of all data currently contained in the selected MARC record
field. This allows patrons to select a search term from existing data, particularly useful to those
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unsure of the search they want to enter. This search selection technique is known as Index
Browse.
 
•     Option buttons – The Languages button displays a list of available interface languages. The
Standard, Enhanced, and Visual buttons select the search method to be used.
 

Search Tips:
• You can apply the trunca- tion asterisk (*) to the begin- ning and/or end of a keyword; the wildcard  question mark (?) character
within  a keyword (wom?n); and quotation marks (“ ”) around a phrase.
• You can use the AND, OR, and NOT Boolean operators to connect keywords within  a keyword box. Be sure to type operators in
capital letters.
 

•     Total box – Displays the number of records found matching the search query.
 
•     Function buttons – The Clear, History, Total, and Search buttons perform the following
functions:

 
Clear – Erases any keywords entered in the keyword boxes and any results listed in the Results tab.
 
History – Displays the History Selection dialog box (Figure 6.10), which lists all Enhanced Search
queries submitted by the patron during the cur- rent search session, along with the number of resulting
records. The patron can use the History function as a shortcut to return to a previous search. For more
information, see “Using the Search History” on
page 6-13.
 
Total – Submits the search query typed into the keyword boxes and dis- plays the number of records
found matching the search query in the Total box.
 
Search – Submits the search query typed into the keyword boxes and, if matches are found,
automatically proceeds to the Results tab.
 
How  to  Search
This procedure assumes the appropriate interface language (see “Selecting an Interface Language”
on page 6-4) and the databases to be searched (see “Selecting a Database to Search” on page 6-4) are
already selected. To conduct an Enhanced Search of the selected databases:
 
1.      On the Search tab, click Enhanced. This displays the Enhanced Search window (Figure 6.7).
 
2.      Type a search query into one or more of the three keyword boxes, as shown in Figure 6.8. To
use different MARC record fields or Boolean oper- ators, select a different field or operator from the
appropriate list.
 
NOTE: You can also use the Index Browse technique to enter a search term. See “Using Index Browse in a Search Query” on page
6-12.
 
 
 
FIGURE  6.8
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You can also click Total to determine how many records match your  search query. Use this feature to fine-tune the search query
before viewing the list of search results.
 
3.      Click Search. The Search Results window displays a list of search results (Figure 6.6).
 
NOTE: If no matches are found, a Browse window (Figure 6.9) displays the indexed entries for the selected MARC field and takes
you to the closest alphabetical match for your keywords. Double-click a listing to enter it into the keyword box in the search
window, then click Search again.
 
4.      See “Working with Search Results” on page 6-18 for more information on options in the Results
tab.
 
Using Index Browse in a Search Query
In addition to typing a keyword into a keyword box, a patron can review and select a search term from
existing field data. This is possible  because most MARC record fields have been indexed. A patron can
browse a field index (such as subject, title, or author) to make a search term selection. This is particularly
useful to patrons who are unsure of the search they want to enter.
 
The Index Browse feature can be used while entering a Standard or Enhanced Search query. An Index
Browse term can be entered into a keyword box by itself or along with typed keywords.
 
 
To use Index Browse:
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1.      In the Standard Search or Enhanced Search window, type a keyword in the appropriate keyword
box. In an Enhanced Search, you can select a MARC record field in the list above the box. Then click the
corresponding Browse button. This displays the indexed entries for the selected MARC field and takes
you to the closest alphabetical match for your keywords
(Figure 6.9).
 
NOTE: In an Enhanced Search, if the selected field is not indexed, and therefore cannot be browsed, the corresponding Browse button
is not available.
 
FIGURE  6.9

 
2.      If you are searching multiple databases and want to switch to a different database, select a
database in the Database list.
 
3.      Double-click a listing. This enters the listing into the keyword box in the search window.
 
NOTE: You can only enter one listing into each keyword box. You can type additional keywords into the same keyword box, if
desired.
 
4.      When finished entering your search query into one or more of the three keyword boxes, click
Search.
 
Using the  Search History
For convenience, a list of Enhanced Search queries accumulates during each patron’s Enhanced Search
session. (This feature is not included in the Standard or Visual Catalog search method.)
 
A patron can use the search history to return to a previous search query in the Search tab. This allows
the patron to fine-tune the query before accessing the Search Results window.
 
A patron can also use the search history to return to the Search Results window for any search listed in
the History Selection dialog box. The AutoSearch feature is used to accomplish this.
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A sample search history is shown in Figure 6.10.
 
FIGURE  6.10

 
As seen in this example, the search history includes the date and time of the search, the search query,
and the number of records resulting from the search.
 
Returning  to a Previous Search Query
To return to a previous Enhanced Search query:
 
1.      In the Enhanced Search window, click History. This displays the History Selection dialog box.
 
2.      Select the search you want to return to, then click OK. This displays the query in the Search tab.
 
Returning  to Previous Results
To return to a previous list of search results:
 
1.      In the Enhanced Search window, click History. This displays the History Selection dialog box.
 
2.      Select the AutoSearch check box.
 
3.      Select the search you want to return to, then click OK. This displays the previous list of search
results in the Search Results window. For details on working with the list of search results, see “Search
Results (Brief Records)” on page 6-18.
 
Deleting the Search History
For privacy, all information in the History Selection dialog box can be deleted. All information is deleted
automatically when the OPAC workstation times out after a designated time period of inactivity. (The
default time-out period can be reconfig- ured by your system administrator.)
 
To delete the history, use one of the following methods:
 
At any point in the search session, click Reset in the header bar. This deletes all information in the
History Selection dialog box and resets all workstation settings to the system default settings. Patrons
should be encouraged to click Reset before starting a search session and when ending a search session.
 
OR
 
1.      In the Enhanced Search window, click History. This displays the History
Selection dialog box (Figure 6.10).
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2.      Click Clear. This deletes all information in the History Selection dialog box.
It does not change any settings the patron has established during the search session.
 
 
Search History Interface Language
The M3 OPAC remembers which interface language was used during each Enhanced Search query. As
a result, when the search history function is used to return to a previous search, the interface always
displays in the same language as the original search.
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Visual Search
 
Visual Catalog Overview
The Visual Catalog search method provides patrons with an easy point-and-click graphical search
method. From a patron’s perspective, a search is just a click on a topic button and then a related
sub-topic button; this generates a list of search results. In actuality, it is a keyword search method
disguised behind a graphical interface; topic buttons are connected to query buttons, which are linked
to pre- defined search queries. A query button launches a search of the selected databases and returns
a list of results.
 
These graphical buttons can also be configured to launch other software applica- tions. Launcher buttons
are optional; you can add, modify, and delete them from the interface.
 
The simplicity of the Visual Catalog search method makes it ideal for novice researchers and those
unfamiliar with computers.  It should be noted that this design does not provide the type of search
flexibility found in the Standard and Enhanced keyword search methods, which contributes to its ease
of use.
 
The Visual Catalog interface is easily customized. Topics and their related search queries can be added,
modified, and deleted. The number of levels before a search results list appears can be reduced or
increased. Sound and visual effects can be changed and disabled. For details on these customizations and
more, see “Custom- izing the Visual Catalog” on page 6-32.
 
Visual Catalog Search Window Features
The Search tab with the default version of the Visual Catalog interface displayed is shown in Figure
6.11.
 
 
FIGURE  6.11
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Tip: Topic, query, and launcher buttons look the same. The result  of selecting them is what makes them different. A topic button
opens a sub-menu. A query button returns search results.  A launcher button opens another application or Web page.
 
How  to  Search
This procedure assumes that the appropriate  interface language (see “Selecting an Interface Language”
on page 6-4) and the databases to be searched (see “Selecting a Database to Search” on page 6-4) are
already selected. To conduct a Visual Cat- alog Search of the selected databases:
 
1.      On the Search tab, click Visual. This displays a button menu that can contain any combination of topic,
query, and launcher buttons. The default button menu (shown in Figure 6.11) consists of topic buttons.
 
2.      Click a topic button. Unless extra topic levels have been added to the default interface, this opens
a sub-menu of related query buttons, as shown in Figure 6.12 for the Animals topic.
 
FIGURE  6.12
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Tip: At the sub-menu level, the selected topic is listed at the top of the tab.
 
Tip: Two navigation buttons function as follows:
• Back returns to the previous button menu level.
• Start Over returns  to the first button menu level.
 
3.      Click a query button. This searches the selected databases, then displays the Search Results
window in the Results tab.
 
NOTE: The button menus shown in this procedure are based on the default buttons. Your Visual Catalog interface may have been
reconfigured to add or delete menu levels, to change the topic or query buttons, or to include launcher buttons.
 
4.      See the next section, “Working with Search Results,” for details on your options in the Results tab.
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Search Results
 
Search Results (Brief Records)
Once a search query is sent, the Results tab appears listing all items found matching the query. By
default, records appear in a brief record format, similar to the example shown in Figure 6.13.
 
FIGURE  6.13

 
 
Note: The Cross-Reference box displays  only if you are using  a version  of M3 that supports Authority Control and the
search term you entered is managed under Authority Control.
A patron can perform several functions from this window. These functions are described in the
following sections.
 
Using Cross-References
The Cross-Reference box displays links to more appropriate headings used by your library or related
headings that may also be useful. Click a “See” or “See also” link to view the search results for that
heading.
 
 
Determining Item Media Type
To determine the media type of an item listed in the search results, refer to Table 6.1. The media type
icon is shown beside the item. (Media type icons also appear in the Search Results Record Details
window and the Bookbag windows.)
 
TABLE 6.1
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Artifact

Book

Photo

Music
Cassette

Data CD

Movie

Electronic
Media

Journal

Library Kit

Map

Book on tape

Music CD

Sheet Music

Video
Recording

Online
Resource

 
Determining Item Availability
To determine each item’s availability, refer to the color of the Availability & Tagging
check box. Green represents available and red represents unavailable.
 
Changing the Record Format
To select a different format for the records displayed:
 
1.      Click Record Format. This displays the Record Format dialog box (Figure 6.14).
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FIGURE  6.14

 
Note: No duplicate listings are placed in the Bookbag.
 
Note:  To enable the printing of holdings  information, change the Print Holdings entry in the M3Opac.ini  file (located in your M3
direc- tory)  from  0 to 1, then restart the OPAC module.  Holdings will then  be listed in the printed item records.
 
2.      Select a record format, then click OK.
 
NOTE: If an expanded format is selected, the amount of information in a record may exceed the amount of space in the list of search
results. When this occurs, ellipses appear in the lower right corner of the box. To view the entire record, click Record Details.
 
Adding Records to the Bookbag
To add records to the Bookbag for later viewing or printing:
 
1.      If you want to add:
 

•    all records in the list, click Add To Bookbag, and then click Add All.
 
•     several records in the list, select the Availability and Tagging check box next to each record you
want to add. Click Add To Bookbag, then click Add Tagged.
 
•    the active record only, click Add To Bookbag, and then click Add Active.

 
2.      A message appears confirming the addition of the records to the Bookbag.
 
Printing Records
To print records from the Search Results or Bookbag Record List windows:
 
1.      If you want to print:
 

•    all records in the list, click Print, and then click Print All.
 
•     several records in the list, select the Availability and Tagging check box next to each record
you want to print. Click Print, then click Print Tagged.

 
•    the active record only, click Print, and then click Print Active.

 
2.      This displays the Print dialog box. Change settings if desired, then click OK.
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To print records from the Search Results Record Details or Bookbag Record Details windows, click Print
while viewing the record you want to print. This dis- plays the Print dialog box. Change settings if
desired, then click OK.
 
 
Tagging Records
The Tag button is a time-saving feature that allows you to select or deselect all records in the Search
Results or Bookbag Record List windows at once.
 

•     To tag all records in the list, click Tag, and then click Tag All.
 
•     To untag all records in the list, click Tag, and then click Untag All.

 
Sorting  Records
To sort the records displayed in the Search Results or Bookbag Record List win- dows by a different
sort formula:
 
1.      Click Sort. This displays the Sort Choices dialog box (Figure 6.15).
 
FIGURE  6.15

 
Note:  To enable the saving  of holdings information,  change the Save Holdings entry in the M3Opac.ini file (located in your M3
directory) from 0 to 1, then restart  the OPAC module. Holdings will then be listed in the saved RTF files.
 
2.      Select a sort formula, then click OK.
 
Saving Records to a File
To save records in the Search Results or Bookbag Record List windows to a file:
 
1.      If you want to save:
 

•     all records in the list, click Save, and then click Save All.
 
•     several records in the list, select the Availability and Tagging check box next to each record
you want to save. Click Save, then click Save Tagged.
 
•     the active record only, click Save, and then click Save Active.
 

2.      This displays the Save As dialog box. Navigate to the location where you want to save the records.
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3.      In the File name box, type a name for the file, and then click Save. This saves the records in rich
text format (RTF).
 
Accessing Record Details
To access more information about a specific brief record, including the expanded record and location of
items (copies) held by the library, see the next section, “Record Details (Expanded Records).”
 
Tip: You can also double-click the brief record to view the Search Results  Record Details window.
 
Record Details (Expanded Records)
To view details about a specific item including location, status information, and the expanded record:
 
1.      In the Search Results or Bookbag Record List windows, select the record you want to view.
 
2.      Click Record Details. This displays the Search Results Record Details or Bookbag Record Details
window (the Search Results Record Details is shown in Figure 6.16).
 
FIGURE  6.16

 
•     Holdings  box – Lists each copy of the item selected in the results list.
By default, this holding record information includes the location, call number, availability status,
and, if applicable, due date. (The default fields can be reconfigured by your system administrator.)
 
•     Expanded  Record box – Displays an expanded version of the biblio- graphic record
selected in the Search Results window, along with an availability check box and media type
icon. (Media type icons are defined on page 6-19.)
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•     Navigation buttons – Access other records in the list of Search Results: First – Displays the
first record in the list.
Previous – Displays the previous record in the list. Next – Displays the next record in the list.
Last – Displays the last record in the list.
 
 
•     Option buttons – These buttons in the Search Results Record Details window provide the
patron with a variety of options:

 
Record Format – Allows the patron to change the format for the record displayed in the Expanded
Record box.
 
Add To Bookbag – Adds the record to the Bookbag for later viewing or printing.
 
Print – Prints the record displayed in the tab.
 
Begin Shelf Browse – Allows the patron to conduct a Shelf Browse from the Search Results Record
Details. For more information, see the next section, “Using Shelf Browse.”
 
Back To Record List – Returns to the Search Results window.
 
Using Shelf Browse
Shelf Browse allows a patron to quickly find records with a call number similar to that of a selected
record. The patron can move one bibliographic record at a time forward or back. This is similar to looking
at items to the left or right of a selected item on a library shelf.
 
NOTE: The call number system used by your shelf browse option is established when your library
collection is indexed during system setup. To change to the other call number system, your collection
must be re-indexed.
 
To use Shelf Browse:
 
1.      In the Search Results Record Details window (Figure 6.16), click Begin
Shelf Browse. This changes the window to Shelf Browse mode
(Figure 6.17). Notice that the active call number for this record appears in the status bar.
 
FIGURE  6.17
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2.   From here, you have the following options:
 

•     To view the previous record “on the shelf,” click Previous.
 
•     To view the next record “on the shelf,” click Next.
 
•     To modify the format in which the record is displayed, click Record Format, select the
preferred format, and then click OK.
 
•     To add a record to the Bookbag, click Add To Bookbag.
 
•     To print the record, click Print.
 
•     To end this Shelf Browse session, click End Shelf Browse.
 
•     To return to the Search Results window, click Back To Record List.
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The Bookbag
 
During a search session, you may want to set aside promising records for addi- tional review or batch
printing. The Bookbag temporarily stores records during the search session. The Reset feature deletes
any records stored in the Bookbag.
 
Adding Records to  the  Bookbag
To add records to the Bookbag from the Search Results window, see “Adding Records to the Bookbag”
on page 6-20.
 
To add records to the Bookbag from the Search Results Record Details window, click Add To Bookbag.
 
Viewing and  Working with Bookbag Records
To view the records placed in the Bookbag during the active search session, click the Bookbag tab at any
time. A sample Bookbag tab is shown in Figure 6.18.
 
FIGURE  6.18

 
 
The option buttons provide the following options:
 
•     To display records listed in the Bookbag by a different format, click Record Format, and then select a
display format. For more information, see “Changing the Record Format” on page 6-20.
 

•     To remove records from the Bookbag, click Remove, and then select an option in the list.
 
•     To print records, follow the procedure in “Printing Records” on page 6-20.
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•     To tag or untag all records currently in the Bookbag, click Tag, and then select an option in
the list.
 
•     To sort the records listed in the Bookbag by a different sort formula, click Sort, and then
select a sort formula. For more information.
 

•     To save records to a file, follow the procedure in “Saving Records to a File”
 
•     To enter barcodes to create a list, follow the procedure in the next section, “Using the
Bookbag to Create a List.”
 
•     To view the record details for a selected record, click Record Details.

 
 
Note: This option must  be enabled in the M3Opac.ini file. For instructions, see “BOOKBAG SCREEN setting” on page A-2.
 
Using the  Bookbag to  Create a List
You can enter or scan barcodes into the Bookbag to create a list of items. To do so:
 
1.      If the Bookbag tab is not enabled, conduct a search for the first item in your list and add it to the
Bookbag.
 
2.      Click the Bookbag tab. This displays the Bookbag Record List window (Figure 6.18).
 
3.      Click Enter Barcode. This displays the Enter Barcode dialog box (Figure 6.19).
 
FIGURE  6.19

 
 
4.      Type or scan the barcode, then click Enter. Repeat for each item you want to add to the list.
 
5.      When finished, you can print or save the list. To do so, follow the proce- dure in “Printing Records”
on page 6-20 or “Saving Records to a File” on page 6-21.
 
 
USING THE  MY  ACCOUNT TAB  (OPTIONAL)
The My Account tab is an optional tab that your system administrator can activate if the library chooses
to use it. Once activated, patron access must be enabled in the Group Editor. Patrons may then view their
current transactions, past transac- tions, and personal information that is on record with the library.
 
Warning: The following information is only for the use of system administrators. If you do not
possess a comprehensive  understanding of configuration files, do not attempt to change the
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M3Opac.ini file. Improper proce- dures could affect the OPAC performance. Before you proceed,
it is suggested that you perform a complete  backup of your system.
 
Activating the  My  Account Tab
To activate the My Account tab:
 
1.      Using a simple text editor such as Notepad or WordPad, open the M3Opac.ini file (the default path
is C:\Program Files\Mandarin M3).
 
2.      Under  [PATRON  HISTORY SCREEN], change Patron_Tab_Visible=0 to Patron_Tab_Visible=1.
 
3.      When finished, save the file. The customized configuration becomes active the next time you start
the OPAC.
 
 
Allowing Patron Access to  the  My  Account Tab
To allow patrons access to this tab, you must enable the option in the Group Editor module. To so do:
 
1.      Start the Group Editor as explained in “Starting Group Editor” on page 3-3.
 
2.      In the Group Editor main window, select the patron group you want to grant access to the tab, and
then click Edit.
 
3.      In the OPAC Access tab:
 
A.     In the Access OPAC list, select Yes.
 
B.     Select the View Transactions check box.
 
4.      Click OK.
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My Account Tab
 
Using the  My  Account Tab
After the system administrator activates the My Account tab, the next time you start the OPAC, the
tab appears to the right of the Databases tab as shown in Figure 6.20.
 
FIGURE  6.20

 
 
To access your account:
 
1.      Click the My Account tab. This displays the My Login dialog box (Figure 6.21).
 
FIGURE  6.21



 
My Account Tab

© 2014 Mandarin Library Automation, Inc. All rights reserved.
249 of 361

 
Tip: Individual user IDs and passwords are assigned and modified in patron records. See “Working  with Patron Records”  on
page 5-33  for more information.
 
FIGURE  6.22

 
 
2.      In the Patron Barcode box, type the barcode from your library card. If your patron record has a
password assigned to it, type your password in the Password box (if not, no password is required). Then
click OK. This dis- plays the My Account tab with your transactions listed (Figure 6.22).
 
The option buttons provide the following options:
 

•     Current – View your open, or current, transactions.
 
•     Historical – View your closed, or historical, transactions.
 
•     My Info – View personal information that the library has on file for you, such as name,
address, and telephone number.
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The Reset Button
 
The Reset button in the OPAC header bar clears all information stored in the Search, Results, and
Bookbag tabs during a search session. It also returns all set- tings to their default positions.
 
Although the OPAC automatically resets after a few minutes without activity, it is a good idea to click
Reset before beginning a search session to clear any informa- tion from a previous user. Click it again
after completing a search session to ensure privacy.
 
The amount of elapsed time prior to an automatic reset can be modified by a system administrator. (See
“Appendix A: Customizing the Windows .ini Files” on page A-1.)
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The Bulletin Board
 
The Bulletin Board is a simple way for library administrators to deliver informa- tion to patrons. The
Bulletin Board button can be linked to a local HTML file or a Web page. A preconfigured  HTML file
(BulletinBoard.html) is included with M3 and can be modified using any HTML editor.
 
Many libraries use the Bulletin Board button to link to the library home page or pages containing
public service announcements. Because the button connects to a page created in HTML format, the
bulletin board can include graphics as well as text.
 
Using the  Preconfigured Bulletin Board
If the preconfigured Bulletin Board was not set up during M3 installation, it can be configured by a
system administrator at any time. To do so:
 
1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, select Utilities, and then
click Setup Bulletin Board.
 
2.      In the Choose Setup Language dialog box, select the desired language and click OK. This
determines the language of the Bulletin Board setup only.
 
3.      In the Welcome dialog box, click Next to begin the setup.
 
4.      In the Choose Destination Location dialog box, either:
 

•     Click Next to save the file BulletinBoard.html into the default folder location on your hard
disk (C:\Program Files\Mandarin M3).
OR
 
•     Click Browse and navigate to the desired folder location. When the desired folder has been
selected, click OK, and then click Next.

 
5.      In the Bulletin Board Configuration dialog box, type your library’s name, a greeting, and your library’s
hours in the appropriate boxes. Then click Next.
 
6.      Click Finish to complete the setup. This Bulletin Board can now be accessed by clicking the Bulletin
Board button in the OPAC window (example shown in Figure 6.23).
 
 
 
FIGURE  6.23
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Note:  To add text or graphics to this Bulletin Board,  open the file BulletinBoard.html (located in your M3 directory) in an HTML 
editor. Modify as desired.
 
Linking to  an  HTML File  or Web  Page
Configuring the Bulletin Board button to link to another HTML file or a Web page is performed in the
M3Opac.ini file.
 
These instructions are also outlined in “Bulletin Board settings” on page A-3 in “Appendix A:
Customizing the Windows .ini Files.”
 
1.      Using a simple text editor such as Notepad or WordPad, open the M3Opac.ini file (the default path
is C:\Program Files\Mandarin M3).
 
2.      Under Bulletin Board settings:
 

A.     Change Use_External_Browser=0 to Use_External_Browser=1.
 
B.     Change Source=LOCAL, where LOCAL is the path to the Web page you want to link to. For
example, Source= http://www.franklinhs.com/library

 
 
 

http://www.franklinhs.com/library
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The OPAC Header
 
Permission to modify  the OPAC header is established in the Group Editor  module. See your system administrator for assistance.
 
To display your library name in the header bar of the OPAC:
 
1.      Right-click in the header bar, then click Edit Name. This displays the Login dialog box.
 
2.      Type your user name in the Login Name box, your password in the Password
box, and then click OK. This displays the Edit Name dialog box
(Figure 6.24).
 
FIGURE  6.24

 
 
3.      In the Name box, type the name you want to display in the header bar.
 
4.      To change the font of the title, click Change Font. Modify settings as desired, then click OK.
 
5.      If you want a dividing line to appear between the header bar and the tabs, select  the Enable Line
Under Name check box. Otherwise, no line will display.
 
6.      Click OK. The new name displays in the header bar.
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Displaying Cover Image in the OPAC
 
To display cover images in the OPAC, you must import the images into your M3 database and enable
them in the M3Opac.ini file. The images can then be viewed in the OPAC in the Search Results, Record
Details, Bookbag Record List, and Bookbag Record Details windows.
 
Importing Cover Images
The M3 Picture Manager utility allows you to import multiple image files and auto- matically link the
images to the appropriate bibliographic records. This utility can be accessed through the Cataloging module.
For instructions, see “Using M3 Pic- ture Manager” beginning on page 4-49.
 
To add an image to one record at a time, see “Adding a Picture Field to a Biblio- graphic or Patron Record”
on page 5-38.
 
Enabling Cover Images
To enable the display of cover images in the OPAC:
 
1.      Using a simple text editor such as Notepad or WordPad, open the M3Opac.ini file (the default path is
C:\Program Files\Mandarin M3).
 
2.      In the entry Display Cover Images=0, change the 0 to 1.
 
3.      Save the file. This feature will be available the next time you start the OPAC.
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Customizing the Visual Catalog
 
Customization Overview
 
The Visual Catalog is a keyword search method disguised behind a graphical inter- face; topic buttons
are connected to query buttons, which are linked to predefined search queries. A query button launches
a search of the selected databases and returns a list of results.
 
These graphical buttons can also be configured to launch software applications or Web pages rather
than search databases. M3 ships with a default interface that includes several topic and query buttons.
M3 also includes over 75 images that can be displayed on the buttons; these can be found in the
VisualCatalogResources folder in your M3 directory.
 
Many Visual Catalog features are easily customized through a password-protected interface accessed
from this search method. This interface, Configuration Mode, categorizes  the Visual Catalog graphical
interface into the following main compo- nents:
 

•     Topic Component – A topic button that opens a sub-menu of additional buttons. The
resulting sub-menu might contain more topic buttons, query buttons, and/or launcher buttons.
 
•     Query Component – A query button linked to a search query, which launches a database
search and potentially returns a list of results.
 
•     Launcher Component – A launcher button that launches a software appli- cation or opens a
Web page.
 
•     Global Options – Options that globally alter the animation, sound, and visual properties on
all button menus.
 
Customization options available through Configuration Mode are:
 
•     Topic buttons can be added, modified, deleted, and moved at any menu level.
 
•     Query buttons can be added, modified, deleted, and moved at any menu level. Additionally,
the search query linked to a query button can be mod- ified.
 
•     Launcher buttons can be added, modified, deleted, and moved at any menu level.
 
•     Visual and sound effects can be globally changed and disabled.

 
All Configuration Mode customization options are explained in the following sec- tions. Other OPAC
customizations (such as printing details and reset timing) are entered in the M3Opac.ini file, and
should be performed by a system administrator.
 
Accessing Configuration Mode
To customize the Visual Catalog, you must access Configuration Mode. To do so:
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1.      Click the Search tab, then click Visual. This displays the Visual Catalog Search window (Figure
6.11).
 
2.      Right-click any open area of the data pane. This opens a menu (shown in Figure 6.25).
 
FIGURE  6.25

 
Tip: Individual user IDs and passwords are assigned and modified in patron records. See “Working  with Patron Records”  on
page 5-33  for more information.
 
3.      Click Enter Configuration Mode. This displays the Login dialog box.
 
4.      Type your user name in the Login Name box and your password in the Pass- word box. (If the
default name and password have not yet been changed, type admin in the Login Name box and boca
raton in the Password box, all in lower-case characters.) Then click OK. This changes  the Visual Catalog
interface to Configuration Mode, as identified in the tab heading (shown in Figure 6.26).
 
FIGURE  6.26



 
Customizing the Visual Catalog

© 2014 Mandarin Library Automation, Inc. All rights reserved.
257 of 361

 
Note: Only eight buttons can be placed on a Visual Catalog button menu. If the menu already contains eight buttons, you must 
delete one before you can add a new one.
 
Working with Topic Components
About Topic Components
A topic component consists of a topic button that opens a sub-menu of additional buttons. The sub-
menu can contain more topic buttons leading to more sub- menus, query buttons that launch database
searches, and/or launcher buttons that access different applications. You can add, modify, and delete a
topic component, and reposition a topic button. These procedures are covered in the following sec- tions.
 
Adding  a Topic Component
Adding a topic component consists of adding a topic button, and then adding the desired topic and/or
query and/or launcher buttons to the sub-menu attached to the new topic button. A topic component
can be added at any menu level.
 
To add a topic component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that is to receive the new topic button.
 
3.      Right-click any open area of the data pane. This opens a shortcut menu (Figure 6.27).
 
FIGURE  6.27
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4.      Click New Topic Component. This places a blank topic button on the button menu.
 
5.      Right-click the new topic button. This opens a button-specific menu (Figure 6.28).
 
FIGURE  6.28

 
 
6.      Click Modify. This displays the Component Configuration dialog box (Figure 6.29).
 
FIGURE  6.29

 
Tips:
• Entries are only required in the Language, Caption, and Image boxes.
• Use the Copy and Paste buttons  to create matching topics for a different interface language. This is explained in “Creating a
Matching Trans- lated Interface” .
 
7.      Complete the boxes in the dialog box to add text, sound, and visual prop- erties to the new button.
Press the TAB key to move from box to box.
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•     Language – Specify the interface language that applies to this new button. If you are offering
the OPAC in multiple interface languages, you need to enter a caption and description for
each language. (See “Creating a Matching Translated Interface” on page 6-48 for shortcut
instructions.)
 
•     Caption – Type the text you want to appear under the button. Keep it short or the text will
extend beyond the button frame.
 
•     Description – Type any descriptive text. This appears near the bottom of the button menu
when the mouse points to the button.
 
•     Flyby Sound – Select the sound that plays when the mouse points to the button. To select a
sound file, either type the path and file name, or click Change and navigate to the location of the
sound file.
 
 
•     Selected Sound – Select the sound that plays when you click the button. To select a sound file,
either type the path and file name, or click Change and navigate to the location of the sound file.
 
•     Image – Select the image that appears on the new button. To select an image file, either type
the path and file name, or click Change and nav- igate to the location of the image file.

 
8.      When finished, click OK. This applies the entries to the new topic button, but does not save those
entries. To save your entries, right-click any open area of the data pane, then click Save Changes.
 
9.      Click the new topic button. This displays the empty sub-menu linked to this button. The next step
is to add buttons to this sub-menu.
 
10. To add topic buttons (that will in turn create deeper levels), repeat steps
2 through 9 in this procedure. To add query buttons, see “Adding a Query Component” on page 6-38. To
add launcher buttons, see “Adding a Launcher Component” on page 6-42.
 
11. After completing all desired interface modifications, right-click any open area of the data pane, and
then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Modifying A Topic Component
A topic component can be modified to change the button caption, description, and visual or sound
effects.
 
To modify a topic component:
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1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the button to be modified.
 
3.      Right-click the topic button. This opens a button-specific menu (Figure 6.28).
 
4.      Click Modify. This displays the Component Configuration dialog box
(Figure 6.30) containing properties for this component.
 
FIGURE  6.30

 
 
5.      Modify any entries as needed. For information about these options, see step 7 in “Adding a Topic
Component” on page 6-35.
 
6.      When finished, click OK. This applies the changes to the topic button, but does not save those changes.
To save your changes, right-click any open area of the data pane, then click Save Changes.
 
7.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.
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Deleting a Topic Component
A topic component (button and the linked sub-menu system) can be deleted by simply deleting the topic
button.
 
To delete a topic component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the topic button to be deleted.
 
3.      Right-click the topic button. This opens a button-specific menu
(Figure 6.28).
 
4.      Click Delete. This deletes the topic component. If additional menu levels are connected below that
sub-menu, they are also deleted.
 
5.      To save your changes, right-click any open area of the data pane, and then click Save Changes.
 
Note: Only eight buttons can be placed on a Visual Catalog button menu. If the menu already contains eight buttons, you must 
delete one before you can add a new one.
 
6.      After completing all desired interface modifications, right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Moving a Topic Component
The procedure to reposition a topic button on the button menu is explained in
“Repositioning Buttons on a Button Menu” on page 6-45.
 
Working with Search Query Components
 
About Query Components
A query component consists of a query button and the search query linked to the button. When a query
button is clicked, the search query is sent, the Results tab becomes active, and the Search Results window
appears. You can add, modify, and delete a query component, and reposition a query button. These
procedures are covered in the following sections.
 
Adding  a Query Component
Adding a query component consists of adding a query button and defining the query linked to it.
 
To add a query component:
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1.   Access Configuration Mode as explained beginning on page 6-33.
 
2.   Go to the button menu that is to receive the new query button.
 
3.   Right-click any open area of the data pane. This opens a shortcut menu
(Figure 6.27).
 
4.      Click New Query Component. This places a blank query button on the button menu.
 
5.   Right-click the new query button. This opens a button-specific menu
(Figure 6.28).
 
6.   Click Modify. This displays the Component Configuration dialog box
(Figure 6.31).
 
FIGURE  6.31

 
7.      Complete the options in the dialog box to add text, sound, and visual prop- erties to the new button.
Press the TAB key to move from box to box. For information about these options, see step 7 on page 6-35.
 
8.      Click Edit Query. This displays the Edit Query Definition dialog box
(Figure 6.32).
 
FIGURE  6.32
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9.      Enter the search query you want this button to submit. To do so:
A.     In the first MARC record field list, select the field you want to search. B.     Type the search query
into the corresponding  keyword box, as shown
in Figure 6.33. The query can be a keyword or multiple keywords joined by Boolean operators AND,
OR, and NOT (AND is assumed if no Boolean is typed between keywords). The query recognizes trun-
cation, wildcard character, and phrase search techniques.
 
C.     If you want the query to include other MARC fields, repeat steps A and B in the remaining boxes
of this dialog box. Be sure to specify the correct Boolean operator between the sets of boxes.
 
FIGURE  6.33

 
 
D.     When finished, click OK. This closes the Edit Query Definition dialog box. The new query appears
above the Edit Query button in the Component Configuration dialog box (see Figure 6.34).
 
10. When finished, click OK. This applies the entries to the new query button, but does not save those
entries. To save your entries, right-click any open area of the data pane, then click Save Changes.
 
11. After completing all desired interface modifications, right-click any open area of the data pane, and
then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
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•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Modifying a Query Component
A query component can be modified to change the button caption, description, visual or sound effects,
and search query.
 
To modify an existing query component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the button to be modified.
 
3.      Right-click the query button. This opens a button-specific menu
(Figure 6.28).
 
4.      Click Modify. This displays the Component Configuration dialog box (Figure 6.34) containing
properties for this component.
 
FIGURE  6.34

 
 
5.      To modify text, sound, or visual properties,  see step 7 on page 6-35. To modify the search query,
see steps 8 and 9 in “Adding a Query Compo- nent,” beginning on page 6-39.
 
6.      When finished, click OK. This applies the changes to the query button, but does not save those
changes. To save your changes, right-click any open area of the data pane, then click Save Changes.
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7.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Deleting a Query Component
A query component (button and the linked search query) can be deleted by simply deleting the query
button.
 
To delete a query component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the query component to be deleted.
 
3.      Right-click the query button. This opens a button-specific menu (Figure 6.28).
 
4.      Click Delete. This deletes the query component.
 
5.      To save your changes, right-click any open area of the data pane, and then click Save Changes.
 
Note: Only eight buttons can be placed on a Visual Catalog button menu. If the menu already contains eight buttons, you must 
delete one before you can add a new one.
 
6.      After completing all desired interface modifications, right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Moving a Query Component
The procedure to reposition a query button on the button menu is explained in
“Repositioning Buttons on a Button Menu” on page 6-45.
 
Working with Launcher Components
 
About Launcher Components
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A launcher component consists of a launcher button and a link to an application or Web page to be
launched by the button. You can add, modify, and delete a launcher component, and reposition a
launcher button. These procedures are cov- ered in the following sections.
 
NOTE: The software to be launched must be Windows compatible.
 
Adding  a Launcher Component
Adding a launcher component consists of adding a launcher button and entering a
Web page address or the path/file name of an application to be launched.
 
To add a launcher component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that is to receive the new launcher button.
 
3.      Right-click any open area of the data pane. This opens a shortcut menu (Figure 6.27).
 
4.      Click New Launcher Component. This places a blank launcher button on the button menu.
 
5.      Right-click the new launcher button. This opens a button-specific menu (Figure 6.28).
 
6.      Click Modify. This displays the Component Configuration dialog box (Figure 6.35).
 
FIGURE  6.35

 
An example  of a completed Component Configuration dialog box is shown in Figure 6.36.
 
7.      Complete the options in the dialog box to add text, sound, and visual prop- erties to the new
button. Press the TAB key to move from box to box. The first six options control text, sound, and visual
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properties  of the button. For information about these options, see step 7 on page 6-35. To complete the
last two boxes, which refer to the application or Web page to be launched:
 

•     Path To Executable – To connect to an application, either type the path and file name, or click
Change and navigate to the location of the appli- cation. To connect to a Web page, type the path
and file name for your Web browser.
 
•     Arguments – To connect to an application, type any optional arguments or parameters
needed to run the application. To connect to a Web page, type the address.
 

8.      When finished, click OK. This applies the entries to the new launcher button, but does not save
those entries. To save your entries, right-click any open area of the data pane, then click Save Changes.
 
9.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
 
Modifying a Launcher Component
A launcher component can be modified to change the button caption, description, and visual or sound
effects, the path and/or file name of the application to be launched, or the address of the Web page to be
opened.
 
To modify an existing launcher component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the button to be modified.
 
3.      Right-click the launcher button. This opens a button-specific menu (Figure 6.28).
 
4.      Click Modify. This displays the Component Configuration dialog box (Figure 6.36) containing
properties for this component.
 
FIGURE  6.36
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5.      To modify text, sound, or visual properties,  see step 7 on page 6-35. To modify the path or file
name in the Command Line boxes, see step 7 in “Adding a Launcher Component” on page 6-43.
 
6.      When finished, click OK. This applies the changes to the launcher button, but does not save those
changes. To save your changes, right-click any open area of the data pane, then click Save Changes.
 
7.      After completing all desired interface modifications, right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 

NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 
•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.
 
 
Deleting a Launcher Component
A launcher component (button and link to an application .exe file or Web page)
can be deleted by simply deleting the launcher button.
 
To delete a launcher component:
 
1.      Access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the launcher component to be deleted.
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3.      Right-click the launcher button. This opens a button-specific menu (Figure 6.28).
 
4.      Click Delete. This deletes the launcher component.
 
5.      To save your changes, right-click any open area of the data pane, and then click Save Changes.
 
6.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Moving a Launcher Component
The procedure to reposition a launcher button on the button menu is explained in the next section,
“Repositioning Buttons on a Button Menu.”
 
Repositioning Buttons on  a Button Menu
Any topic, query, or launcher button can be moved to a different position on a button menu. The
procedure is the same for all three types of buttons.
 
To move a button:
 
1.      Access Configuration Mode as explained on page 6-33.
 
2.      Go to the button menu that contains the button to be moved.
 
3.      Right-click the button. This opens a button-specific menu (Figure 6.28).
 
4.      Click Move Left or Move Right, depending  on which way you want to move the button.
 
5.      Repeat steps 3 and 4 until the button reaches the desired position. (A button automatically wraps
to the top or bottom level when moved between the fourth and fifth button positions.)
 
6.      To save your entries, right-click any open area of the data pane, then click
Save Changes.
 
7.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
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•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Globally Modifying Visual and  Sound Effects
From Configuration Mode, you can globally modify, enable, and disable interface visual and sound effects.
These changes impact all translated interfaces. To modify effects for a specific button, refer instead to the
instructions for modifying topic, query, or launcher components in preceding sections.
 
To globally change interface visual or sound effects:
 
1.   Access Configuration Mode as explained beginning on page 6-33.
 
2.   Right-click any open area of the data pane. This opens a shortcut menu (Figure 6.27).
 
3.      Click Configure Global Options. This displays the Global Options Configura- tion dialog box (Figure
6.37).
 
FIGURE  6.37

 
4.      Modify one or more of the following options:
 

•     Layout – Controls the button alignment on all button menus. Select the Auto Center check
box for buttons to appear centered, or clear Auto Center for left alignment.
 
•     AVI Play Mode  – Controls button animation behavior:
 
•     Click Always for all animations to play continuously.
 
•     Click On Mouse Capture for an animation to play only when the mouse points to the button.
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•     Click Never to disable all animations.
 
•     Effects – Controls how button frames and button images display on all button menus. To modify,
select a button section and button phase in the left list, then select the desired effect in the right
list.

 
 
The button sections are:
 

•     Frame – the outer perimeter of the button
 
•     Image – the graphical image within the button

 
The button phases are:
 

•     Active Down – when the button is clicked
 
•     Active Up – when the mouse is pointing to the button
 
•     Inactive – when the mouse is not pointing to or clicking the button

 
The right list specifies the available display effects:
 

•     Raised – the entire button or image appears to be raised
 
•     Recessed – the entire button or image appears to be recessed
 
•     Trench – a narrow recessed trench outlines the button or image
 
•     Wall – a narrow raised wall outlines the button or image
 
•     Enabled – Controls all Visual Catalog sound effects. Select the Enabled check box to enable
sound effects, or clear to disable.

 
•     Language – Identifies the language interface of the global sound effects. This only applies
if you offer the OPAC in multiple interface languages and want to use different sound effects
for the different interface languages. If your institution offers multiple languages, you must
complete a separate Global Options Configuration dialog box for each interface language. To do
so, see steps 11 through 15 in the next section, “Creating a Matching Translated Interface.”
 
•     Copy/Paste – Used only when you need to create a separate Global Options Configuration
dialog box for a different interface language. This is explained in the next section, “Creating a
Matching Translated Interface.”
 
•     Flyby Sound – Identifies the sound that plays when the mouse points at a button. A default
flyby sound is entered. To select a sound file, either type the path and file name, or click Change
and navigate to the loca- tion of the sound file.
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•     Selected  Sound – Identifies the sound that plays when a button is clicked. A default sound is
entered. To select a sound file, either type the path and file name, or click Change and navigate
to the location of the sound file.

 
5.      When finished, click OK. This applies the changes, but does not save them. To save your changes,
right-click any open area of the data pane, then click Save Changes.
 
6.      After completing  all desired interface modifications,  right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.

 
Tip: If you are the system administrator for your insti- tution and are familiar with the file system of the M3 OPAC, there is
another way to create a parallel  interface. For infor- mation, contact Mandarin Tech Support.
 
Creating a Matching Translated Interface
The Visual Catalog interface can be offered to patrons in other interface lan- guages. Each language
requires its own set of global options and topic/query/ launcher components; this creates a parallel
translated interface.
 
A shortcut feature, Copy/Paste, makes it easy to create a parallel interface. The Copy and Paste buttons
appear in every Component Configuration dialog box and in the Global Options Configuration dialog
box.
 
NOTE: The Visual Catalog ships with a default set of English topic components and query components. Before creating a parallel
translated interface, make sure the English version has been customized to meet your library’s needs; this saves customization
time.
 
To create a parallel translated interface:
 
1.      At the main button menu level, access Configuration Mode as explained beginning on page 6-33.
 
2.      Click Languages, select the interface language you are translating from, and then click OK. This is
the master interface you will copy from to create the new parallel interface. (In most cases, this is the
English interface.)
 
3.      Right-click the first button on the button menu. (It can be a topic button, query button, or launcher
button.) This opens a button-specific menu (Figure 6.28).
 
4.      Click Modify. This displays the Component Configuration dialog box
(Figure 6.36) containing the properties for this component.
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5.      Click Copy.
 
6.      In the Language list, select the interface language you are adding.
 
7.      Click Paste. This creates a duplicate dialog box containing  all the original entries.
 
8.      In the Caption and Description boxes, type the translated text. Assuming you want to keep all other
entries the same between the two languages, click OK. This applies the entries to the parallel interface,
but does not save those entries.
 
9.      Right-click any open area of the data pane, then click Save Changes. This saves your entries, but
does not exit Configuration Mode.
 
10. Repeat steps 3 through 9 for each topic, query, and launcher button in your Visual Catalog. This
creates a parallel Component Configuration dialog box for each component.
 
11. Right-click any open area of the data pane. This opens a shortcut menu
(Figure 6.27).
 
12. Click Configure Global Options. This displays the Global Options Configura- tion dialog box (Figure
6.38).
 
FIGURE  6.38

 
 
13. Click Copy.
 
14. In the Language list, select the interface language you are adding.
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15. Click Paste. This creates a duplicate Global Options Configuration dialog box containing all the
original entries. Assuming you want to keep all effects the same between the two languages, click OK.
 
16. Your new parallel language interface is now complete. Right-click any open area of the data
pane, and then click Exit Configuration Mode. This dis- plays a warning dialog box. Click Yes and exit
Configuration Mode.
 
17. To review and use the new parallel interface, click Languages on the Search tab, and then click the
language of the parallel interface you just created. Then click OK. This refreshes  the Visual Catalog,
changing all interface text to the new language.
 
Modifying a Translated Interface
You can modify a translated topic, query, or launcher component. You can also modify the global sound
effects for a translated interface. If you modify an existing interface in one language, you may need to
make matching changes in all interface languages offered to your patrons.
 
Modifying a Translated Component
To modify an existing topic, query, or launcher component:
 
1.      At the main button menu level, access Configuration Mode as explained beginning on page 6-33.
 
2.      Go to the button menu that contains the topic, query, or launcher compo- nent to be modified.
 
3.      Right-click the button to be modified. This opens a button-specific menu (Figure 6.28).
 
4.      Click Modify. This displays the Component Configuration dialog box con- taining properties of this
component (example shown in Figure 6.36).
 
5.      To modify text, sound, or visual properties,  see step 7 on page 6-35. To modify a search query, see
steps 8 and 9 beginning on page 6-39. To modify a launcher component link, see step 7 on page 6-43.
 
6.      When finished, click OK. This applies the changes, but does not save them.
 
7.      When satisfied with the changes made to the component, save your changes. To do so, right-click
any open area of the data pane, then click Save Changes. This saves your changes, but does not exit
Configuration Mode.
 
8.      After completing all desired interface modifications, right-click any open area of the data pane,
and then click Exit Configuration  Mode.
 
NOTE: If there are any unsaved changes, a warning dialog box appears. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.
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Modifying Translated Global Sound Effects
To modify the global sound effects in an existing parallel language interface:
 
1.      At the main button menu level, access Configuration Mode as explained beginning on page 6-33.
 
2.      Right-click any open area of the data pane. This opens a shortcut menu (Figure 6.27).
 
3.      Click Configure Global Options. This displays the Global Options Configura- tion dialog box (Figure
6.39).
 
FIGURE  6.39

 
 
4.      In the Language list, select the interface language that requires the sound modification.
 
 
5.      Modify the sound effects as needed. You cannot modify the visual effects for this language only; if
you change the visuals, those changes will apply to every interface language offered to patrons.
 
•     Flyby Sound – Identifies the sound that plays when the mouse points at a button. To select a sound
file, either type the path and file name, or click Change and navigate to the location of the sound file.
 
•     Selected  Sound – Identifies the sound that plays when a button is clicked. To select a sound file,
either type the path and file name, or click Change and navigate to the location of the sound file.
 
6.      After completing  all desired interface modifications,  right-click any open area of the data pane, and
then click Exit Configuration Mode. This displays a warning dialog box. You can:
 

•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
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•     Click Cancel to remain in Configuration Mode without saving changes.

 
Saving and  Exiting Configuration Mode
To save and/or exit Configuration Mode:
 
1.      Right-click any open area of the data pane. This opens a shortcut menu (Figure 6.27).
 
2.      Click one of the following:
 

•     Save Changes – This saves your changes, but does not exit Configura- tion Mode.
 
•     Exit Configuration Mode – This displays a warning dialog box. You can:
 
•     Click Yes to save the changes and exit Configuration Mode.
 
•     Click No to cancel any unsaved changes and exit Configuration Mode.
 
•     Click Cancel to remain in Configuration Mode without saving changes.
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Using Report Tool
 
This chapter describes:
 
•     How to access and run the reports preloaded into M3
 
•     How to customize the library name on a preloaded report
 
•     How to print a report
 
•     How to download a report to diskette
 
•     How to create a new report
 
•     How to use the grouping function
 
•     How to use the join function
 
NOTE: The common ReportToolTM  functions are described in this M3 Users Guide. The M3 ReportTool module also includes
an extensive on-screen Help system. For detailed information not included in this Users Guide, refer to the on-screen ReportTool
Help.
 
 
ABOUT REPORTTOOL
 
Notes:
• In a wide area network, Mandarin recommends running reports at the central site only. If individual sites need to run reports,
they should be scheduled  to run at different times to avoid slowing down the server.
• Deleted records  appear in reports until  deletions are purged using  the M3 Cata- loging module.
 
In M3, reports are generated using ReportTool, a flexible and powerful Windows report generator
developed by Zen Software, Inc. More than 850 library-related reports are preloaded into M3. You can
run these preloaded reports in their cur- rent form, customize the preloaded reports, or create new
reports.
 
During M3 installation, the user must choose to install preloaded reports in one of two categories:
 

•     School – contains more than 850 reports. This includes reports generally used by K-12 schools,
public libraries, and universities.
 
•     Public or Academic – contains more than 450 reports generally used by public libraries and
universities. This does not include reports generally used by K-12 schools.

 
The preloaded reports are listed in Tables B.1 through B.14 in “Appendix B: Pre- loaded Reports”
beginning on page B-1. Reports are coded according to type:
S (School) or P/A (Public or Academic). Additional reports are created periodically and can be
downloaded from the Mandarin Web site at: http://www.mlasolutions.com
 

http://www.mlasolutions.com/
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Under Customer’s Corner, type your customer number, then click Login. On this page, you can also
request custom reports by clicking the Request a custom report link.
 
 
STARTING REPORTTOOL
 
FIGURE 7.1

 
On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click ReportTool.
This displays the M3 ReportTool  window (Figure 7.1).
 
REPORTTOOL SETUP
 
Before running or creating reports, you should configure several options which will make the report
design easier to understand.
 
To set up ReportTool:
 
1.      On the Tools menu, click Options. This displays the Options dialog box (Figure 7.2) with the View
tab displayed.
 
FIGURE 7.2
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2.      In the Layout group, select the Section Names, Boundaries, Field Names, and Tool Tips check boxes.
These options make the features visible.
 
 
3.      In the Grid group, select the Show check box. This option places a grid design on your report.
 
4.      Click OK to save your changes.
 
 
RUNNING PRELOADED REPORTS
 
To run a preloaded report:
 
1.      On the File menu, click Open. This displays the Open dialog box containing a list of available
reports.
 
2.      Select the report you want to run, then click Open. This displays the Man- darin M3 ODBC dialog
box (Figure 7.3).
 
FIGURE 7.3

 
 
3.      Select the database for which you want to run the report, then click OK.
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This displays the corresponding  report layout screen, which shows where the data fields are positioned
on the report page. It does not include your report data at this time.
 
4.      From here you can:
 

•     Compile and print the report. To do so, click Print on the File menu. In the Print dialog box,
adjust the settings as desired, and then click OK. After the data is compiled, the report prints
without a preview.
OR
 
•     Compile and preview the report on-screen. To do so, click Print Pre- view on the File menu.
After the data is compiled, the report displays. The Print Preview toolbar allows you to zoom in
and out, skip to the next or previous page, and display two pages at a time. Click Print to print
the report, or Close to exit Preview mode.

 
NOTES:
•     Preloaded reports automatically print with the current date.
•     Preloaded reports do not include a library name unless your library has customized the reports. If you want to add your
library name to a pre- loaded report, refer to the next section, “Adding Your Library Name to a Preloaded Report.”
 
 
ADDING YOUR LIBRARY NAME TO  A  PRELOADED REPORT
 
You have the option to add your library’s name to the header of a preloaded report. (Otherwise, the
report prints without any library name.) To do so:
 
1.      On the File menu, click Open. This displays the Open dialog box.
 
2.      Select the report you want to modify, then click Open. This displays the
Mandarin M3 ODBC dialog box (Figure 7.3).
 
3.      Select the database for which you want to run the report, then click OK.
This displays the report layout screen.
 
4.      If the report already contains a text box with an incorrect library name, select the incorrect text and
type your library’s name in its place. Then skip to step 7.
OR
 
If the report layout screen does not have an existing library name box, continue to step 5.
 
5.      On the Drawing toolbar (usually positioned along the right of the window), click the A symbol.
 
6.      In the Report Header (shown in Figure 7.5), drag the mouse to create a text box (see Figure 7.6).
Type your library’s name in the text box.
 
7.      To format the appearance of your library’s name, right-click in the text box, and then select
Properties from the menu. This displays the Properties dialog box (Figure 7.4).
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FIGURE 7.4

 
 
8.      Select the font, text alignment, and other properties in the appropriate tabs. When finished, click
OK.
 
9.      On the File menu, click Save As. This displays the Save As dialog box. Nav- igate to the location
where you want to save the report.
 
10. In the File name box, type a new name for the report, and then click Save.
This saves the report.
 
 
PREVIEWING A  REPORT
 
To preview a report to check content and layout:
 
Tip: Use the camera icon on the toolbar as a shortcut  to Print Preview; it speeds up the process if you have repeated previews  to
perform.
 
1.      On the File menu, click Print Preview. This displays the Mandarin M3 ODBC
dialog box (Figure 7.3), which lists the available databases.
 
2.      Select the appropriate database, then click OK. This displays the report.
 
3.      To navigate the report, use the following buttons:
 

•     Print – prints a preview copy of the report
 
•     Next Page – displays the next page of the report
 
•     Prev Page – displays the previous page of the report
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•     Two Page – displays the report two pages at a time (if Two Page is selected, One Page appears
on the button)
 
•     Zoom  In – enlarges the display of the report
 
•     Zoom Out – reduces the display of the report
 
•     Close – closes the preview and returns to the layout screen

 
NOTE: Sample data is used in Preview mode. Therefore, a printed preview report should only be used to review field placement
and text properties.
 
 
PRINTING A  REPORT
 
Note: Before printing, verify ReportTool is not running  in Preview  mode. To do this, verify that the camera icon on the toolbar is
not selected.
 
To print a report:
 
1.      On the File menu, click Open. This displays the Open dialog box.
 
2.      Select the report you want to print, then click Open. This displays the Man- darin M3 ODBC
dialog box (Figure 7.3).
 
3.      Select the database for which you want to run the report, then click OK.
This displays the report.
 
4.      On the File menu, click Print. This displays the Print dialog box.
 
5.      Change settings as desired, then click OK. This prints the report.
 
 
DOWNLOADING A REPORT TO  A  FILE
 
To download a report to a file:
 
1.      On the File menu, click Open. This displays the Open dialog box.
 
2.      Select the report you want to download, then click Open. This displays the Mandarin M3 ODBC
dialog box (Figure 7.3).
 
3.      Select the database for which you want to run the report, then click OK. This displays the report.
 
4.      On the File menu, click Print. This displays the Print dialog box.
 
5.      Select the Print to file check box, then click OK. This displays the Print to
File dialog box.
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6.      Navigate to the location where you want to download the report.
 
7.      In the File name box, type a name for the report.
 
8.      In the Save as type list, select the appropriate file format, then click Save. This downloads the
report.
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Create a new Report - Report Tutorial
 
In the ReportTool,  creating a new report requires a series of procedures. These procedures are
summarized in the following section, “Overview,” and then detailed in the sections that follow.
 
Overview
Step 1:      Define the report, determining if a similar report exists that you can modify or if you must
create a new report
 
Step 2:      Create a blank report
 
Step 3:      Add a title to the report
 
Step 4:     Add style to text on the report Step 5:     Add the run date to the report Step 6:     Specify
the data source
Step 7:      Add and sort fields on the report
 
Step 1: Defining the  Report
Before beginning, make a list of what the report must accomplish  and what infor- mation must
appear on the final printed report. Then, compare  your list to the pre- loaded report list to determine
if a similar report already exists (see Tables B.1 through B.14 in “Appendix B: Preloaded Reports”
beginning on page B-1). It is faster to modify an existing report than to create a new one.
 
NOTE: When you modify a preloaded report, always save the report under a dif- ferent name. This will preserve your new report
when reports are updated.
 
Step 2: Creating a Blank Report
To create a new report:
 
1.      Verify that your server (or ZServer module) is running.
 
2.      On the File menu, click New. This displays the Open dialog box containing a list of available
reports.
 
3.      Select Blank Report, then click OK. The layout for a blank report is dis- played in Figure 7.5.
 
FIGURE 7.5
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The report layout is divided into five sections:
 

•     Report Header – Appears at the top of page one of the report. It is not repeated on
subsequent report pages.
 
•     Page Header – Appears at the top of every page. On page one, it appears below the Report
Header.
 
•     Detail – Encompasses the body of the report.
 
•     Page Footer – Appears at the end of every page. On the last page, it appears above the Report
Footer.
 
•     Report Footer – Appears at the end of the last page.

 
Step 3: Adding the  Report Title
The report title appears in the Report Header section. To create a title for the report:
 
1.      On the Drawing toolbar, click the A symbol.
 
2.      In the Report Header (shown in Figure 7.5), drag the mouse to create a text box (shown in Figure
7.6).
 
 
 
FIGURE 7.6
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3.      In the text box, type the title of your report. When finished, click outside the text box to deselect it.
 
Step 4: Formatting Text
To modify the text properties of the report title, or any text added to the report:
 
1.      Verify the text box is not selected. To do so, click elsewhere on the report.
 
2.      Right-click in the text box you want to format, then select Properties from the menu. This displays
the Properties dialog box (Figure 7.7).
 

A.     To change the font, click the Font tab (shown in Figure 7.7). Select the desired font, font
style, and size.

 
FIGURE 7.7
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B.     To change the alignment, click the Alignment tab. Select left, center, or right alignment,
then click OK.

 
3.      To resize the text box, select the text box, then drag one of the corners.
 
4.      To move the text box, click outside the text box to deselect it. Then click on the text box and drag it
to the new location.
 
5.      To center a text box or field on a report, click Align on the Format menu.
This displays the Align dialog box. In the Horizontal group, click Center, and then click OK.
 
6.      On the File menu, click Print Preview to view your changes. Click Close to exit the Print Preview
and return to the report.
 
7.      When finished, click Save on the File menu.
 
Step 5: Adding the  Report Run  Date
To display the date the report was run in the Report Header:
 
1.      On the Insert menu, click Fields. This displays the Fields window
(Figure 7.8).
 
FIGURE 7.8

 
 
2.      In the list, select System Variables. This displays a list with the following:
 

•     PRINTDATE – prints the current date
 
•     PRINTTIME – prints the current time
 
•     PAGE – prints the current page number
 
•     TOTALPAGES – prints the total number of pages
 
•     REPORTNAME – prints the report file name

 
3.      Drag  PRINTDATE into the Report Header section, then close the Fields window.
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4.      Right-click in the new date field, then select Properties. This displays the Properties dialog box
(Figure 7.4).
 

A.     Click the Field tab, then click Date.
 
B.     Click the Number tab (shown  in Figure 7.9). In the Category box, select Date. In the Format
Codes box, select a format.

 
 
 
FIGURE 7.9

 
 

C.     Make any desired text property changes in the Font and Alignment tabs. (For instructions,
see “Step 4: Formatting Text.”) Then click OK.

 
5.      To move or resize the new date box, see steps 3 and 4 beginning on page 7-8 for instructions.
 
6.      On the File menu, click Print Preview.
 
7.      Today's date should be visible on your report. If part of the date is trun- cated, click Close to return
to the report layout, and then resize the date box.
 
8.      When finished, click Save on the File menu.
 
 
Step 6: Specifying the  Data Source
To specify the database table from which the report will draw data:
 
1.      On the Tools menu, click Query. This displays the Query dialog box.
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FIGURE 7.10

 
 
2.      On the Tables tab, click Add. This displays the ODBC Tables dialog box (Figure 7.11).
 
FIGURE 7.11

 
Note: ODBC stands for "Open DataBase Connectivity,"  a standard by which many commercial  database vendors  have agreed to
abide. ReportTool offers you the choice of using other ODBC- compliant database systems; however, if you choose another system,
Mandarin technical support will not be able to help you in case of a problem. Mandarin only guarantees ReportTool will work
with the M3 system.
 
 
3.      In the Show Tables for list, select SIRS Mandarin  M3. If your library offers multiple database types,
the Mandarin M3 ODBC dialog box (Figure 7.3) appears. Select the appropriate database type (usually
Library), then click OK. This displays the ODBC Tables dialog box (Figure 7.12) with M3 data- base
table choices listed.
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FIGURE 7.12

 
 
4.      Select the database table you want to use. Your default options are:
 

•     M3Barcode – contains the barcodes used by Circulation
 
•     M3Bibliographic – contains all the MARC bibliographic  records
 
•     M3Group – contains all the item and patron groups
 
•     M3Holding – contains all the MARC holding records
 
•     M3Message – contains all the blocking messages used by Circulation
 
•     M3Patron – contains the patron records
 
•     M3Session – contains the session records created by Circulation
 
•     M3Transaction – contains the transaction records created and used by Circulation

 
5.      Click OK. This closes the ODBC Tables dialog box, and displays the data- base table name in the
Tables tab of the Query dialog box.
 
6.      Click Close to close the Query dialog box.
 
 
Step 7: Adding and  Sorting Fields
 
Placing Fields onto the Report
To place fields from a database table onto a report:
 
1.      On the Insert menu, click Fields. This displays the Fields window (Figure 7.13).
 
FIGURE 7.13
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2.      The database table you selected in step 4 of “Step 6: Specifying the Data Source” displays. Below
it appears a list of field tag numbers and sub-tag codes that represents all the defined fields in a record.
In Figure 7.13, an M3 patron record is defined. (For a definition of the fields listed here, see “Obtaining
Record Definitions” on page 7-15.)
 
3.      Drag the desired fields from the Fields window into the Detail section of the report you are creating.
 
NOTE: If you need to enlarge the Detail section, position your cursor over the ruler bar where the bottom margin of the Detail
section intersects the ruler bar. When the cursor changes to a double-ended arrow, drag the margin line down to resize.
 
4.      When finished, close the Fields window.
 
5.      To change the text properties and field placement, see “Step 4: Formatting
Text” beginning on page 7-8.
 
6.      When finished, click Save on the File menu.
 
 
Sorting  Field Data
To sort the data in a report by a field:
 
1.      On the Tools menu, click Query. This displays the Query dialog box
(Figure 7.10).
 
2.      Click the Sorting tab (shown in Figure 7.14). In the Available Fields list, select a database table.
 
FIGURE 7.14
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You can use this  dialog box at any time to add, remove, or reorder  data sort formulas.
 
3.      Select a field in the left column, then click the > button to move the field to the Sort Fields box.
 
4.      Select the field in the Sort Fields box. In the Sorting Options group, click Ascending or Descending,
and then select the Ignore Case check box.
 
5.      Repeat steps 3 and 4 for each field you want to sort. The fields will be sorted in the order they
appear in the Sort Fields box; you can reorder the fields by dragging the field to the appropriate position
in the Sort Fields box. When finished, click OK.
 
6.      On the File menu, click Print Preview. Data should now display in the order you selected.
 
7.      When finished, click Save on the File menu.
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Obtaining Record Definitions
 
To obtain the definition for any record structure used in M3:
 
1.      Minimize the ReportTool window.
 
2.      Using a simple text editor such as Notepad or WordPad, open the Patrons.ini file (the default path is
C:\Program Files\Mandarin M3\Definition).
 
This document and all other .ini files in the Definition folder contain field definitions for all the valid
fields in MARC tables for ReportTool. Each field tag is enclosed in brackets; each field definition is
preceded by t00=. (A sample Patrons.ini file is shown in Figure 7.15.)
 
NOTE: Within .ini files, t00 contains English terms, t01 contains French, t02 contains Spanish, t03 contains German, and t04
contains Italian.
 
FIGURE 7.15

 
 
3.      On the File menu, click Print, and then close the document.
 
4.      Maximize the ReportTool window.
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Using the Grouping Function
 
If you want all records that have the same value for a particular field to be printed together on a
report, they need to be grouped. Grouping differs from sorting in that it only prints associated records
together on a report; it does not put the records in order. In the following example, we will create a
grouping of all patrons in a particular city.
 
Step 1: Adding a Group
1.      On the Tools menu, click Grouping. This displays the Grouping dialog box
(Figure 7.16).
 
FIGURE 7.16

 
 
2.      Select the field that you want to group in the left column, then click the > button to move the field
to the Group Fields box. In this example, we will select 110#b (City). When finished, click Close.
 
Step 2: Adding a Group Header
1.      On the Tools menu, click Grouping. This displays the Grouping dialog box
(Figure 7.16). M3Patron.110#b now appears in the Group Fields box.
 
2.      Click M3Patron.110#b in the Group Fields box. This enables the Group Break
Options group. Select the Header check box, then click Close.
 
3.      The report window now displays the 110#b field in the Group Header (GH) section as shown in
Figure 7.17.
 
FIGURE 7.17
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Step 3: Adding a Field and  Field Label
1.      On the Insert menu, click Fields. This displays the Fields window (Figure 7.13).
 
2.      Drag 110#b into the Group Header (GH: 110#b)  section of the report, then close the Fields window.
This adds the new field.
 
3.      Click the text box that contains the column header City and press
CTRL+C. This copies the text box.
 
4.      Click in the Group Header section, then click CTRL+V. This pastes the copied text box and adds
the new field label.
 
5.      Click in the new City text box and type a colon (:) after the word City. Align the new text box so
that City appears  as the field label as shown in
Figure 7.18
 
FIGURE 7.18

 
6.      In order for your report to group and sort properly, you must add the M3Patron.110#b  field to
your sort criteria. For instructions, see “Step 7: Adding and Sorting Fields” on page 7-13.
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Using the Join Function
 
The “join” function is used to connect different tables in M3. Any report containing information in
more than one table requires a join. For example, since the item Title and Author are stored in the
M3Bibliographic  table and the Call Number is stored in the M3Holding table, a report containing this
information requires a join.
 
A join can only be performed between tables that contain a field with common data. For example, all
records in the M3Bibliographic  table contain an ISN number (Control Number), which is contained
in M3Bibliographic.001. The M3Holding table also contains an ISN number, which is contained in
M3Holding.001. How- ever, these ISN numbers are not equal. The M3Holding table also contains a field
which stores the ISN number for the corresponding bibliographic record. The bib- liographic  ISN is
stored in the M3Holding.004 field. Therefore, when creating a join between the bibliographic  table and
the holding table, the join is M3Bibliographic.001 >>> M3Holding.004.
 
Table 7.1 lists the joins most commonly used when creating reports for M3.
 
 
TABLE 7.1
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Using Inventory
 
This chapter describes:
 
•     How to conduct a full inventory
 
•     How to conduct a partial inventory
 
•     How to enter additional barcodes after the barcode records have been uploaded
 
•     How to remove barcodes during the inventory process
 
•     How to print and save inventory results
 
•     How to export a barcode list of inventory results
 
•     How to open a previously saved inventory session or report
 
 
ABOUT M3  INVENTORY
 
Using M3 Inventory, you can conduct a full or partial inventory of your library’s holdings. A full inventory
involves scanning the entire collection during one time period. A partial inventory involves scanning
portions of the collection  at any time throughout the year. Both types of inventory are explained in this
chapter.
 
Conducting an inventory with M3 requires only a few basic steps. First, the items to be inventoried
need to be scanned. Then the scanning results need to be uploaded into the M3 Inventory module.
If conducting a partial inventory, the range limits of the corresponding  holdings need to be entered.
Lastly, the “Do Inventory” procedure must be run to compare the scanned barcodes to the corre-
sponding holdings database.
 
When M3 Inventory compares the scanning results to the contents of the holdings database, it groups
and categorizes any differences as Newly Found, Missing, Invalid Barcode, Misplaced, Loaned Shelved,
No Barcode, Duplicate Barcode, or Out of Range(s) Items. Once the results are compiled, you can print
the results lists needed to reconcile your inventory.
 
 
STARTING M3  INVENTORY
 
If desired, you can run the M3 Inventory module while other M3 modules are open. However, to ensure
accurate inventory results, you should not circulate or catalog items while the collection is being scanned.
 
To start the M3 Inventory module:
 
1.      On the taskbar, click the Start button, select Programs, select Mandarin M3, and then click
Inventory. This displays the Inventory Login dialog box.
 



 
Using Inventory

© 2014 Mandarin Library Automation, Inc. All rights reserved.
298 of 361

2.      Type your user ID in the Login Name box, your password in the Password box, and then click OK.
This displays the Select Inventory Session window (Figure 8.1).
 
FIGURE  8.1

 
 
3.      Click Create New Session or Open Existing Session.
 
•     If you click Create New Session, the main M3 Inventory window displays
(Figure 8.2), ready for you to conduct an inventory.
 
•     If you click Open Existing Session, the Open dialog box displays. Navi- gate to the inventory session file
you want to open, then click OK. This opens the session in the main M3 Inventory window (Figure 8.2).
 
 
INVENTORY  WINDOW FEATURES
 
All M3 Inventory functions can be accessed from the main Inventory window. The Inventory window
(Figure 8.2) is divided into three parts: the Inventory menu bar, the Barcode pane (left pane), and the
Inventory pane (right pane).
 
FIGURE  8.2

 
•     Inventory menu bar – Contains the File, Action, View, and Help menus:
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•     File menu – Allows you to open and save sessions, add and remove a barcode or a barcode
file, upload barcodes from the scanner, open or save an inventory report, export barcodes, print
reports, and con- figure the print setup.
 
•     Action menu – Allows you to run the Do Inventory procedure, clear all lists, mark items, run
user-defined reports, and access Inventory Options.
 
•     View menu – Allows you to change the language of the interface, view a summary of
inventory statistics, and turn the status bar on and off.
 
•     Help menu – Allows you to access Inventory Help topics and connect to the Mandarin Web
page.
•     Barcode pane – Displays the barcode files you are working with.
 
•     Inventory  pane – Displays the results of your inventory procedure. It is divided into nine
tabs, corresponding  to the results of the barcode scan- ning. These tabs are: Newly Found,
Missing, Invalid Barcode, Misplaced, Loaned Shelved, No Barcode, Duplicate Barcode, Out of Range(s),
and Statistics.

 
NOTE: Media type icons display in the Inventory pane in all tabs (except Statistics) alongside  items that have a media type
assigned. For information on assigning media types, see “Appendix E: Configuring Media Type Icons” on page E-1. To disable
these icons, change the HasIcons entry in the InventoryDisplay.ini file (located in the Inventory folder in your M3 directory) from
1 to 0, then restart the Inventory module.
 
 
SELECTING AN  INTERFACE LANGUAGE
 
In M3 Inventory, you can specify the interface language. This affects screen ele- ments such as names
of windows, buttons, and text boxes; it does not affect the language of the records in your database.
 
To select an interface language:
 
1.      On the View menu, click Languages. This displays a sub-menu with the lan- guages available for
selection.
 
2.      Click the language you want to use. This refreshes your Inventory interface to display the selected
language.
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Conducting a Full Inventory
 
To conduct a full inventory:
 
1.      Scan the barcode of each item on the shelves, following shelflist order. Use a barcode scanner such
as a tricoder.
 
NOTE: A tricoder can hold an average of 6,000 scanned barcodes at a time. Once that capacity is
reached, the information needs to be uploaded into the inventory file. It may take several scanning and
uploading sessions to build the inventory data.
 
2.      Upload the scanned barcode records (for the shelved items) from the bar- code scanner to M3
Inventory. To do so:
 
A.     On the File menu, click Upload From Reader. (Or, right-click while pointing to the Barcode pane to
access a shortcut menu.) This displays the Add From Tricoder window (Figure 8.3).
 
FIGURE  8.3

 
 
B.     Follow the instructions in the window, then click Save & Add. This displays the Save As dialog box.
 
C.     Navigate to the location where you want to store the barcode file. If you are going to upload
multiple barcode files, you may want to create a new folder for the files.
 
D.     In the File name box, type a name for the barcode file you are uploading, and then click Save. This
saves the file and adds the barcodes to the current inventory. (If you need to upload multiple times to
scan the entire collection, be sure to designate different names for each upload file to avoid overwriting
data.)
 
3.      Scan the barcode of each item that is out-of-sequence  (that is, items not on the shelves, such as
items on carts).
 
 
4.      Upload the scanned barcode records (for the out-of-sequence items) from the barcode scanner to
M3 Inventory. To do so:
 
A.     On the File menu, click Upload From Reader. (Or, right-click while pointing to the Barcode pane to
access a shortcut menu.) This displays the Add From Tricoder window (Figure 8.3).
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B.     Click Add to Out-of-Sequence Items. This adds the items to the out-of- sequence list without creating
a file. A misplaced item check is not performed on the out-of-sequence list.
 
5.      On the Action menu, click Inventory Options. This displays the Inventory
Options window (Figure 8.4).
 
FIGURE  8.4

 
 
6.      In the Database Set list, select the database containing the holdings that are now being inventoried.
 
7.      (Optional Step) You can configure the Inventory module to recognize a specific pattern of
characters, a certain barcode length, or both. If any scanned barcodes deviate from this character and/
or length specification, the deviant barcodes are highlighted in the barcode listing. To do so:
 

A.     Click New Pattern. This displays the New Pattern dialog box
(Figure 8.5).

 
FIGURE  8.5

 



 
Conducting a Full Inventory

© 2014 Mandarin Library Automation, Inc. All rights reserved.
302 of 361

B.     To set up a character pattern, type the pattern in the Pattern box. For example, if all barcodes
involved in this full inventory begin with the same three characters, type those three characters
here.
 
C.     To set up a length pattern:
 

•     In the Minimum Length  box, type the minimum number of charac- ters in the barcode
pattern.
 
•     In the Maximum Length box, type the maximum number of charac- ters in the
barcode pattern.

 
D.     Click OK to return to the Inventory Options window, where your pattern entries display in
the Barcode Patterns box.
 
E.     Select the Barcodes are case-sensitive check box to locate the exact text of the barcode. For
example, if you select this check box and search for B200, you only find occurrences of B200. You
will not find an occurrence of b200.
 
F.     Select the Check call number sequence  check box to check for and report any barcodes that
are not in the sequence being searched.
 
G.     Click Save.

 
8.      Create the barcode file. To do so:
 

A.     On the File menu, click Add Barcode File. This displays the Open dialog box.
 
B.     Navigate to the location where you stored the barcode records files.
Double-click the file name. (If you uploaded multiple barcode record files, double-click one of the
files. Then repeat this step for each barcode record file you uploaded.) This imports the data into
the M3
Inventory module and creates a file in M3 Inventory. The file name appears in the Barcode
pane in the main Inventory window
(Figure 8.6).
 
C.     The total number of barcodes imported is displayed to the right of the name of the newly
created file. Click the plus (+) sign to expand the file and view the list of barcodes entered.

 
FIGURE  8.6
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FIGURE  8.7

 
9. Run the Do Inventory procedure. To do so:

A. On the Action menu, click Do Inventory. M3 Inventory compares the barcode information
to the corresponding  holdings data. When finished, a dialog box (Figure 8.7) displays with a
summary of the inventory results.
 
B.     Click OK to close the dialog box and return to the main Inventory window. M3 Inventory
places the appropriate information in each of the nine tabs in the Inventory pane:
 

•     Newly Found – Lists items present in this barcode upload, but previously flagged as
missing. (NOTE: To change the status of all newly found items to “Normal,” click Mark
Newly Found Items on the Action menu. At the confirmation prompt, click OK.)
 
•     Missing – Lists all items missing from this barcode upload. If the item has a Location
(852#a), the Location appears before the call number.
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•     Invalid Barcodes  – Lists items that do not belong in the collection or have the wrong
barcode length.
 
 
•     Misplaced – Lists items that are in the wrong shelf position.
 
•     Loaned Shelved – Lists items that have an availability status of loaned, but are
actually on the shelf.
 
•     No Barcode – Lists items that have no barcode on file in the catalog.
 
•     Duplicate Barcode – Lists items that have duplicate barcodes.
 
•     Out of Range(s) – Lists items that are not in the inventory call number range, but are
in the barcode upload in shelflist order.
 
•     Statistics – Displays a summary of the current inventory results, as well as statistics
regarding this inventory.

 
C.     Click any tab to view the corresponding information. In Figure 8.8, the Out of Range(s)
tab is selected. This information can be printed or saved to a file, if desired. (See “Printing and
Saving Results” on
page 8-14.)
 

FIGURE  8.8
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10. To place a “missing” status in the corresponding holding records of all items listed in the Missing
tab:
 

A.     Click the Missing tab. Some items may display in black and some in red. Black signifies the
item was listed as missing in a previous inven- tory. Red signifies the item was listed as missing
during this inventory.
 
B.     On the Action menu, click Mark Missing Items. At the confirmation prompt, click OK. This
turns all red items to black and places a status of “missing” in the corresponding holding
records.
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Conducting a Partial Inventory
 
To conduct a partial inventory:
 
1.      Scan the barcode of each item on the shelves to be inventoried at this time, following shelflist
order. Use a barcode scanner such as a tricoder.
 
2.      Upload the scanned barcode records (for the shelved items) from the bar- code scanner to M3
Inventory. To do so:
 

A.     On the File menu, click Upload From Reader. (Or, right-click while pointing to the Barcode
pane to access a shortcut menu.) This displays the Add From Tricoder window (Figure 8.9).

 
FIGURE  8.9

 
 

B.     Follow the instructions in the window, then click Save & Add. This displays the Save As
dialog box.
 
C.     Navigate to the location where you want to store the barcode file. If you are going to upload
multiple barcode files, you may want to create a new folder for the files.
 
D.     In the File name box, type a name for the barcode file you are uploading, and then click
Save. This saves the file and adds the barcodes to the current inventory. (If you need to upload
multiple times, be sure to designate different names for each upload file to avoid overwriting
data.)

 
3.      Scan the barcode of each item to be inventoried  that is out-of-sequence
(that is, items not on the shelves, such as items on carts).
 
4.      Upload the scanned barcode records (for the out-of-sequence items) from the barcode scanner to
M3 Inventory. To do so:
 

A.     On the File menu, click Upload From Reader. (Or, right-click while pointing to the Barcode
pane to access a shortcut menu.) This displays the Add From Tricoder window (Figure 8.3).
 
B.     Click Add to Out-of-Sequence Items. This adds the items to the out-of- sequence list without
creating a file. A misplaced item check is not performed on the out-of-sequence list.
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5.      On the Action menu, click Inventory Options. This displays the Inventory
Options window (Figure 8.10).
 
FIGURE  8.10

 
 
6.      In the Database Set list, select the database containing the holdings that are now being inventoried.
 
7.      (Optional Step) You can configure the Inventory module to recognize a specific pattern of
characters, a certain barcode length, or both. If any scanned barcodes deviate from this character and/
or length specification, the deviant barcodes are highlighted in the barcode listing. To do so:
 

A.     Click New Pattern. This displays the New Pattern dialog box (Figure 8.11).
 
FIGURE  8.11

 
 

B.     To set up a character pattern, type the pattern in the Pattern box. For example, if all
barcodes involved in this partial inventory begin with the same three characters, type those three
characters here.
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C.     To set up a length pattern:
 

•     In the Minimum Length  box, type the minimum number of charac- ters in the barcode
pattern.
 
•     In the Maximum Length box, type the maximum number of charac- ters in the
barcode pattern.

 
 
D.     Click OK to return to the Inventory Options window, where your pattern entries display in
the Barcode Patterns box.
 

8.      Click New Range. This displays the New Range dialog box (Figure 8.12), where you specify the
range of call numbers involved in this partial inven- tory. The range of holdings you specify here is
compared to the barcodes you uploaded from the barcode scanner. If your barcode files cover mul- tiple
ranges, you can specify multiple ranges in this dialog box.
 
FIGURE  8.12

 
 

A.     In the Call No. equal to or > box, type the beginning range. (You are only typing the
classification part of the call number, as designated in MARC field 852#h.)
 
B.     In the To Call No. < box, type the ending range. The ending range should be the first
increment of one after the classification range you want to include. (You are only typing the
classification part of the call number, as designated in MARC field 852#h.)
 
Example: You want to inventory all holdings with an 800 classification part. To do so, the correct
entries are 800 in the Call No. equal to or > box and 900 in the To Call No. < box. This ensures that
all 800 hold- ings up to but not including 900 are included (everything through 899.999). If you
had typed 899 in the To Call No. < box, any 899.+ numbers would be unintentionally left out.
 
C.     (Optional Step) Within the specified call number range, you can advise the Inventory
module to compare barcodes to holdings that have a specific prefix or that have no prefix in
MARC field 852#k.
 

•     If you want to compare barcodes to holdings with or without a prefix, do not select
the Prefix check box.
 
•     If you want to compare barcodes to holdings that have no prefix, select the Prefix check
box and do not type anything in the Prefix box.
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•     If you want to compare barcodes to holdings with a certain prefix, select the Prefix
check box and type the desired prefix in the Prefix box.
 

D.     Click OK to return to the Inventory Options window, where your range entries display in
the Call Number Ranges box.
 

9.      Click Save to save your entries in the Inventory Options window.
 
10. Create the barcode file. To do so:
 

A.     On the File menu, click Add Barcode File. This displays the Open dialog box.
 
Note: If you return  a missing item while an inventory is in progress, the item will not be reported as “missing.”

B.     Navigate to the location where you stored the barcode records files.
Double-click the file name. (If you uploaded multiple barcode record files, double-click one of the
files. Then repeat this step for each barcode record you uploaded.) This imports the data into
the M3
Inventory module and creates a file in M3 Inventory. The file name appears in the Barcode
pane in the main Inventory window.
 
C.     The total number of barcodes imported is displayed to the right of the name of the newly
created file. Click the plus (+) sign to expand the file and see the list of barcodes entered.

 
11. Run the Do Inventory procedure. To do so:

A.     On the Action menu, click Do Inventory.
 

NOTE: If a there is a discrepancy of more than 3,000 barcode entries, a message appears asking if you want to proceed. This
happens when:
 

•     You are trying to run a partial inventory and did not set the appro- priate call
number range. Make sure you have set the correct call number range in the Inventory
Options window. See step 8 on page 8-11 for instructions.
 
•     Your scanning devices may not have functioned properly or you may have missed a
large number of items during the scanning process. To resolve the problem, check the
barcode scanner. If it appears to be functioning properly, scan the items again.

 
To proceed, click Continue; otherwise, click Cancel. M3 Inventory compares the uploaded barcode data to
the specified range of call numbers in the corresponding holdings data.
 

B.     When the inventory comparison is complete, a dialog box (shown in Figure 8.7) displays
with a summary of the inventory results. The results include the number of Newly Found,
Missing, Invalid Barcode, Misplaced, Loaned Shelved, No Barcode, Duplicate Barcode, and Out
of Range(s) Items. Details appear in the corresponding  tabs in the main Inventory window. For
more information on these tabs, see step
9B beginning on page 8-7.
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C.     Click any tab to view the corresponding information. In Figure 8.13, the Out of Range(s) tab is
selected. This information can be printed or saved to a file, if desired. (See “Printing and Saving
Results” on
page 8-14.)

 
 
FIGURE  8.13

 
12. To place a “missing” status in the corresponding holding records of all items listed in the Missing
tab:
 

A.     Click the Missing tab. Some items may display in black and some in red. Black signifies the
item was listed as missing in a previous inven- tory. Red signifies the item was listed as missing
during this inventory.
 
B.     On the Action menu, click Mark Missing Items. At the confirmation prompt, click OK. This
turns all red items to black and places a status of “missing” in the corresponding holding
records.
 

 



 
Entering Additioanl Barcodes

© 2014 Mandarin Library Automation, Inc. All rights reserved.
311 of 361

Entering Additioanl Barcodes
 
You can add more barcodes to your inventory after the scanned barcode records have been uploaded. If
you have already run the Do Inventory procedure, you must run it again after adding the extra barcodes
to update the results.
 
To add a barcode:
 
1.      On the File menu, click Add Barcode. This displays the Add Barcode dialog box (Figure 8.14).
 
FIGURE  8.14

 
2.      In the Barcode to Add box, type the barcode number (or scan the barcode), and then click OK. This adds
the barcode to the Out-of-Sequence Items folder in the Barcodes pane (within the main Inventory window).
Repeat for each desired barcode.
 
3.      The total number of barcodes entered this way display to the right of the folder name. To review the
list of barcodes entered, click the plus (+) sign to expand the folder.
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Removing Barcodes
 
You can remove a barcode or barcode file at any time during the inventory process. Removing barcodes in
this manner does not remove the barcodes from the M3 system or from the scanned barcode file. Instead,
it removes the barcodes from the Barcode pane in the main Inventory window and, therefore, from the
inventory results. If you remove barcodes after you have run the Do Inventory procedure, you must run Do
Inventory again to update the inventory results.
 
Removing a Barcode
1.      In the Barcode pane of the main Inventory window, select the barcode you want to remove.
 
2.      On the File menu, click Remove Barcode. This removes the barcode from the inventory procedure.
 
Removing a Barcode File
1.      In the Barcode pane of the main Inventory window, select the file you want to remove.
 
2.      On the File menu, click Remove Barcode File. This removes  the barcode file from the inventory procedure.
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Printing and Saving Results
 
Note:  To  change the font size on a report, select a size  in the Printed report font size box in the Inventory Options window (see
Figure 8.4). The default font size is 10 point.
 
To print inventory results displayed in any of the tabs:
 
1.      Click the tab containing the information to be printed.
 
2.      On the File menu, click Print Setup. This displays the Print Setup dialog box. Change settings if
desired, then click OK.
 
3.      On the File menu, click Print [List Type] List. This displays  the Print dialog box. Change settings if
desired, then click OK.
 
To save inventory results to a file:
 
1.      On the File menu, click Save Inventory Report. This displays the Save As dialog box.
 
2.      Navigate to the location where you want to save the inventory report.
 
3.      In the File name box, type a name for the file, or accept the default name M3Inventory Report [current
date and time].
 
4.      Click Save. This saves the inventory report.
 
 
To save an inventory session to a file:
 
On the File menu, click Save Session. This saves the file as M3Inventory Session
[current date] to the same location where you initially saved the barcode file.
 
OR
 
1.      On the File menu, click Save Session As. This displays the Save As dialog box.
 
2.   Navigate to the location where you want to save the file.
 
3.   In the File name box, type a name for the file, or accept the default name M3Inventory Session [current
date].
 
4.   Click Save. This saves the inventory session.
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Exporting Barcodes
 
 
You can export the barcodes in any of the inventory tabs (except the No Barcode tab) to a file. The export
function only exports the barcodes in the tab you are cur- rently viewing.
 
To export barcodes:
 
Tip: Make sure you are viewing the specific inventory tab for the barcode export you want to perform.
 
1.      Click the inventory tab from which you want to export barcodes. This dis- plays the corresponding
barcode list.
 
2.      On the File menu, click Export [List Type] List. This displays  the Save As dialog box.
 
3.      Navigate to the location where you want to save the barcodes.
 
4.      In the File name box, type a name for the file, or accept the default name BarcodeFile [current date and
time].
 
5.      Click Save. This exports the barcodes.
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Opening a Previous Session or Report
 
To open a previously saved inventory session or report:
 
1.      On the File menu, click Open Session or Open Inventory Report, depending  on the type of file you want
to open. This displays the Open dialog box.
 
2.      Navigate to the file you want to open, then click Open. This opens the file in the main Inventory
window. Proceed with the inventory as desired.
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Using M3 Server
 
This chapter describes:
 
•     The features of the M3 Server Monitor window
 
•     How to add and delete ports
 
•     How to view the log file and change its size
 
•     How to clear the log file
 
 
ABOUT M3  SERVER
 
M3 Server is a connectivity tool that allows the M3 system to search your Mandarin catalog database. It
also acts as a usage monitoring tool, allowing administrators to view server information, port statistics,
and database usage.
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Monitor Window Features
 
To open the Mandarin M3 Server Monitor window in your Web browser:
 
1.      On the taskbar, click the M3 Server icon (shown in Figure 9.1).
 
FIGURE  9.1

 
2.      This displays the M3 Server menu (Figure 9.2). Select Monitor, then click the port number you
want to display. For this example, 210 will be used.
 
FIGURE  9.2

 
3.      This displays the Login dialog box. Type your user ID in the Login Name box, your password in the
Password box, and then click OK. This displays the Monitor window (Figure 9.3).
 
FIGURE  9.3
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•     M3 Server header – Displays the IP address and port number being viewed, as well as the
M3 Server version number and the current oper- ating system.
 
•     Selection tabs – Use the four tabs to move between Statistics, Recent Activity, Connections,
  and Tables.
 
•     Resource Information  pane – Displays information related to the selected tab.

 
Statistics Tab
This tab (Figure 9.3) displays information related to the selected server, such as port details, usage
statistics, and recent activity. All information described will not immediately display; use the scroll bar
to navigate through the window.
 
•     Server (shown in Figure 9.3) – The technical statistics on system perfor- mance for the port.
 
•     Running Time – The amount of time M3 Server has been listening to the port.
 
•     Threads – The number of resources dedicated to client requests.
 
•     Bytes Received – The number of bytes of information received by the port.
 
•     Bytes Sent – The number of bytes of information the M3 Server has sent to the clients.
 
•     Unhandled Exceptions – The number of unanticipated error conditions that have been encountered 
with the M3 Server. On occasion, the M3
Server may shut down in an attempt to fix itself.
 
•     Connections (shown in Figure 9.3) – The statistical data on connections through the port.
 
•     Total – The number of connections that occurred on the port.
 
•     Current – The number of connections that are currently active.
 
FIGURE  9.4
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Tip: Use the scroll  bar to navigate through the window.
 
Note: The M3 Server recog- nizes  the client searches as Type-0, Type-1, or Type-101
Z39.50  search types. For information on the additional search types reported, refer to www.niso.org/z3950.html.
 

•     Searches (shown in Figure 9.4) – The number of searches that occurred through the port.
 
•     Type – The Z39.50 search type category. The M3 Clients report statis- tics through Type-0,
Type-1, and Type-101 searches.
 
•     Successes – The number of successful searches performed through the port.
 
•     Hits – The number of successful  hits or matches for the search.
 
•     Hits/Search – The average number of hits or matches in each search performed through the
port.

 
FIGURE  9.5

http://www.niso.org/z3950.html
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•     Presents (shown in Figure 9.5) – The number of records the M3 Server pro- vided in response
to the client requests.
 
•     Records – The number of records presented by the M3 Server.
 
•     Requests – The number of requests received for records.
 
•     Records/Request – The average number of records per request that occurred through the port.
 
•     Scans (shown in Figure 9.5) – The number of whole field index scan requests and processes
performed.
 
•     Requests – The number of scan requests received.
 
•     Terms – The number of entries returned.
 
•     Terms/Request – The average number of entries returned per request.
 

 
 
FIGURE  9.6
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•     Sorts (shown in Figure 9.6) – The number of sorts requested and the number of records
sorted.
 
•     Requests – The number of sorts requested.
 
•     Records – The number of records sorted.
 
•     Records/Request – The average number of records sorted per request.
 
•     Updates (shown in Figure 9.6) – The number of new, modified, and purged records. The total
number of requests and failures for each Update Type is listed.
 
•     Insert – The number of new records added.
 
•     Replace – The number of edited records.
 
•     Delete – The number of records that have been removed or purged.
 
•     Total – The total number of updates that have occurred.

 
FIGURE  9.7
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Tip: To refresh  the pane, click Refresh  on your browser.
 

•     Response  Time (milliseconds) (shown in Figure 9.7) – The response time for each activity
performed by the M3 Server reported in milliseconds.
 
•     Activity – The response time for each M3 Server action is monitored and reported in
milliseconds.
 
•     Minimum – The minimum response time for the action.
 
•     Maximum – The maximum response time for the action.
 
•     Average – The average response time for the action.

 
 
Recent Activity Tab
This tab (Figure 9.8) displays recent activity for the selected port, including the sites that connected,
the connection date and time, the event performed, any mes- sages, and the result. The Resource
Information pane can display up to 1,024 lines of activity. All activity is written to the log file.
 
FIGURE  9.8
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•     Connection – The TCP/IP address and port number of each client site that has recently
connected.
 
•     Timestamp – The date and time of each event.
 
•     Event – The occurrence types.
 
•     Connect – Occurs when a client connects to a port.
 
•     Search – Occurs when a client completes a search on a port. Search lists the database search,
along with the Z39.50 query in the Message column. It also displays the number of matching
records or an error number in the Result column.
 
•     Disconnect – Occurs when a client disconnects from a port.
 
•     Message – Additional information regarding the event.
 
•     Result – The result for the event, if any.

 
 
Connections Tab
This tab (Figure 9.9) displays the current connections to the server.
 
FIGURE  9.9
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•     Address – The TCP/IP address and port number of each client site that is currently
connected.
 
•     Type – The type of connection made.
 
•     Connected – The length of time the connection has been open.
 
•     State – The status of the connection.  States include (but are not limited to) Idle, Processing, 
Delivery, and Closing.
 
•     Operation – The operation currently in process by the M3 Server for this connection.
Operations include (but are not limited to) Initialize, Search, Present, Sort, and Scan.
 
•     Duration – The length of time the connection has been in the current State or Operation.
 
•     Bytes Received – The number of bytes of information received through this connection.
 
•     Bytes Sent – The number of bytes of information the M3 Server has sent to this connection.

 
 
Tables Tab
This tab (Figure 9.10) displays a list of the tables being used by the M3 system.
 
FIGURE  9.10
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Port Customization
 
M3 Server listens to a TCP/IP port for connections from client sites. The default port number is 210.
 
Adding a Port
Multiple port numbers are useful if your library has multiple sites and you need to track usage
statistics by site.
 
To add a port:
 
1.      On the taskbar, click the M3 Server icon (shown in Figure 9.1).
 
2.      On the M3 Server menu (Figure 9.2), click Options. This displays the
Options dialog box (Figure 9.11).
 
FIGURE  9.11

 
3.      Click Insert. This displays the Server dialog box (Figure 9.12).
 
FIGURE  9.12
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4.      In the Port box, type or select a port number.
 
NOTE: Port numbers can range from 1 to 65,535. Some port numbers are reserved for other TCP/IP server connections,  such as
80 for WWW/HTTP and 21 for FTP.
 
5.      In the Directory box, type the path to the server directory, or click Browse
and navigate to the path. (It should default to the correct name.)
 
6.      In the Maximum Log Size box, type or select a log size.
 
7.      In the User Name and Password boxes, type the login information to be used for accessing this port.
 
8.      When finished, click OK.
 
9.      In the Options dialog box, click Apply to save your changes. This displays a confirmation dialog
box; click Yes to add the port.
 
10. In the Options dialog box, click OK.
 
 
Deleting a Port
To delete a port:
 
1.      On the taskbar, click the M3 Server icon (shown in Figure 9.1).
 
2.      On the M3 Server menu (Figure 9.2), click Options. This displays the
Options dialog box (Figure 9.11).
 
3.      Select the port you want to delete, then click Delete.
 
4.      In the Options dialog box, click Apply to save your changes. This displays a confirmation dialog
box; click Yes to delete the port.
 
5.      In the Options dialog box, click OK.
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Working with the Log File
 
The log file contains information about the activity of every port; it contains the same information as
the Resources Information pane. The default log size is 1 MB.
 
Viewing the  Log  File
To open the log file:
 
1.      On the File menu, click Exit to close the M3 Server.
 
2.      Using a simple text editor such as Notepad or WordPad, open the log.txt file (the default path is C:
\M3 Server).
 
Modifying the  Log  File  Size
You can increase or decrease the maximum log file size. If you do not want this file to log activity, set
the size to 0 MB.
 
To modify the log file size:
 
1.      On the taskbar, click the M3 Server icon (shown in Figure 9.1).
 
2.      On the M3 Server menu (Figure 9.2), click Options. This displays the
Options dialog box (Figure 9.13).
 
FIGURE  9.13

 
 
3.      Select the port containing the log file you want to modify, then click Edit.
This displays the Server dialog box for this port (Figure 9.14).
 
FIGURE  9.14
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4.      In the Maximum Log Size box, type or select a log size.
 
5.      When finished, click OK.
 
6.      In the Options dialog box, click Apply to save your changes. This displays a confirmation dialog box.
Click Yes to modify the log size now, or No to modify the log size the next time the server is started.
 
7.      In the Options dialog box, click OK.
 
Clearing the  Existing Log
To clear the existing log file:
 
1.      On the taskbar, click the M3 Server icon (shown in Figure 9.1).
 
2.      On the M3 Server menu (Figure 9.2), click Options. This displays the
Options dialog box (Figure 9.13).
 
3.      Select the port containing the log file you want to clear, then click Edit.
This displays the Server dialog box for this port (Figure 9.14).
 
4.      When finished, click Clear. This displays a confirmation dialog box; click
Yes to delete the log file. (A new log file is created the next time the M3
Server is started.)
 
5.      In the Options dialog box, click OK.
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A. Customizing the .ini Files
 
The M3 OPAC has default settings that work with most configurations. However, you may choose to
customize the OPAC .ini files to work with your own system configuration preferences. This appendix
describes:
 
•     How to modify the M3Opac.ini file
 
•     How to modify the SortFormulas.ini file
 
•     How to modify the Summaries.ini file
 
•     How to modify the ZNetworked.ini file
 
 
Warning:
The following information is only for the use of system administrators. If you do not possess a
comprehensive  understanding of configuration files, do not attempt to change the .ini files.
Improper procedures could affect the OPAC. Before you proceed, it is suggested that
you make a complete  backup of this  file.
 
 
MODIFYING THE  M3OPAC.INI  FILE
 
The M3Opac.ini file controls several general configuration aspects of the Windows
M3 OPAC. To modify the M3Opac.ini file:
 
1.      Using a simple text editor such as Notepad or WordPad, open the M3Opac.ini file (the default path
is C:\Program Files\Mandarin M3).
 
2.      In the M3Opac.ini file, make the desired customizations.
 
3.      When finished, save the file. The customized configuration becomes active the next time you start
the M3 OPAC.
 
Contents of  the  M3Opac.ini File
Table A.1 contains some of the common customizable fields. The left column of the table lists the
information contained in the M3Opac.ini file. The right column provides an explanation of the left
column entries.
 
NOTE: The values shown in the left column are the default settings.
 
TABLE A.1
Contents of M3Opac.ini file Explanation

BULLETIN BOARD settings  
Use_External_Browser=0 Controls whether the Bulletin Board uses an external browser to link to the page to be displayed (0=disabled and 1=enabled).

Source=LOCAL Where LOCAL is the default bulletin board file in the M3 directory.
The local default file is “BulletinBoard.html.” Instead of “LOCAL,” this also can be the full path to any Web page. Formats include:
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• http://
• https://
• file:///

WWW HOTSPOTS settings  
Use_External_Browser=0 Controls whether the OPAC uses an external browser for any URLs listed in the Search Results window (0=disabled and 1=enabled).

PRINTING settings  
<Header>
• 0=Mandarin M3 OPAC
• Justification=Center
 
<Footer>
• 0=Page%CURRENT_PAGE
• Justification=Center

Controls elements and formats of the printed header and footer. You can use any of the following variables.
 
The default variables are:
• %CURRENT_PAGE - Current page.
• Justification - Controls where the information will appear (Center, Left, Right).
 
In addition, you can include any of these variables in the header and footer:
• %APP_NAME - Current name of the program.
• %SECOND - Current time’s seconds.
• %MINUTE - Current time’s minutes.
• %STANDARD_HOUR - Current time’s hour in standard format (two 12-hour cycles per day).
• %AM_PM_INDICATOR - Indicates before noon or after noon for STANDARD_HOUR format. (Text for these indicators is located in the
Timestamp.ini file.)
• %HOUR - Current time’s hour in military format
(i.e., one 24-hour cycle per day).
• %NUMERIC_DAY - The number of the current day of the month ranging from 1 to 31.
• %ALPHA_DAY - The name of the current day of the week. (Text for these names is located in the Timestamp.ini file.)
• %NUMERIC_MONTH - Current month listed numerically, from 1 (January) to 12 (December).
• %ALPHA_MONTH - The name of the current month. (Text for these names is located in the Timestamp.ini file.)
• %YEAR - Current year calculated by the computer and displayed as a four-digit number.

 
 
Contents of M3Opac.ini file Explanation

<Limits> Pages=0 Controls the number of pages a patron can print. If pages=0, there is no limit to the number of pages a patron can print. If pages>0, then the
limit is equal to that number.

REPORT settings  
<Names> Maps language keys to language dependent report formats.

<Attribute_Set_Identifier> Specifies the attribute set identifier of the attribute set with which a report format is to be associated.

<Format_String> Contains the format strings that dictate the type of and layout of the data on the report. Also specifies whether the report is to be language dependent
on the OPAC.

 
MODIFYING THE  SORTFORMULAS.INI  FILE
 
The SortFormulas.ini file controls the formulas by which record lists are sorted in the M3 OPAC.
These formulas apply to sorting records in the Search Results Record List, Bookbag Record List,
and the Open Transactions and Closed Trans- actions lists in the My Account tab. To modify the
SortFormulas.ini file:
 
Note: If you installed M3 v1.1 prior to installing v1.6,
your default path is
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C:\Program Files
\SIRS Mandarin\M3.
 
1.      Using a simple text editor such as Notepad or WordPad, open the SortFor- mulas.ini file (the default
path is C:\Program Files\Mandarin M3).
 
2.      In the SortFormulas.ini file, make the desired customizations.
 
3.      When finished, save the file. The customized configuration becomes active the next time you start
the M3 OPAC.
 
Adding New Sort Formulas
If a sort formula you want to use is not listed in the SortFormulas.ini file, you can add a new sort
formula. To do so:
 
1.      In the SortFormulas.ini file, locate the heading [sort_formula].
 
2.      Highlight the entire section (down to the next [sort_formula] heading) to select it, then press CTRL
+C. This copies the text.
 
3.      On the line before the next [sort_formula] heading, press CTRL+V. This pastes the copied text.
 
4.      In the new serial_number= entry, delete the number that appears after the equal (=) sign and type
the number of this new sort formula (for example, if five sort formulas are currently listed, type 6).
 
5.      In the 0= entry, delete the existing text and type the name of the new sort formula. In the four lines
that follow, type language translations as needed (1=French, 2=Spanish, 3=German, 4=Italian).
 
6.      Under the heading <default>, type any options you want to specify for this sort formula.
For an explanation of available options, see the instructions under [sort_formula] <default>  in the
SortFormulas.ini file.
 
 
7.      Under the heading <key>, type the identification number of the sort key by which you want to sort.
You can select multiple keys, if desired. The available sort keys are listed under the [sort_key] heading
in the file. To create a new sort key, see the following section, “Adding New Sort Keys.”
 
8.      When finished, save the file. The new sort formula becomes active the next time you start the M3
OPAC.
 
Adding New Sort Keys
If a sort key you want to use is not listed in the SortFormulas.ini file, you can add a new sort key. To do
so:
 
1.      In the SortFormulas.ini file, locate the heading [sort_key].
 
2.      Highlight the entire section (down to the next [sort_key] heading) to select it, then press CTRL+C.
This copies the text.



 
A. Customizing the .ini Files

© 2014 Mandarin Library Automation, Inc. All rights reserved.
334 of 361

 
3.      On the line before the next [sort_key] heading, press CTRL+V. This pastes the copied text.
 
4.      In the new serial_number= entry, delete the number that appears after the
= sign and type the number of this new sort key (for example, if five sort keys are currently listed, type
6).
 
5.      In the 0= entry, delete the existing text and type the name of the new sort key. In the four lines
that follow, type language translations as needed (1=French, 2=Spanish, 3=German, 4=Italian).
 
6.      Under the heading <options>,  type any options you want to specify for this sort key. For an
explanation of available options, see the instructions under [sort_key] <options>  in the SortFormulas.ini
file.
 
7.      When finished, save the file. The new sort key becomes active the next time you start the M3
OPAC.
 
Automatic Sorting
The OPAC can be configured to automatically sort the Search Results Record List by a default formula.
To do so:
 
1.      In the SortFormulas.ini file, locate the formula by which you want to sort
(Call Number, Title, and so on). For this example, we will use Title.
 
2.      Under the heading [sort_formula], locate the [identification] section with the entry 0=Title. This is
the Title sort formula.
 
3.      In this sort formula, locate the <default>  section. After the entry
missing_keys_last=1, type auto=1  on a new line.
 
4.      Save the file, then restart the OPAC. The next time a search is conducted, the Search Results Record
List will automatically  sort by the specified for- mula.
 
 
MODIFYING THE  SUMMARIES.INI  FILE
 
In the M3 OPAC, the Summaries.ini file allows configuration of the Holdings box in the Search Results
Record Details window. You can choose the fields that are listed and the order they display on screen.
To modify the Summaries.ini file:
 
1.      Using a simple text editor such as Notepad or WordPad, open the Summaries.ini file (C:\Program
Files\Mandarin M3).
 
2.      In the Summaries.ini file, make the desired customizations.
 
3.      When finished, save the file. The customized configuration becomes active the next time you start
the M3 OPAC.
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Adding a New Field
If a field you want to display is not listed in the Summaries.ini file, you can add a new field. To do so:
 
1.      In the Summaries.ini file, locate the heading [summary_column].
 
2.      Highlight the entire section (down to the next [summary_column] heading)
to select it, then press CTRL+C. This copies the text.
 
3.      On the line before the next [summary_column] heading, press CTRL+V. This pastes the copied text.
 
4.      In the new serial_number= entry, type the number of this new summary column (for example, if 10
summary columns are currently listed, type
11).
 
5.      In the 0= entry, type a new name for the column. In the four lines that follow, type language
translations as needed (1=French, 2=Spanish,
3=German, 4=Italian).
 
6.      In the linking_identifier= entry, type a code to reference the table storing the data (for example,
b=bibliographic, h=holding, or e=equipment).
 
7.      In the <format>  section, in the 0= entry, type the field and subfield in which the data is stored (for
example, 852c).
 
8.      Locate the heading [summary_layout] for the type of linking identifier being modified (holdings,
BIB1, or e (equipment)).
 
9.      Highlight a <column> section (consisting of three lines) to select it, then press CTRL+C. This copies
the text.
 
10. At the desired location, press CTRL+V. This pastes the copied text to create a new column that will
display the data.
 
11. In the new id= entry, type the number you entered in step 4.
 
12. In the new width= entry, type a new column width, if needed.
 
13. When finished, save the file. The new field displays the next time you start the M3 OPAC.
 
 
MODIFYING THE  ZNETWORKED.INI  FILE
The ZNetworked.ini file controls the path to the database. To modify the ZNetworked.ini file:
 
1.      Using a simple text editor such as Notepad or WordPad, open the ZNetworked.ini file (the default
path is C:\Program Files\Mandarin M3).
 
2.      In the ZNetworked.ini file, type the new database path.
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3.      When finished, save the file. The new database path becomes active the next time you start the
M3 modules.
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B. Preloaded Reports
 
M3 reports adhere to the following naming convention:
[Report Category]-[Type of Report][(Report Criteria)] For example: Item-List(ByAuthorForSelectedLocation)
 
Reports are divided into the following categories: Bib & Item Lists, Bill Letters, Booking Reports, Cards
& Labels, Equipment Lists & Forms, Fine Letters, Fine Lists, Fine Notices, Overdue Letters, Overdue
Lists, Overdue Notices, Patron Lists, Statistical Reports, and Transactions Lists.
 
Reports are coded according to the folder in which they reside: School  (S) or Public or Academic (P/A).
 
BIB  & ITEM LISTS
Bibliographic reports (Bib-List) list bibliographic records. Item reports (Item- List) list holding records
and include pertinent information from the corre- sponding bibliographic record. Lists are available
for deleted records, but not purged records. Lists in shelflist order are sorted by call number, title, and
author.
 
BILL LETTERS
Bill letters are sent to patrons with items in an overdue  status. All bill letters allow the user to specify
the number of days that items are overdue (“cut-off date”) as a criteria in creating the letters; items due
more than this number of days will be billed. These letters list the overdue item and the replacement
cost of the item; payment is requested. Selected bill letters allow a surcharge to be added to the cost. An
example of the desired format for standard price-cur- rency is “p9.95usd”.
 
BOOKING REPORTS
Booking reports list library equipment (such as overhead and slide projectors, VCRs, TVs, and so on)
and items (such as reference books or any other library item) that are booked for future use. When
running booking reports on equipment (Booked-Equipment),  select the equipment database; when
running booking reports on items (Booked-Items),  select the library database.
 
CARDS & LABELS
Cards and labels print barcodes, spine labels, book pocket cards, multi-page forms, address labels, and
index cards. Most card and label names contain a dash followed by a number, which signifies that the
report was created to run on special stock (the number is an Avery stock number unless otherwise indi-
cated). When creating cards or labels for equipment, select the equipment database.
 
EQUIPMENT LISTS & FORMS
Equipment lists and forms include equipment items and verification forms. Items must be in the
equipment database and the equipment database must be selected in order for the items to be included
in equipment reports.
 
FINE LETTERS
Fine letters are sent to patrons who have returned items but have outstanding fines due. One fine
letter is created for each patron. Generating fine letters on a consistent day and at a consistent time
will ensure accuracy and eliminate repetition.
 
FINE LISTS
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Fine lists include patrons who have outstanding fines. With the lists that include a “Selected Range Of
Days,” the user can generate lists that correspond to the Fine Letter or Fine Notices that have been
generated. Lists in shelflist order are sorted by call number, title, and author.
 
FINE NOTICES
Fine notices are distributed to patrons who have returned items but have out- standing fines. One
fine notice is created for each item having an outstanding fine. Notices are printed four per page and
can be separated for distribution. Unlike fine letters, fine notices do not contain address information.
Generating fine notices on a consistent day and at a consistent time will ensure accuracy and eliminate
repetition.
 
OVERDUE LETTERS
Overdue letters are sent to patrons with items that have exceeded the due date. Overdue letters do
not include a fine amount unless specified in the report cri- teria. Generating overdue letters on a
consistent day and at a consistent time will ensure accuracy and eliminate repetition.
 
OVERDUE LISTS
Overdue lists include patrons who have outstanding loans. With the lists that include a “Selected
Range Of Days,” the user can generate lists that correspond to the Overdue Letter or Overdue Notices
that have been generated. Lists in shelflist order are sorted by call number, title, and author.
 
OVERDUE NOTICES
Overdue notices are distributed to patrons who have outstanding loans. One overdue notice is created
for each overdue item. Notices are printed four per page (except for faculty notices, which are printed
on a single page) and can be separated for distribution. Unlike overdue letters, overdue notices do not
contain address information. Generating overdue notices on a consistent day and at a consistent time
will ensure accuracy and eliminate repetition.
 
PATRON LISTS
Patron lists provide information about patrons and are generated from the library database. The
“Public or Academic” reports provide address infor- mation, and the “School” reports provide grade,
homeroom, and teacher information.
 
STATISTICAL REPORTS
Statistical reports include statistics for the following areas: circulation, fines, in-house circulation,
loans (including hourly), renewals, and transactions.
 
TRANSACTIONS LISTS
Transactions lists include items on hold, returned via in-house circulation, loaned, renewed, and
reserved.
 
 



 
C. M3 Patron Record Definition

© 2014 Mandarin Library Automation, Inc. All rights reserved.
339 of 361

C. M3 Patron Record Definition
 
Table C.1 provides the standard M3 patron record definition.
 
TABLE C.1
USMARC
Field Tag

Field Name

110#n Primary Address 2 (P.O. Box)

110#o Primary Address 3 (RR#, RFD, and so on)

  

111 Secondary Address (same subfields as 110)

  

112 Alternate Address (same subfields as 110)

  

113 Additional Address (same subfields as 110)

  

120 Contact Information

120#a Telephone

120#b Fax

120#c Electronic Mail

  

200 Friend or Neighbor Personal Information

200#a First Name

200#b Middle Name

200#c Last Name

  

210 Friend or Neighbor Address

210#a Address

210#b City

210#c State or Province

210#d Country

210#e Postal or Zip Code

  

220 Friend or Neighbor Contact Information

220#a Telephone

220#b Fax

220#c Electronic Mail
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852 System Information

852#a Location (School or Library)

852#b Homeroom

852#c Teacher or Advisor

852#d Department

852#f Patron Language

852#g Grade Level

852#h Year of Graduation

852#i ILL Permission

852#j Internet Access permission

852#k Rental Permission

852#l Parent or Guardian Last Name

852#m Parent or Guardian First Name

852#o Login Name

852#p Barcode

852#q Password

852#z Note

  

853 Membership Information

853#a Date Paid

853#b Amount

853#c Status

853#d Member Since (Sign up date)

853#e Expiry of Membership

  

990 Message

990#a Message ISN

990#b Message Formula

990#c Location Assigned

  

991 Groups Information

991#a Standard Group

991#b Reserve Group

  

993 Statistics

993#a Loan Count

993#b Hold Count
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993#c Reserve Count

993#d Renewal Count

993#e Recall Count

993#f ILL Count

993#g Booking Count

993#i Fines Count

993#j Fines Total

993#k Fines Forgiven Count

993#l Fines Forgiven Total

993#m Lost Count

993#n Lost Total

993#o Lost Forgiven Count

993#p Lost Forgiven Total

993#q Damaged Count

993#r Damaged Total

993#s Damaged Forgiven Count

993#t Damaged Forgiven Total

993#u Claimed “Never Had” Count

993#v Claimed “Returned” Count

993#w Claimed “Paid” Count

993#x Current Loan Count

993#y Current Hold Count

993#z Current Reserve Count

993#1 Current Renewal Count

993#2 Current Fines Count

993#3 Last Subject Borrowed

993#7 Current Due Amount
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D. Bibliographic Record Format for Records From Vendors
 
MARC records can be created in various formats. Book vendors that provide MARC records  may store
the field and subfield information differently than M3. In this case, records would require manipulation
after importing to M3. In order to alleviate unnecessary record manipulation, users should request the
MARC record profile described below.
 
 
MARC21 MICROLIF PROTOCOL
M3 uses the MARC21 MicroLIF Protocol, formerly known as USMARC MicroLIF Protocol. MicroLIF
is an abbreviation for Microcomputer Library Interchange Format, a specific implementation of the
MARC21 format incorporating library holding information. This format utilizes the MARC21 852
Location field for local holdings information. Each record must have one 852 field for every copy or
volume purchased. The configuration of the 852 field should be as shown in Table D.1.
 
 
TABLE D.1
MARC 852 Location Field
Description Subfield Example

Location a YPWG

Sublocation or Collection b Reference

Classification Part h 398.2

Item Part i AND

Call Number Prefix k REF

Call Number Suffix m v.3

Copy Number t c.2

Barcode p YPWG001234

Price* 9 p19.95usd

 
*852#9 should contain p, followed by the decimal price, followed by the ISO cur- rency code for the
currency with which the item was paid.
 
NOTE: It is not acceptable for the entire call number to be stored in 852#h; it must be split into the
appropriate subfields (h, i, k, m).
 
 
Libraries that catalog as part of a district or region should prepare their records in the same manner,
with the exception of subfields a and b. In this case, 852#a should contain the district or region code and
852#b should contain the individual library or building code. An example of district or regional cataloging
of the 852 field is shown in Table D.2.
 
 
TABLE D.2
MARC21 852 Location Field for District/Regional Cataloging
Description Subfield Example
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Holding Symbol a FEH*
Sublocation or Collection b SRS**
Classification Number h 398.2

Cutter (Author Letters) i GRI

Call Number Prefix k REF

Call Number Suffix m v.3

Barcode p SRS0012345

Price 9 p19.95usd

 
*Abbreviation for Franklin-Essex-Hamilton BOCES School Library System.
 
**Abbreviation for Salmon River Secondary School.
 
NOTE: The 852 field formats shown above apply to Mandarin 2.80e and M3 users.
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E. Configuring Media Type Icons
 
Tip: If you want icons to display in the OPAC only, they can be disabled in the Inven- tory module. For more infor- mation, see
“Inventory  pane” on page 8-3.
 
In order for media type icons to display in the OPAC and Inventory modules, cer- tain codes must
be entered into each bibliographic record. Table E.1 lists the appropriate icon for each type of
bibliographic record along with the field, posi- tion, and codes needed in the record.
 
If more than one field and position are listed for a record type, enter the fields and positions in the order
listed. If more than one code appears for a field and position, choose the one that is appropriate for the
record.
 
 
 
TABLE E.1
Record Type Icon and

Image Name
Field and Position Code and Description

Artifact Field 000, position 6 r = Three dimensional artifact or naturally occurring
object

Field 000, position 6 a = Language material
t = Manuscript language material

Book

Field 000, position 7 a = Monographic component part
c = Collection
d = Subunit
m = Monograph/item

Photo Field 000, position 6 k = Two dimensional nonprojectable graphic

Music
Cassette

Field 000, position 6 j = Musical sound recording

Field 007, position 00 c = Computer fileData CD

Field 007, position 01 c = Optical disc

Movie, slide

film.ico

Field 000, position 6 g = Projected medium

Electronic
media

 

floppydisk.ico

Field 000, position 6 m = Computer file

Field 000, position 6 a = Language materialJournal  

journal.ico

Field 000, position 7 b = Serial component part
s = Serial
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Library kit  

kit.ico

Field 000, position 6 o = Kit
p = Mixed material

Map  

map.ico

Field 000, position 6 e = Printed map
f = Manuscript map

Book on tape  

microphone.ico

Field 000, position 6 i = Nonmusical sound recording

Field 007, position 00 s = Sound recordingMusic CD  

music.ico

Field 007, position 01 d = Sound disc

Sheet music  

sheetmusic.ico

Field 000, position 6 c = Printed music
d = Manuscript music

Video
recording

video.ico

Field 007, position 00 v = Videorecording

Field 000, position 6 m = Computer fileOnline
resource

 

www.ico

Field 008, position 26 j = Online system or service
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F. New Release Documents
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1.6 NF
(Rev. 5 May 2003)

CIRCULATION
ENHANCEMENTS

• A flag in the Global.ini.REG file contains a new flag that can turn off most override messages
when in self-check mode. The only override that will display is if the item is non-circulating.
To enable:

[Self Mode]
Skip Override=on

• A flag in the Global.ini.REG file contains an option to remove the item and patron history
option entirely from Circulation (in both the Circulation Options screen and from the item/
patron pull-down menu) To enable:

[History Option]
Disable=on

• A flag in the Global.ini.REG file contains an option to add a transaction fee amount to any
item that is returned as lost or damaged. This fee will be assessed in addition to the regular
fine for a lost or damaged item. To enable:

[Transaction Fee]
Prompt for fee=on
Amount=x.xx

• A flag in the Mcircsys.ini file allows users to customize whether a message displays when an
item is going to be placed on hold instead of on reserve. To enable, type under [maininit] :

Display Placed on Hold Message=on

• A flag in the Mcircsys.ini file will display a new shortcut toolbar for all Circ functionalities. To
disenable type under [maininit]:

• Shortcut Toolbar=off

To toggle use Ctrl T
Added the ability to search for an item or patron by typing in the barcode field.

• If in Loan, Reserve, or Booking mode and a patron is scanned, the search will be performed for
an item title. If the search fails, the search will be performed for a patron name.

• If in Loan, Reserve, or Booking mode with no patron scanned, the search will be performed for
a patron name.

• If in Return, Renew, and Status mode, the search will be performed for a patron name.
• Added a new Renew All and Return All function.
• If an item is returned that belongs to a Special Reserve group, a warning message will now

display.
• After doing a bibliographic search, clients can now double-click on the bibliographic record to

select the holding. They are no longer required to double-click on the holding.
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• Added the ability to enter refunds on the payment screen.
• Added the ability to enter an additional fine on the payment screen.
• When an item is flagged as lost, the fine amount will be the item price as determined by field

852#9 in the holding. If no price exists, the fine will be the maximum fine in Group Editor.
• Sound was modified so that two distinct beeps will occur if there is a problem with the

scanned barcode.
• When an item is returned and placed on hold, e-mail notification is now available.
• A flag in the global.ini file contains the ability to set the fields from which the patron email

and phone number information is obtained on all hardcoded messages in Circulation (such as
the message which displays when a lost item is returned). If not specified, this information
will be obtained from fields 120#a (phone) and 120#c (email). To change the fields:

[PATRON INFO FIELD]
email=110#m
phone=110#k

FIXES

• Corrects a crash that would occur when a user was logged in as a member of a group other
than Administrator or Librarian and attempted to add a new patron.

• Fines are now calculating correctly on an odd schedule (such as Mon/Wed/Fri) when Exclude
Closed Days was enabled.

• Receipts will now print correctly with fourteen digit barcodes.
• The problem with the bibliographic reserve statistics not being updated is fixed.
• Forgiven and payment amounts now display on the Paid screen in Payments.
• Override messages will no longer display in Status mode.
• Patron and item records can now be deleted and undeleted. The barcode table will be

correctly updated. This will reduce instances of the “Barcode is deleted” problem when a
patron or item is scanned in Circulation.

• Reserves, holds, and bookings will no longer be allowed on deleted items.
• Reserves/holds are now allowed on items that are members of an *expired* Special Reserve

group.
• Circulation now handles a corrupt transaction table, such as at McConnell school (Gwinnett).

Allows operations on unaffected transaction records.
• The Hold email message has been rewritten (new message requiring translation).
• The default Circ design views now displays pictures (if they are defined in 996#a). This affects

only new customers.

CATALOGING
ENHANCEMENTS

·     Added the ability to import pictures and to update bibliographic and patron records with these
imported pictures.
·     Added the ability to download and link pictures from the internal Syndetics picture database to
bibliographic records. Field 020#a (ISBN) from the bibliographic record will be compared with the
ISBN’s on the Syndetics picture database. If a match is found, the matching picture will be linked to
the bibliographic record.
·     A flag in the ActiveMarcEdit.ini file contains an option not to strip empty fields/subfields when
saving a record. To enable:
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[Strip Empty Fields]
Override=on
·     A flag in the ActiveMarcEdit.ini file contains an option to modify the font size and style in the
Record Editor. If this flag is not present, the default type is MS Sans Serif and the size is 8. To enable:
[Default Grid Font]
Name=xxxxxxxx
Size=xx
        By default, the font is set to Verdana. This will support Central European, Baltic, and Turkish
characters in a future Unicode release.
·     Added the ability to select multiple records after a search by using the Ctrl+Shift command.
·     Added the ability to create multiple holdings for a bib record at one time.
·     The location codes for fixed field 008, position 15-17 (Place of Publication) was updated to include
missing locations, such as Oregon and Egypt.
·     Cataloging now integrates with MARC Magician. Users can edit records externally from M3 using
MARC Magician and transfer records to and from Cataloging.
·     Cataloging now hooks into BookWhere. Users can download MARC records from BookWhere
directly into M3.
·     New statuses (on order, in bindery) are supported.

Fixes

·     If using the patron overlay during import, the patron group selection in Step 3 of the import will be
ignored and the patrons will be imported into their original patron group.
·     Items with barcodes taken from deleted temporary items can now be returned after the temporary
item is purged. This will reduce instances of the “Barcode not found’ problem when an item is scanned
in Circulation.
·     Item barcodes can be re-assigned to patrons and vice versa. This will reduce instances of the
“Barcode is detached” problem when items/patrons are scanned in Circulation.
·     If transactions in the Library and Equipment databases have the same ISN, deleted holdings in one
database will be purged if there are no open transactions in that database. The query now includes the
database ID.
·     Added ability to partially match a bib record against an authority record during verification.
·     Authority records that are created during the verification process no longer have end of field
punctuation.
·     The drag and drop functionality would not work if there was no location in 852#a. This was fixed.
·     When creating a new patron record, the expiration date of the patron group selected will be
inserted into 853#e. Currently, the expiration date used is the default patron group as set up in Group
Editor and not the patron group to whom the patron is assigned.
·     When creating a new holding for an existing bib record, the 852#k (prefix) is now copied into the
new holding.
·     Sorting now ignores non-filing characters.
·     Holding subfield 'k' is added to holdings created from the bibliographic and holding marcedit frame.
·     Hitting Enter on the 'Record has changed' dialog after clicking Next Record now saves changes.
·     Retrieve from MARC Magician of records not currently in the database appends (adds) the records
to the current database.
·     The crash that occurred when invoking the Retrieve from MARC Magician from any view other
than Bibliogrphic has been fixed.
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OPAC

Enhancements

·     The Bookbag display is now identical to the Record Detail screen.
·     Link to Syndetics (More Info button).
·     OPAC now supports displaying cover images linked to 996#a of bib record.
·     Added the ability to print/save all holdings attached to a bib record. This feature is a configurable
option in the M3Opac.ini file by setting “Save_Holdings=1”.
·     Library name can be customized on the main screen.
·     In scoped environments, local holdings are designated with a star icon.
·     Browse window is invoked if 0 results are returned.
·     New installs include new and improved record display formats.

Fixes

·     Blind See and See Also references no longer display.
·     For Authority Control, the search term no longer displays as a cross reference on the search results
screen.
·     Major redesign to correct how See Also references are displayed.

Inventory

Enhancements

·     Media-type icons included in all report views. Icons are based on the leader, 007, and 008 fields
according to the same specifications as OPAC’s icon display.
·     Add an option to mark newly found items as ‘normal’. Display the Location (852#a) on the Missing
list.
·     Increase the font size on all reports.
·     When saving an uploaded barcode file, leave the default name blank. Clients have reported that
they have forgotten to rename the file and have overwritten a previously saved file.

Miscellaneous

·     The search dialogue is now able to handle special characters, such as ampersands.
·     The backdoor user name/password was removed. The backdoor can be reinstated when needed for a
pre-determined period of time.
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1.6 SP1
(Rev. 7 April 2004)

Changes/Additions in Arial Bold Italic
*Currently being developed
?Status to be determined

CATALOGING
ENHANCEMENTS

1. Selective purging has been added.
2. Fields used for duplicate detection for authority and bib records are now configurable in

Cataloging.ini. Patron overlay now supports matching on more than one field.
3. Cataloging now handles multiple authority tables and multiple schemes (LC, Sears, etc.)

BUG FIXES

1. Cataloging allows a user without access to delete selected bib records that belong to
another organization.

2. Find/Replace is slow. This was caused by how the implementation of operating on selected
records had been handled in 1.5. Find/Replace is much faster in this release.

3. Cataloging would hang when performing a Retrieve from MARC Magician. This was caused
by a pointer being incorrectly set in the read buffer.

4. When importing records using the Do Not Allow Duplicates flag in Step 3 of the Import, the
duplicate records are not wtitten to Duplicates.txt in the ImportLogs\Bibliographic folder.

5. Cataloging crashes when attempting to purge deleted patron who have open transactions.
This occurred when Cataloging was in a view other than the patron view. Fixed by a
revision to Cataloging.ini.

6. Find/Replace may cause Cataloging to crash under certain circumstances. The immediate
cause has been fixed and Find/Replace finishes in the example data. If a similar unhandled
condition arises in the future, the exception will be handled and Find/Replace will complete
with the message ‘At least 1 record has failed to update.’

7. Select Authority dialog may hang. This was caused by a very long data stream in a 1xx field
that was not handled by the scan grid.

8. Find/Replace ignores the INACCESSIBLE_FIELDS keys in Cataloging.ini. This allowed
Find/Replace to run on fields, such as the barcode (852#p)  and group (991#a) fields.

9. During propagtion of authority data after an authority record has been saved, the subfields
specified in AuthorityVerifier.ini REMOVEFROMMATCHING key are stripped from the
bib fields.

10. In a scoped environment, field 995 (Organization) in the bib record is not updated on import
when the option Do Not Allow Duplicates is selected in Step 3.

OTHER
The ‘Automatically generate barcode records’ checkbox has been removed from the Import dialog.

CIRCULATION
ENHANCEMENTS
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1. Circulation now supports centralized scheduling. Circulation will propagate CircSchd.cfg
to the server on first run, then reads the file from the server thereafter. The Circulation
schedule file is differentiated according to site and organization. The file is written into the
Registry\Common folder using the following format: Site-Organization-CircSchd.cfg.REG.
This allows different sites and organizations to use different schedules, while maintaining
the global aspect of the schedule.

2. Can now sort the columns in the Transaction display.
3. In a scoped environment, ‘Renew All’ and ‘Return All’ functions work only on transactions

of the current organization (as defined by organization_key in startup.ini). Selected
transactions can always be renewed/returned, if the user has access.

4. When email notification is turned on, the sender is no longer cc’d. If cc’ing is desired,
multiple cc recipients can be defined in Global.ini.REG (the cc email addresses must be
comma-separated).

5. Circulation now handles multiple authority tables and multiple schemes (LC, Sears, etc.).

BUG FIXES

1. The Group Hierarchy override flag was reversed in the original 1.6 release. The correct
handling is as follows: ‘override=on’ means the group hierarchy will not be enforced;
‘override=off ’ means the group hierarchy will be enforced.

2. When adding a date column in the transaction view, if the transaction type does not include
the data, the column will be empty rather than reflect today’s date.

3. When returning as lost or damaged, the fine based on 852#9 will not be created if the
value of the ‘generate’ key in the Fine Transaction section of Global.ini.REG in M3 Server
\Registry\COMMON is equal to ‘no’.

4. Circulation ignores repeating Global Recall in case of 365-day loan period.
5. Expired reserves may not be removed from a patrons transactions. This can happen if

a patron has both a reserve transaction and a hold, and the reserve is first in the list of
transactions. The reserve transaction will not be expired the first time Circulation starts up
after the reserve expiry date. Circulation now expires both transactions after the first start-
up.

6. Circulation may login slowly. This is caused by a very large transaction table and the query
Circ sends to expire holds, bookings, and reserves. In SP1, the query has been optimized for
performance.

7. ‘View Library transactions’ returns transactions for all databases. In SP1, in order to get
transactions for Equipment, it is necessary to switch the current database to Equipment.

8. Status allows backdoor to transactions when the scanned patron has a privilege block
(overdue, fine, etc.).

9. Hold email message contains incorrect due date. The date is the original reserve due date,
not the due date of the hold.

10. In a scoped environment, Circulation ignores organization membership when converting
reserves to holds.

INVENTORY
ENHANCEMENTS

Inventory now supports very large numbers (e.g., value of missing items).

BUG FIXES
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1. Inventory crashes on clicking Invalid Items and No Barcodes tabs. Caused by icons being
turned on for these lists. The hasIcons key has been hardcode to off for the Invalid Items list,
and the issue affecting No Barcodes has been fixed.

2. During partial inventories, Inventory sometimes shows a discrepancy in the number of
missing items on the Inventory Statistics page. This was caused by getting the total number
of missing items for the range.

3. Second title column in the Misplaced list repeats the title from the first line of the No
Barcode list successively. Caused by memory error.

4. Barcodes appended to Out-of-Sequence Items cause the count to increment incorrectly.
5. Inventory may crash while the lists are being populated, if there is no range and a large

number of barcodes are absent from the inventory. Caused by a memory access violation.

OPAC
ENHANCEMENTS

Displaying the Browse dialog when the query returns 0 results is now configurable.

BUG FIXES

1. In the case where the Scoping flag is off for the selected database, OPAC no longer sends
queries with scope restrictions.

2. The massive OR query with scope restrictions has been eliminated. This issue was
introduced by fixes in OPAC to recognize organizations default scope restrictions. If all
organizations are selected, OPAC now sends the query with no restrictions.

PICTURE MANAGER
BUG FIXES

1. Picture Manager inserts empty 996#a when using bitmaps. Bitmaps may not be moved into
the Pictures folder.

2. Picture Manager hangs on browsing a hierarchical folder structure that contains no files.

RECORD EDITOR
ENHANCEMENTS
     Ability to insert multiple subfields.

BUG FIXES
     If the user overrides Authority Control and inserts a subfield into an authority-controlled field, the
data in the first subfield of the next field is lost.

SEARCH DIALOG
BUG FIXES

1. In a scoped environment, if all organizations’ default scope restriction was set to unselected,
Search Dialog deselected all restrictions. Search Dialog now allows the Startup.ini’s
organization key to override the organization’s default scope restriction. The organization in
Startup.ini is always selected, regardless of the organization’s default scope restriction.

2. Organizations that have a relationship only to a database of type ‘online’ no longer appear in
the list of restrictions.
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WEB OPAC
BUG FIXES

1. The Clear button does not work after the query is submitted.
2. In a multi-database environment, when more than one database is selected in Preferences,

the first database’s holding table is queried for all other databases. When you click the
Other databases link, the wrong holdings will be attached to the bib records when you view
details. 

3. The login username and the site key are case-sensitive.
4. ILL requires the presence of organization records in the Configuration table.
5. Holding symbols will be handled as phrases. This prevents features, such as ILL, from

failing because of spaces in the holding symbol.
6. Bib-level availability is incorrectly set. If one or a few holdings are on loan or missing, but

the remaining holdings are available, the graphic in the Record List displays as red.
7.  When Renew, Reserve, and ILL links are all active, they overlap in the multiple holdings

display.
8. If you set a password on an installation that is different from the m3opac-setup

password and modify that installation, when you click Save, you are prompted for
the m3opac-setup password, followed by the installation password,  followed again by
the m3opac-setup password. If you follow the correct sequence, this means at least three
password entries. If not, it will require four or more.

9. The Search button has been disabled for more than one click until results are displayed. This
prevents multiple clicks from running the service into the ground.
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Glossary
 

attributes Fields within MARC records  that can be searched. Each attribute must be attached to an attribute set. See also attribute set.
attribute set Collection of attributes. The purpose of each attribute set is to define end user searches. The M3 system adheres to the standard Z39.50

attribute set to identify search fields. See also attributes.
Authority Control Controls the consistency of bibliographic records. This is achieved by managing the headings (names, titles, and subjects) for bibliographic

records, as well as the appropriate references from unauthorized and authorized headings to and from other authorized headings. See also
authority record, cross-references.

authority record Record in MARC format which controls the authorized forms of names, titles, and subjects in bibliographic records. See also Authority
Control, cross-references.

barcode Unique identification code assigned to an item or patron. An item barcode typi- cally appears somewhere on the item, and a patron
barcode typically appears on the patron’s library card.

block When a message is attached to a patron or item record, it must also be indicated how the message will interrupt (that is, block) the circulation
transaction. To do so, a block type is assigned to each message when it is attached to a record. The M3 system includes four block types:

•     blocking block – The user must select an option in the message dialog box in order to proceed.
 
•     information block – The user can bypass this block by clicking anywhere in the window. This is the least intrusive block type.
 
•     nudge block – The first time a message with a nudge block appears, the user must select a decision in the message dialog box in
order to proceed. Each subsequent time the message appears, the user can click anywhere in the window to proceed.
 
•     privilege block – The user must type a password to bypass the message dialog box. This is the most intrusive block type.

blocking block See block.

Bookbag Feature in the M3 OPAC and the optional Web Gateway that allows the patron to save item records to a temporary location during a
search session.

booking Method of reserving an item, such as a conference room or a piece of equipment, for a future day and/or time.
Boolean operator Operators AND, OR, and NOT, used in a search query to link two or more key- words.
Bulletin Board    Feature in the M3 OPAC that can be configured to link to a Web page or HTML file.

 

circulation period Period of time that an item can be loaned to a patron in a patron group or a special reserve group. The length of the circulation period is
determined by the group the item is assigned to in the Group Editor.

claimed never had When a patron reports to the circulation desk that the item in question was never checked out to that patron.
claimed returned When a patron reports to the circulation desk that the item in question was previ- ously returned by the patron.
cross- references In versions of M3 that support Authority Control, these appear as links in the Search Results window when a search term is entered that

is managed under Authority Control. There are two types of cross-references:
 
•     “See” references lead a searcher from an unauthorized heading to an authorized heading.
 
•     “See also” references lead a searcher from an authorized heading to another related authorized heading.
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delimited record Bibliographic or patron records in which data fields are separated by a space, tab, punctuation mark, or other character. Delimited records
are converted to USMARC format when imported into your M3 system.

Design Mode In M3 Circulation, the mode that allows the panes in the main Circulation window to be customized. A different configuration can be prepared
for each transaction mode. See also transaction modes

Enhanced Search One of two keyword search methods available in the M3 OPAC. This method offers search flexibility and options. See also Standard
Search.

FTP     File Transfer Protocol. The predetermined format used on the Internet to send files.
fine Monetary penalty that accrues when an item’s circulation period has expired before the item has been returned to the library. An overdue

item generates a fine when the item is returned or claimed as lost. Damaged items can also generate fines.
fixed width record Bibliographic or patron records in which data fields are limited to a specified number of characters. Fixed width records are converted to

USMARC format when imported into your M3 system.
forgive In M3 Circulation, an action to dismiss the fine for an overdue item. A fine can be partially or completely forgiven.
grace period Amount of time a loaned item can be checked out beyond the specified circulation period before the item is considered overdue.
grouping In ReportTool,  a function that allows you to visually separate records that have a specific value and display summary data for each group.

Helping Hand    ReportTool’s  wizard that can be used to help you create column, row, label, and crosstab reports; it simplifies the creation of reports. This
is explained in more detail in M3 ReportTool online Help.

history    See search history.

hold Method used to set aside a library item for a patron. When an item is checked into the library and therefore available, it is placed on hold.
See also reserve.

holding    Any item, book, videocassette, and so on, currently in the library’s inventory. See also item.
holding record    In M3, a MARC record containing information for a specific item in the library’s inventory.

ILL     Interlibrary loan. The optional Web Gateway module includes an ILL request form.
Index Browse        Feature in the M3 OPAC and the optional Web Gateway that allows a patron to review and select a search term from existing field data. A

patron can browse a field index (such as subject, title, or author) to select a search term.
 

information block See block.

in-house circulation Return function designed to “return” items that were removed from their shelf locations and left on library tables or desks. It is presumed
that the items were used at the library though not checked out.

interface language Language in which messages and names of windows, dialog boxes, buttons, text boxes, and tabs display. Selecting an interface language
does not affect the lan- guage of the data in the database being used.

IP address    Numeric Internet Protocol address assigned by the Network Information Center (NIC) that uniquely identifies each computer on the
network that uses TCP/IP. The IP address is a 32-bit identifier made up of four groups of numbers, each separated by a period, such as
123.432.154.13.

item    In M3, a library holding such as a book, videocassette, or CD-ROM that has a MARC bibliographic  record and associated MARC holding
record. Items can be added to and/or removed from an item group via the Group Editor module. A holding record can be assigned to only
one item group at a time, but can be included in any number of special reserve groups.  See also holding, patron group, special reserve
group.
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item group    Made up of one or more holding records, an item group is used to control the cir- culation behavior for items assigned to that item group.
A library can create an unlimited number of item groups. Typical item groups are General Collection and Reference Collection. A holding
record can be assigned to only one item group at a time.
 

join In ReportTool,  a function used to establish a relationship between two tables. A join is necessary when composing a report that contains
information in more than one table. Each of the tables to be joined must contain a field with common data.

keyword    Single term used in a search query.

launcher component Component found in the Visual Catalog Search of the M3 OPAC and the optional Web Gateway that consists  of a launcher button and a link
to an application or Web page to be launched by the button. See also Visual Catalog Search.

layout screen    Design area of a report; includes section breaks that allow for placement of objects and fields.
Library Transactions
Mode

Mode in M3 Circulation in which you can view and print circulation statistics for specific transactions.

loaned item     Item that has been checked out by a patron through the library’s circulation system.
MARC   Machine Readable Cataloging. A MARC record includes a description of the item, the main entry and added entries, subject headings, and

the classification or call number. (MARC records often contain much additional information.)
message bank     In M3 Circulation, a collection of patron and item messages available for attachment to patron and item records.
nudge block     See block.

OPAC    Online Public Access Catalog. An online bibliography of a library collection that is available to the public.
 

patron    Person or organization  that is categorized by a single patron barcode for a library’s circulation system. Patrons can be added to and removed
from patron and special reserve groups via the Group Editor. A patron can be assigned to only one patron group at a time, but can be included
in any number of special reserve groups. See also patron group, special reserve group.
 

patron group    Made up of one or more patron records, a patron group is used to specify the cir- culation permissions for patrons assigned to that group.
A library can establish several patron groups such as General Patron, Library Volunteer, and Staff Member. A library can create an
unlimited number of patron groups. A patron can only be assigned to one patron group at a time.
 

phrase search quotes In searching, the use of quotation marks (“ ”) to enclose keywords in order to only find instances where the keywords appear together. For
example, the keywords “Greek islands” find only occurrences of the two words together, and do not find individual occurrences of Greek or
islands.

placeholder    Identifies the position on a report template where database fields subsequently will be placed when a report is created using the
template. By using placeholders in a template, you can define the position of data fields prior to creating a report or selecting a database.
Placeholders can be created only in a template. However, a report based on a template will inherit the template’s placeholders. 
Placeholders can be used as markers for database, sort, and group fields, as well as in formulas, crosstabs, and charts. This is explained in
more detail in the M3 ReportTool online Help.
 

port    Interface on a computer to which a device is connected. In TCP/IP networks, a port is the beginning or end of a logical connection. Port
numbers identify the type of data being transferred by the port. For example, port 210 is used for Z39.50 traffic.

privilege block    See block.

purge records    This command removes all records marked for deletion from the M3 system.
Purged records are permanently deleted.
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query component Component found in the Visual Catalog Search of the M3 OPAC and the optional Web Gateway that consists of a query button and the
search query linked to the button. When a query button is clicked, the search query is sent and the results are displayed. See also Visual
Catalog Search.

registry service Provides the system administrator with an inside view into the workings of the server. It also allows the administrator to gain remote
access and perform system maintenance.  It is not related to the Windows registry.

report footer     Summary information at the end of a report, such as grand totals and charts.
report header    Information at the beginning of a report, such as the report title and charts.
reserve   Method used to set aside a library item for a patron. This method is used when the item is currently on loan. When the item is returned

and becomes available, this status changes to hold. See also hold.
Reset    Feature in the M3 OPAC that clears the search history for the current search ses- sion. The system can be reset on command or configured

to reset automatically after a predetermined idle time. See also search history.
search history     Feature in the M3 OPAC that allows the patron to return to an earlier Enhanced Search in the current session.
search query     Grouping of keywords and Boolean operators submitted to search a database.
See, See also    See cross-references.

Shelf Browse    Feature in the M3 OPAC and the optional Web Gateway that allows a patron to view records with a call number similar to that of a
selected record. This is similar to looking at items to the left or right of a selected item on a library shelf.
 

SMTP server    Simple Mail Transfer Protocol. A protocol for sending e-mail messages between servers. Generally used to send messages from a client to a
server.
 

special reserve group Typically, a temporary group of patrons and items established to accommodate unusual circulation needs. For example, a library might
create a four-week special reserve group to restrict certain science books to in-library use by students involved in a chemistry project.
A library can create an unlimited number of special reserve groups, and patrons and items can be assigned to multiple special reserve
groups. Special reserve group permissions override item group permissions.
 

Standard
Search

One of two keyword search methods available in the M3 OPAC. This basic method is meant for simple searches or novice researchers.  See
also Enhanced Search.

system variable Data available for use in a report based on the current date, time, or page number.

table check return See in-house circulation.

TCP/IP    Transmission Control Protocol/Internet Protocol. The standard format for trans- mitting data over networks and the Internet.
 

template    Provides layout and format information to be used when creating bibliographic, holding, and patron records. Also used for reports, as
explained in the ReportTool online Help.
 

temporary items When creating a new holding record, the record can be designated as temporary. This means that the record will be deleted when the item
is returned, and the bar- code can be reused. Some librarians use this method to manage periodicals. You can configure Circulation to
allow temporary items to remain in the catalog after being returned. Temporary items cannot be placed on reserve.
text field     Field created with ReportTool and made of up alpha or numeric characters.
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topic component Component found in the Visual Catalog Search of the M3 OPAC and the optional Web Gateway that consists of a topic button that opens a
sub-menu of additional buttons. The sub-menus consist of query buttons that launch database searches, and/or launcher buttons that open
different software applications.  See also Visual Catalog Search.
 

transaction modes Types of transactions that can be conducted in M3 Circulation. The transaction modes are Loan, Return, Renew, Reserve, Booking, and
Status. See also Library Transactions Mode.

truncation    In searching, the use of an asterisk (*) character to designate one or more unspec- ified characters at the beginning or end of typed text.
For example, the keyword farm* finds all terms beginning with farm: farmer, farming, farms, and so on (including  farm). Similarly, the
keyword *forest*  finds all terms that include forest: deforestation, reforestation, and so on.

use attributes    See attribute set.

Visual Catalog
Search

Easy point-and-click graphical search method in the M3 OPAC and the optional Web Gateway.  It is a keyword search method disguised
behind a graphical inter- face where topic buttons are connected to query buttons, which are linked to pre- defined search queries. The
graphical buttons can also be configured to launch software applications. See also topic component, query component, and launcher
component.

Web gateway    Interface that allows a library to place its OPAC on the World Wide Web. Patrons use Web browsers to connect to and search the library
catalog database.

wildcard    In searching, the use of a question mark character (?) to designate one or more unspecified characters within typed text. For example, the
keyword wom?n finds woman, women, and so on.
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Ordering & License
 

You can instantly order the fully licensed version of Mandarin M3 at automation@mlasolutions.com or call
561 995 4010 opt 2. 
 
Please visit www.mlasolutions.com for pricing information.
 

mailto: automation@mlasolutions.com
http://www.mlasolutions.com
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Contacts & Credits
 

POSTAL ADDRESS
Mandarin Library Automation, Inc.
P.O. Box 272308
Boca Raton, FL 33427-2308
 
PHONES AND FAX
(800) 426-7477 Toll-free
(561) 995-4010 Local
(561) 995-4065 Fax
 
REGULAR OFFICE HOURS
M-F 8:30AM - 5:00PM EST
 
TECHNICAL SUPPORT HOURS
24x7x365 - 24 hours/day, 7 days/week
 
BY EMAIL
Sales & Marketing: automation@mlasolutions.com
Customer Service: automation@mlasolutions.com
Technical Support: support@mlasolutions.com
Webmaster: webmaster@mlasolutions.com
 

 
 

mailto:automation@mlasolutions.com
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